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Unit 1: COLOUR THEORY

1.1 History of principles of colour theory

When most people think of color, the first thing that comes to mind is the color wheel we were
shown in elementary art class. This abstract representation is meant to show the relationships
between certain colors in the wheel, and denotes the “primary”, “secondary”, and “tertiary”
colors, which can be combined in various ways to create a broader spectrum.

What most people do not know is the vast history behind the color wheel and the discoveries
which were integral to its invention and standardization.

The first color wheel was presented by Sir Isaac Newton in the 17th century when he first
discovered the visible spectrum of light. Around this time, color was thought to be a product of
the mixing of light and dark, with red being the “most light”, and blue the “most dark”. Newton
saw that this theory was flawed, and while in isolation as the bubonic plague ravaged Europe,
began testing the properties of white light and “to try therewith the celebrated Phenomena of
Colour”. In his classic prism experiment, he noted that white light is composed of a variety of
colors. He then mapped these colors into an octave schema as the first color wheel and the
original ROY G BIV. His experimentations also led to the discovery that all secondary colors
can be made by mixing primary colors. The mixtures of colors in varying ratios resulted in
different “hues” of novel colors from the classic ROY G BIV baseline, and resulted in the first
hue wheel, which is likely the color wheel we are most used to seeing.

Right: Newton’s color wheel. Note the arrangement of the colors within the pattern of an octave.
Left: Goethe’s color wheel.

Right: Isaac Newton, from Opticks: or, A Treatise of the Reflexions, Refractions, Inflexions and
Colours of Light (London, 1704). Left: Wolfgang von Goethe, from Theory of Colours. 1810



Well after Newton’s publication of Opticks in 1704, Johann Wolfgang von Goethe began his
own experiments with color. Like Newton, Goethe attempted to “conceive nature in her simplest,
most conspicuous creations,” although he proposed to do so “without the aid of mathematics”.
His experience as a painter and artist led to a fascination with the phenomena of color much like
that of Newton’s, though he fervently disagreed with Newton’s idea that darkness was just an
absence of light. Instead, he insisted that darkness was an active ingredient in the production of
color. This questioning of the science behind Newton’s discovery led many to believe him to be
an opponent of the sciences in general. However, Goethe himself claimed that “nobody can
appreciate [mathematics] more highly than I,” but that “to understand the phenomena of color
nothing is required but unbiased observation and a sound head”. Strikingly, Goethe’s
investigation of color mirrored that of Newton’s. The 1810 publication Theory of Colours,
although not strictly scientific, was monumental in its breadth of data and investigation. Goethe
conducted numerous experiments with color to address the gaps he perceived in Newton’s
theory, a holistically scientific approach similar to the rigor of Newton’s prism experiments.
Perhaps due to his background in poetry and the arts, Goethe also went into detail about the
psychological aspects of colors and their relationship to human emotions and behavioral traits.
He especially hoped that his investigation would aid painting, which he deemed “an art which
has the power of producing on a flat surface, a much more perfect visible world than the actual
one can be”. His work was also in part a contemplation of the effects of light and dark on human
color perception, such as the way in which ratios of light and dark produce differences in the
color spectra. These observations led Goethe to develop his own color wheel, which is more akin
to the one we use today. In his wheel, colors opposite each other have a visually antagonistic
role. Surprisingly, this observation later became the foundation for our knowledge of how color
is interpreted by the human brain.

Two more aspects of color were expanded upon by the research of American painter Alfred
Munsell in the early 20th century. As a teacher, Munsell recognized the usefulness of a
systematic method for communicating and teaching color. This required a system where color
was easily measurable and definable, a system which was missing from arts education. To
achieve this, Munsell added the dimensions of “chroma” and “color value” as additions to hue.
Chroma is the purity or intensity of the color, and is now referred to as saturation. Color value
refers to the lightness or darkness of the color, and is now referred to as value or brightness.
These dimensions now defined the 3D *color space”, represented by Munsell’s tree with color
value as the y-axis, chroma as the x-axis, and hue as the z-axis, He also defined a standardized
method of notating specific colors within this space. Variations in these properties are set up
within a 3-dimensional graph space, and a precise color can be relayed by naming its specific
coordinates. For example, 5PB 5/1 refers to Purple-Blue 5 with a value of 5 and a saturation of 1.
This “color space” is still used for not only arts education, as Munsell had intended, but also in
the field of optics and color mathematics.



Munsell’s color tree. Notice how the vertical axis displays color brightness and the horizontal
axis shows color saturation, or chroma. The circle around the verticl axis represents hue.

Jacob Rus, 2007

The work of these men, as well as many other men and women, led to the standardized color
wheel and color space that are now used across arts, science, and mathematics in a multitude of
color research. Their approaches, both scientific and artistic, set the foundation for studies of
color for generations to come. Color production is still standardized by hue, value, and
saturation, which have important implications for such things as production of paints and dyes
and coding of pixels in televisions for specific colors. Color perception used the fundamentals of
Goethe’s Theory of Color to further investigate the role of color in psychology, ecology, and
evolution, as well as the physiology of human sight and color discernment.

These artists and scientists both desired to explore the nature of color in their own mediums, and
only through the synergy of their research can understanding the fundamental human experience
of color vision move forward. As famous color theorist Josef Albers said, “Ah, the creative
process is the same secret in science as it is in art. They are all the same absolutely.”



The First Color Organization Systems

Gautier's color-printed picture accompanied one of his many anti-Newtonian publications about
color theories. The band of color at the center imitates an illustration in Newton's Opticks but
"proves" Gautier's assertion that all colors cannot be found in Newton's spectrum of light.

What is the simplest design that can communicate a relationship among colors? It might be no
more than a bar or line, perhaps based on the shape that appears when light is passed through a
prism. Bars of colors convey two basic ideas: Color exists and it has a regular order. A linear
form hints at a progression that can be linked to wavelengths or cycles, but it does not
accomplish much more. It does not suggest complexities of color relationships and so does not
validate other aspects of either practices or ideas. The shape and the placement of color may not
be arbitrary, but the value of the system is limited.

Color Tables and Charts

Color tables expand the color bar, literally and figuratively. They offer a similarly recognizable
display of information, but one that suggests interior relationships through size, shape, or
placement of the colored areas.



Richard Waller's Basic_Chart
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Richard Waller's, 1686

Noting the lack of a standard for colors in natural philosophy, and inspired by a similar table
published in Stockholm, Richard Waller indicated that his "*Table of Physiological Colors Both
Mixt and Simple," (created in 1686) would permit unambiguous descriptions of the colors of
natural bodies. To describe a plant, for example, one could compare it to the chart and use the
names found there to identify the colors of the bark, wood, leaves, etc. Similar applications of the
information collected in the chart might also extend to the arts and trades, he suggested.

Waller offered the Society and, through its publication, readers, a grid containing 119 colors. He
arranged his choices in a progression from lighter to darker colors but did not claim to include all
variations of all mixtures. From left to right at top, there are seven colors, all pure (i.e.,
unmixed), ranging from Spanish white through deeper blue colors—smalt and indigo—to
atramentum siricum, a dark blue-black. At left, from top to bottom, are first the pure yellows and
then the pure reds, moving from lightest (ceruse) through atramentum fuliginosti, a dark red-
brown. Mixed colors fill the balance of the grid; lighter shades are clustered in the top left and in
the lower right are the darkest blacks. Waller's text suggests the mixed colors represent equal
mixtures of the pure color samples at the top and left edges of the graph. He explains how to
create these interior colors, but the names suggest that they may have been purchased, or that it
was possible to do so.



Schiiffer's Table
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Schéffer's principal colors were red, yellow, blue, white, black, brown, and green.

Schéffer designed his method to ensure that illustrations in his own books could be colored
properly by anyone anywhere. As the author of volumes on the classification of insects,
mushrooms, and fish, he knew, through personal experience, of the problems of color and
coloring.

Schéffer outlined his order for color in nine rules. The first few state general concepts. There are
seven simple and natural principal colors (red, yellow, blue, green, brown, white, and black), and
colors may be made from a mixture of two, three, or more of the principal colors. The remaining
rules, based on Schéffer's own research, describe the construction of his classification aid and
explain its system.

Schéffer's system relied on colors that could be found in an artist's shop, and it called for many
mixtures, including combinations within a color group: reds with reds, browns with browns, etc.
Rather than attempt to include all colors in a single sheet, he devised an initial page of principal
colors, and separate pages for colors made from mixtures.



Mayer's Color Triangle

Lichtenberg's replication of Tobias Mayer's triangle has only seven chambers per side, rather
than Mayer's suggested 12.

Mayer also conducted a study to guide the size of the triangle. His tests of visual perception
determined that the eye can distinguish only about twelve gradations between any two colors.14
Accordingly, his triangle has thirteen compartments on each side. At each extreme, the angular
color is a perfect or pure color. Each is separated from the two other pure colors by eleven
proportional mixtures of them.

Mayer's complete color system included other triangles made up of the pure pigments mixed
with progressively larger quantities of white or black. These triangles had progressively fewer
compartments as the colors approached white (lightness) or black (darkness).

Mayer described how these triangles determined and defined colors. His graphs were bi-
directional, equally useful to describe a color at hand or to determine the formula to make any
color the eye could see. One could compare a color found on an object to the colors in the
triangle and, because location on the graph was determined by the proportions of the preparation,
know its composition. Alternatively, one could choose a color from the schematic and know
immediately the combination of red, yellow, blue, black, and white needed to recreate it.

Newton's Color Circle



Newton took the bar of colors created by the passage of . A i
light through a prism and transformed it into a vi"i‘w'
segmented circle, where the size of each segment S 2
differed according to his calculations of its wavelength o @
and of its corresponding width in the spectrum. The AT
placement and size of the colored sections of Newton's ) e %
circle suggested other mathematical and harmonic 3 - @ a
relationships. a

An Early Eighteenth-century Color Wheel
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C.B. 1708

Two color circles are included as illustrations in the 1708 edition of Traité de la peinture en
mignature, an artist's manual attributed to "C.B." (often assumed to be Claude Boutet, or the
publisher, Christophe Ballard). Connections between Newtonian theories about color and this
pair of circles are apparent in the design and the accompanying text. It is less clear, however,
whether those theories were a direct source of inspiration. The first circle contains seven colors,
violet, blue, green, yellow, orange, scarlet, and crimson. A second circle adds golden yellow, red,
purple, sea green and yellow-green for a total of twelve colors. Overall, their inclusion is
somewhat mysterious. The treatise had been issued in at least five editions without this portion;
the color circles and the accompanying text appear only intermittently in later editions.

The physical format of "C.B."'s circle, and of circles more generally, offered consumers
information about color and color relationships that was difficult to procure from charts or linear
graphs. Waller's table showed which two colors could be mixed to create a third color. Mayer's
triangle indicated the same information with three colors. The circle could simplify painting

10



practices, because it is a convenient display tool for painters who wish to prepare or to choose
colors.

Other Color Circles
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Ignaz Schiffermiiller, 1772 & Goethe, 1810

An entomologist, Ignaz Schiffermiller wished to create a more nuanced color wheel, one that
would express the logical connections between musical and chromatic harmonies but that would
also prove useful in practical endeavors, including natural-history classification and color

production.

Goethe's Theory of Colours provided the first systematic study of the physiological effects of
color (1810). His observations on the effect of opposed colors led him to a symmetric
arrangement of his color wheel, "for the colours diametrically opposed to each other... are those
which reciprocally evoke each other in the eye.” (Goethe, Theory of Colours, 1810)

- wiki:Color Wheel
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Wilhelm von Bezold's 1874
1.2 Terms related to colour theory

You see colors in everything around you, every moment of the day—»but do you ever stop to
think about the impact each of those colors is having on you? Whether it’s the calming effect of
blue skies and fields of green, or the saliva-inducing red and yellow of your local fast food chain,
each color is tapping into an emotion. There’s a whole science (and art) in the meanings of
different colors. As an entrepreneur or designer, it’s essential to be aware of these color
meanings to help you choose your colors wisely and tap into the magical power of color

psychology.
Color Meaning

Red

Red is the color of love and passion. Boxes of candies are red on valentines day. Some are pink,
which is atint of red. Red is also the color of anger and blood. Red, orange and yellow are all
found in fire. Red can also mean danger. Stop signs are red, which get our attention and tell us to
be careful and look before we proceed. Red is dominant, and when combined with colors such as
black, can create a very masculine look. Red commands attention and can set a serious tone.

JOIN NOW
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Orange

Orange represents warmth, but isn’t aggressive like red is. Orange can portray a fun atmosphere
because it is energetic and creates a sense of warmth without associated connotations of danger
and blood, as with the color red. Orange can be associated with health, such as vitamin C, which
is commonly found in oranges.

citrus
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Yellow

Yellow is associated with the sun and warmth. When used with orange, it creates a sense of
summer fun. Yellow can be associated with thirst, and can be found on the walls of many
refreshment shops. Yellow can also be associated with cowardice and fear, which comes from
the old expression of someone being “yellow.” When combined with black, it can gain a lot of
attention. A good example outside of design would be a taxi. The combination gets a lot of
attention.

Helveticons

Preview_
Helveticons

Green

Green is the color of money, so in our culture it is associated with wealth. Since most plants are
green, it is also associated with growth and health. It is used to show that products are natural
and healthy, it also connotes profit and gain. Combined with blue, green further perpetuates
health, cleanliness, life, and nature.

13
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Blue

Depending on the tint and shade of blue, it can represent different feelings, thoughts, and
emotions. In imagery, dark shades of blue can give a sense of sadness. An expression that goes
along with this is “singing the blues” when someone is sad. Light blue is the color of the sky and
of water, which can be refreshing, free, and calm. Blue skies are calming and tranquil. Water
washes away dirt and cleans wounds. Blue can represent freshness and renewal, such as when
rain washes away dirt and dust. The calmness of blue promotes relaxation.

Purple
Associated from the color of the robes of royalty, purple relates to royalty. Purples with more red

can be associated with romances, intimacy, softness, and comfort. Purple can give a sense of
mystique as well as luxury. A good example would be the wine website shown below.

HUNGARIAN WINE

14



White

White can be associated with sterility, due to doctors wearing white and most hospitals being
white. Because most artistic depictions of religious figures are completely colorless, white
represents “good” and holiness. White can represent cleanliness, such as clean linens and clean
laundry. It can represent softness due to cotton and clouds. It can reference mental health due to
the white coats and uniforms, white walls, etc. White is great for connoting health and
cleanliness, as shown in the optical website shown below.

o
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Black

Black is mostly associated with death, especially in the United States. It can represent decay —
due to rot — based on how food breaks down and turns black. Black can represent evil, because
it is the opposite of white, which often represents good. It can represent anxiety due to darkness
and the unknown. A lot of black in an image can suggest depression and despair, as well as
loneliness. However, despite all of the negative connotations, when combined with other colors,
such as gold, it can represent luxury. Combined with silver or grey, it can represent
sophistication, such as in the timepiece website shown below.

IG)
ROGER DUBUIS

Skeleton double flying tourbillon

Let’s talk about primary, secondary, and tertiary colors. They're pretty important if you want to
understand, well, everything else about color.

15



Primary Colors

Primary colors are those you can't create by combining two or more other colors together. They're
a lot like prime numbers, which can't be created by multiplying two other numbers together.

There are three primary colors:

Red
Yellow
Blue

Think of primary colors as your parent colors, anchoring your design in a general color scheme.
Any one or combination of these colors can give your brand guardrails when you move to
explore other shades, tones, and tints.

When designing or even painting with primary colors, don't feel restricted to just the three
primary colors listed above. Orange isn't a primary color, for example, but brands can certainly
use orange as their dominant color.

Knowing which primary colors create orange is your ticket to identifying colors that might go
well with orange -- given the right shade, tone, or tint. This brings us to our next type of color.
Secondary Colors

Secondary colors are the colors that are formed by combining any two of the three primary

colors listed above. Check out the color theory model above -- see how each secondary color is
supported by two of the three primary colors?

There are three secondary colors: orange, purple, and green. You can create each one using two
of the three primary colors. Here are the general rules of secondary color creation:

16



Red + Yellow = Orange
Blue + Red = Purple
Yellow + Blue = Green

Keep in mind that the color mixtures above only work if you use the purest form of each primary
color. This pure form is known as a color's hue, and you'll see how these hues compare to the
variants underneath each color in the color wheel below.

Tertiary Colors

Tertiary colors are created when you mix a primary color with secondary color.

From here, color gets a little more complicated. And if you want to learn how the experts choose
color in their design, you've got to first understand all the other components of color.

The most important component of tertiary colors is that not every primary color can match with a
secondary color to create a tertiary color. For example, red can't mix in harmony with green, and
blue can't mix in harmony with orange -- both mixtures would result in a slightly brown color
(unless of course that's what you're looking for).

Instead, tertiary colors are created when a primary color mixes with a secondary color that comes
next to it on the color wheel below. There are six tertiary colors that fit this requirement:

Red + Purple = Red-Purple (magenta)

Red + Orange = Red-Orange (vermillion)
Blue + Purple = Blue-Purple (violet)

Blue + Green = Blue-Green (teal)

Yellow + Orange = Yellow-Orange (amber)
Yellow + Green = Yellow-Green (Chartreuse)

The Color Theory Wheel

This is the impetus behind the color wheel, a circle graph that charts each primary, secondary,
and tertiary color -- as well as their respective hues, tints, tones, and shades. Visualizing colors in
this way helps you choose color schemes by showing you how each color relates to the color that
comes next to it on a rainbow color scale.

17



HUE:

Pure Color

TINT:
Hue + White

TONE:
Hue + White and Black

SHADE:
Hue + Black

When choosing colors for a color scheme, the color wheel gives you opportunities to create
brighter, lighter, softer, and darker colors by mixing white, black, and gray with the original
colors. These mixes create the color variants described below:

Hue

Hue is pretty much synonymous to what we actually mean when we said the word "color.” All of
the primary and secondary colors, for instance, are "hues."

Hues are important to remember when combining two primary colors to create a secondary
color. If you don't use the hues of the two primary colors you're mixing together, you won't
generate the hue of the secondary color. This is because a hue has the fewest other colors inside
it. By mixing two primary colors that carry other tints, tones, and shades inside them, you're
technically adding more than two colors to the mixture -- making your final color dependent on
the compatibility of more than two colors.

If you were to mix the hues of red and blue together, for instance, you'd get purple, right? But
mix a tint of red with the hue of blue, and you'll get a slightly tinted purple in return.

Tints, Shades, and Tones

These terms are often used incorrectly, although they describe fairly simple color concepts. If a
color is made lighter by adding white, the result is called a tint. If black is added, the darker
version is called a shade. And if gray is added, the result is a different tone.

Shade: adding black to a pure hue

18
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You may recognize the term “shade" because it's used quite often to refer to light and dark
versions of the same hue. But actually, a shade is technically the color that you get when you add
black to any given hue. The various “shades™ just refer to how much black you're adding.

Tint: adding white to a pure hue

A tint is the opposite of a shade, but people don't often distinguish between a color's shade and a
color's tint. You get a different tint when you add white to a color. So, a color can have a range
of both shades and tints.

_ -

Tone (or Saturation) - adding gray to a pure hue:

=

You can also add both white and black to a color to create a tone. Tone and saturation essentially
mean the same thing, but most people will use saturation if they're talking about colors being
created for digital images. Tone will be used more often for painting.

Adding and Subtracting Color

If you've ever played around with color on any computer program, you've probably seen a
module that listed RGB or CMYK colors with some numbers next to the letters.

Ever wondered what those letters mean?
CMYK

CMYK stands for Cyan, Magenta, Yellow, Key (Black). Those also happen to be the colors
listed on your ink cartridges for your printer. That's no coincidence.

CMYK is the subtractive color model. It's called that because you have to subtract colors to get
to white. That means the opposite is true -- the more colors you add, the closer you get to black.

19



Think about printing a piece of paper. When you first put a sheet in the printer, you're typically
printing on a white piece of paper. By adding color, you're blocking the white wavelengths from
getting through.

Then, let's say you were to put that printed piece of paper back in the printer, and print
something on it again. You'll notice the areas that have been printed on twice tend to colors
closer to black.

Think about CMYK in terms of its corresponding numbers. CMYK works on a scale of 0 to 100.
If C=100, M=100, Y=100, and K=100, you end up with a black color. But, if all four colors
equal 0, you end up with true white.

RGB

RGB color models, on the other hand, are designed for electronic displays, including computers.

RGB stands for Red, Green, Blue, and is based on the additive color model of light waves. This
means, the more color you add, the closer you get towards white. For computers, RGB is created
using scales from 0 to 255. So, black would be R=0, G=0, and B=0. White would be R=255,
G=255, and B=255.

)

When you're creating color on a computer, your color module will usually list both RGB and
CMYK numbers. In practice you can use either one to find colors, and the other color model will
adjust accordingly.

20



However, many web programs will only give you the RGB values or a HEX code (the code
assigned to color for CSS and HTML). So, if you're designing digital images, RGB is probably
your best bet for choosing colors.
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Unit 2: DIGITAL DESIGN

1. Demonstrate the use AdobePhotoshop
1. Workspace of Adobe Photoshop

You create and manipulate your documents and files using various elements, such as panels,
bars, and windows. Any arrangement of these elements is called a workspace. (The workspaces
of different Adobe creative applications share similar appearances so that you can move between
the applications easily.) You can adapt Photoshop to the way you work by selecting from several
preset workspaces or by creating one of your own.

Home screen

When you launch Photoshop, the Home screen appears, which includes the following:
Information about new features.

A wide range of tutorials to help you quickly learn and understand the concept, workflow, tips,
and tricks.

Display and access to your recent documents. If necessary, customize the number of recent files
displayed. Select Preferences > File Handling and then specify the desired value (0-100) in
the Recent File List Contains field.

The contents of the Home screen are tailored based on your familiarity with Photoshop and your
Creative Cloud membership plan.

NOTE:

To access the Home screen at any point while working in a Photohop document, click the Home

icon in the Options bar.
To exit the Home screen, simply press the Esc key.

Photoshop Home screen

The Home screen shows the following tabs and buttons on the left:

Home: Click this tab to open the Home screen.

Learn: Click this tab to open a list of basic and advanced tutorials on Illustrator to get started
with the application.

LR Photos: Click this tab to access your synced Lightroom photos and import them into a
Photoshop document.

Create New: Click this button to create a new document. You can create a document by
selecting one of the numerous templates and presets available in Photoshop.

Open: Click this button to open an existing document in Photoshop.

22



A first look at the Photoshop working area
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A: Tools anel | B: History panel | C: Color panel | D: Creative Cloud Libraries panel | E: Layers
panel

Interactive image | Click the highlighted areas in the image to view more information about
them

Workspace overview

The Application bar across the top contains a workspace switcher, menus (Windows only), and
other application controls. On the Mac for certain products, you can show or hide it using the
Window menu.

The Tools panel contains tools for creating and editing images, artwork, page elements, and so
on. Related tools are grouped.

The Options bar Control panel displays options for the currently selected tool.

The Document window displays the file you’re working on. Document windows can be tabbed
and, in certain cases, grouped and docked.

Panels help you monitor and modify your work. Panels can be grouped, stacked, or docked.
The Application frame groups all the workspace elements in a single, integrated window that lets
you treat the application as a single unit. When you move or resize the Application frame or any
of its elements, all the elements within it respond to each other so none overlap. Panels don’t
disappear when you switch applications or when you accidentally click out of the application. If
you work with two or more applications, you can position each application side by side on the
screen or on multiple monitors.

If you are using a Mac and prefer the traditional, free-form user interface, you can turn off the
Application frame.

Usability features

23



The Photoshop workspace is easy to use and includes a number of usability features:

Different brightness levels: Choose Edit > Preference (Windows) or Photoshop > Preferences
(Mac OS) and select a Color Theme swatch in the Interface section.
Note:

To quickly decrease brightness, press Shift + 1; to increase brightness, press Shift + 2. (On Mac
OS, it’s necessary to also press the FN key.)

On-image displays: Stay informed as you use your favorite tools. On-image displays show
selection dimensions, transformation angles, and more. To change the placement of the displays,
choose an option from the Show Transformation Values in the Interface preferences.

Maximized screen space: Click the button at the bottom of the toolbar to switch between
Standard and Fullscreen display modes.

Set UX color: You can customize the interface to sport one of the following color themes: Black,
Dark Gray, Medium Gray and Light Gray.To do this, follow these steps:

Choose Edit > Preferences > Interface.

Choose the desired color theme.
Appearance

Color Theme: ‘:‘ D . .

Available Color Theme options

Hide or show all panels
To hide or show all panels, including the Tools panel and Control panel, press Tab.

To hide or show all panels except the Tools panel and Control panel, press Shift+Tab.

Note:

You can temporarily display hidden panels if Auto-Show Hidden Panels is selected in Interface
preferences. Move the pointer to the edge of the application window (Windows) or to the edge of
the monitor (Mac OS) and hover over the strip that appears.

Display panel options
Click the panel menu icon == in the upper-right corner of the panel.
Note:

You can open a panel menu even when the panel is minimized.

Note:

In Photoshop, you can change the font size of the text in panels and tooltips. In the Interface
preferences, choose a size from the UI Font Size menu. Too scale the entire Photoshop Ul based
on the Ul Font Size you've chosen, select the Scale UI To Font.

Reconfigure the Tools panel

You can display the tools in the Tools panel in a single column, or side by side in two columns.
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Click the double arrow at the top of the Tools panel.

The Photoshop Toolbox
VISIT PHOTOSHOP WEBSITE \.&\ Manage WindOWS and panels
MARQUEE TOOL @ >.;- MOVETOOL
e ;} oo You can create a custom workspace by moving and
oo R Wcivo manipulating Document windows and panels. You
aonesweroot | b, 5, | wstonvsmusuToot can also save workspaces and switch among them.
ERASERTOOL g‘ &‘ PAINT BUCKET TOOL
swrTooL | (), &, | popceTooL
PATH SELECTION T00L : T, | rweroot Rearrange, dock, or float document windows
PENTOOL 2, [, | suapeTooL
woresroocR (B 8 R vononren ooy When you open more than one file, the Document
i . windows are tabbed.
Reser cotos | To rearrange the order of tabbed Document
smanssm ol R sk e windows, drag a window’s tab to a new location in
BN | S the group.

To undock (float or untab) a Document window
from a group of windows, drag the window’s tab
out of the group.

Note:

You can also choose Window > Arrange > Float in Window to float a single Document window,
or Window > Arrange > Float All In Windows to float all of the Document windows at once.

To dock a Document window to a separate group of Document windows, drag the window into
the group.

To create groups of stacked or tiled documents, drag the window to one of the drop zones along
the top, bottom, or sides of another window. You can also select a layout for the group by using
the Layout button on the Application bar.

To switch to another document in a tabbed group when dragging a selection, drag the selection
over the document’s tab for a moment.

Dock and undock panels

A dock is a collection of panels or panel groups displayed together, generally in a vertical
orientation. You dock and undock panels by moving them into and out of a dock.

To dock a panel, drag it by its tab into the dock, at the top, bottom, or in between other panels.
To dock a panel group, drag it by its title bar (the solid empty bar above the tabs) into the dock.

To remove a panel or panel group, drag it out of the dock by its tab or title bar. You can drag it
into another dock or make it free-floating.
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Navigator panel being dragged out to new dock, indicated by blue vertical highlight

NAVIGATOR HISTOGRAM
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Navigator panel in its own dock

Note:You can prevent panels from filling all the space in a dock. Drag the bottom edge of the
dock up so it no longer meets the edge of the workspace.

Move panels

As you move panels, you see blue highlighted drop zones, areas where you can move the panel.
For example, you can move a panel up or down in a dock by dragging it to the narrow blue drop
zone above or below another panel. If you drag to an area that is not a drop zone, the panel floats
freely in the workspace.

Note:

The position of the mouse (rather than the position of the panel) activates the drop zone, so if
you can’t see the drop zone, try dragging the mouse to the place where the drop zone should be.
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e To move a panel, drag it by its tab.

e To move a panel group, drag the title bar.
A

B —— COLOR

LAYERS | CHANNFLS | PATHS
[ ) p’ -
\Normol A Opacity:  100%

Lock! -—M

Narrow blue drop zone indicates Colm:.];anel will be docked on its own above the Layers panel
group.

A. Title bar B. Tab C. Drop zone
Note:

Press Ctrl (Windows) or Command (Mac OS) while moving a panel to prevent it from docking.
Press Esc while moving the panel to cancel the operation.
Add and remove panels

If you remove all panels from a dock, the dock disappears. You can create a dock by moving
panels to the right edge of the workspace until a drop zone appears.

e Toremove a panel, right-click (Windows) or Control-click (Mac) its tab and then select Close, or
deselect it from the Window menu.

e Toadd a panel, select it from the Window menu and dock it wherever you want.

Manipulate panel groups

o To move a panel into a group, drag the panel’s tab to the highlighted drop zone in the group.

—
SWATCHES TYLES

Adding a panel to a panel group

o To rearrange panels in a group, drag a panel’s tab to a new location in the group.
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To remove a panel from a group so that it floats freely, drag the panel by its tab outside the
group.

To move a group, drag the title bar (the area above the tabs).

Stack floating panels

When you drag a panel out of its dock but not into a drop zone, the panel floats freely. The
floating panel allows you to position it anywhere in the workspace. You can stack floating panels
or panel groups so that they move as a unit when you drag the topmost title bar.

NAYIGATOR AI5TOGRAM

Free-floating stacked panels

To stack floating panels, drag a panel by its tab to the drop zone at the bottom of another panel.

To change the stacking order, drag a panel up or down by its tab.
Note:

Be sure to release the tab over the narrow drop zone between panels, rather than the broad drop
zone in atitle bar.

To remove a panel or panel group from the stack, so that it floats by itself, drag it out by its tab
or title bar.
Resize panels

To minimize or maximize a panel, panel group, or stack of panels, double-click a tab. You can
also double-click the tab area (the empty space next to the tabs).

To resize a panel, drag any side of the panel. Some panels, such as the Color panel cannot be
resized by dragging.

[ Collapse and expand panel icons

* NAYIGATOR You can collapse panels to icons to reduce clutter on the workspace. In
some cases, panels are collapsed to icons in the default workspace.
] HISTOGRAM
O ~ro LLLAne S il & LAYERS
Ctrl+e~
&% COLOR ‘ Ctrl+1
B swaTcHES 7y Ctrl+2
sl STYLES L B
Panels expanded from icons
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To collapse or expand all panel icons in a column, click the double arrow at the top of the dock.
To expand a single panel icon, click it.

To resize panel icons so that you see only the icons (and not the labels), adjust the width of the
dock until the text disappears. To display the icon text again, make the dock wider.

To collapse an expanded panel back to its icon, click its tab, its icon, or the double arrow in the
panel’s title bar.

To add a floating panel or panel group to an icon dock, drag it in by its tab or title bar. (Panels
are automatically collapsed to icons when added to an icon dock.)

To move a panel icon (or panel icon group), drag the icon. You can drag panel icons up and
down in the dock, into other docks (where they appear in the panel style of that dock), or outside
the dock (where they appear as floating icons).

Prevent accidental panel moves with Lock Workspace

Introduced in the October 2018 release of Photoshop CC (version 20.0)

Use the Lock Workspace option to prevent accidentally moving workspace panels, particularly
when you’re using Photoshop on a tablet/stylus. To access this option, choose Window >
Workspace > Lock Workspace.

Use simple math in number fields
Introduced in the October 2018 release of Photoshop CC (version 20.0)

You can also perform simple math in any input box that accepts numeric values.

For example, if you want to want to increase the canvas size by an additional 50 pixels, you can
simply type '+50' to the current width or height field value in the Canvas Size dialog.

To calculate values in any text box that accepts numerical values:
1. Do one of the following:

o To replace the entire current value with a mathematical expression, select the entire current
value.

o To use the current value as part of a mathematical expression, click before or after the current
value.
2. Type a simple mathematical expression using mathematical operators, such as + (plus), -
(minus), x (multiplication), / (division), or % (percent).
For example,
3 cm * 50% equals 3 centimeters multiplied by 50%, or 1.50 cm.
50 pt + 25% equals 50 points plus 25% of 50 points, or 62.5 points.
3. Press Enter or Return to apply the calculation.
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Comprehensive search

Photoshop features powerful search
functionality that lets you search across Ul
elements, documents, Help & learning content,
inspiring Stock assets, and much more—all
from within a unified dialog. You can search
for items right after launching Photoshop or
when one or more documents are open.

Create documents

When you create a document in Photoshop, instead of beginning with a blank canvas, you can
choose from a wide variety of templates, including templates from Adobe Stock. Templates
include stock assets and illustrations that you can build on to complete your project. When you
open a template in Photoshop, you can work with it just as you would work with any other
Photoshop document (.psd).

In addition to templates, you can also create a document by selecting one of the numerous blank
presets available in Photoshop.

Untitled-1

View All Presets +

New Document dialog | Templates from Adobe Stock and blank presets

Save and switch workspaces

By saving the current size and position of panels as a named workspace, you can restore that
workspace even if you move or close a panel. The names of saved workspaces appear in the
workspace switcher in the Application bar.

Save a custom workspace
1. With the workspace in the configuration you want to save, choose Window > Workspace >
New Workspace.
2. Type a name for the workspace.
3. Under Capture, select one or more options:
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Keyboard shortcuts

Saves the current set of keyboard shortcuts (Photoshop only).
Menus or Menu Customization

Saves the current set of menus.

Display or switch workspaces

Select a workspace from the workspace switcher in the Application bar.
Note:

In Photoshop, you can assign keyboard shortcuts to each workspace to navigate among them
quickly.

Delete a custom workspace

o Select Manage Workspaces from the workspace switcher in the Application bar, select
the workspace, and then click Delete.

o Select Delete Workspace from the workspace switcher.

e Choose Window > Workspace > Delete Workspace, select the workspace, and then click
Delete.

Restore the default workspace
1. Select the Default or Essentials workspace from the workspace switcher in the application bar.
2. Select Window > Workspace > Reset [Workspace Name].

Restore a saved workspace arrangement

In Photoshop, workspaces automatically appear as you last arranged them, but you can restore
the original, saved arrangement of panels.
e To restore an individual workspace, choose Window > Workspace > Reset [Workspace
Name].

o To restore all the workspaces installed with Photoshop, click Restore Default Workspaces
in the Interface preferences.
Note:

To rearrange the order of workspaces in the application bar, drag them.

Rich tooltips

Figuring out what Photoshop tools do is now easier than ever before! When you hover the
pointer over certain tools in the Tools panel, Photoshop displays a description and a short video
of the tool in action.

You can choose not to view rich tooltips. To do so, deselect the Preferences > Tools > Use Rich
Tooltips preference.
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Rich tooltip: Quick Selection tool

Quick Selection tool (W)
Crop tool (C)

Makes a selection by finding and following the

edges in an image Trims or expands the edges of an image

Rich tooltip: Crop tool

Hide tooltips

When you position the pointer over most tools and options, descriptions appear in tooltips by
default. If you find tooltips visually distracting, you can hide them.

In the Interface preferences, deselect Show Tooltips.

Note:

Tooltips are not available in some dialog boxes.

Windows | High-density monitor support and per-monitor scaling

On Windows 10 Creators Update and later versions, Photoshop offers a full range of choices for
Ul scaling—from 100% through 400% in 25% increments. This enhancement makes the
Photoshop user interface looks crisp and sharp regardless of the pixel density of your monitor.
Photoshop automatically adjusts its resolution based on your Windows settings.

In addition, you can adjust per-monitor scaling across monitors with different scaling factors.
This flexibility ensures that a high resolution (HiDPI) laptop works seamlessly alongside a
lower-resolution desktop monitor, or vice versa. For example, one of your monitors can have a
scale factor of 175%, while another monitor can have a scale factor of 400%. So, you can choose

32



either the highest-end 13-inch laptops with 4k screens, the more affordable 1080p models, or tap
into 8k desktop monitors, and still have an uncompromised experience within Photoshop.

In Windows, select Start > Settings > System > Display. Now, under Scale And Layout,
choose a scaling factor for each of your displays.

Note:

On Windows 10 Creators Update and later versions, the UI Scaling setting in Photoshop
(Preferences > Interface > Ul Scaling) still applies to some components, such as the File

Info and Camera Raw dialogs. On earlier versions of Windows, this preference applies to all
Photoshop components. When the UI Scaling option is set to Auto, scaling defaults to the value
closest to the primary monitor's OS scaling factor—100 or 200.

Use Photoshop with the Touch Bar on MacBook Pro

Windows | Modifier Keys palette
B The new Modifier Keys palette lets you access frequently-used keyboard modifiers—
Shift, Ctrl, and Alt—on Windows-powered touch devices, such as the Surface Pro.

» Select Window > Modifier Keys.

2. Demonstrate the use different drawing and painting tools
1. Selection and manipulation of tools
Understand shapes and paths
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Tools panel overview
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8 indicates default tool  * Keyboard shortcuts appear in parenthesis ¢ Extended only

Drawing in Adobe Photoshop involves creating vector shapes and paths. In Photoshop, you can
draw with any of the shape tools, the Pen tool, or the Freeform Pen tool. Options for each tool
are available in the options bar.

Before you begin drawing in Photoshop, you must choose a drawing mode from the options bar.
The mode you choose to draw in determines whether you create a vector shape on its own layer,
a work path on an existing layer, or a rasterized shape on an existing layer.

Vector shapes are lines and curves you draw using the shape or pen tools. Vector shapes are
resolution-independent—they maintain crisp edges when resized, printed to a PostScript printer,
saved in a PDF file, or imported into a vector-based graphics application. You can create
libraries of custom shapes and edit a shape’s outline (called a path) and attributes (such as stroke,
fill color, and style).
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Paths are outlines that you can turn into selections, or fill and stroke with color. You can easily
change the shape of a path by editing its anchor points.

A work path is a temporary path that appears in the Paths panel and defines the outline of a
shape.

You can use paths in several ways:

e Use a path as a vector mask to hide areas of a layer.

o Convert a path to a selection.

« Fill or stroke a path with color.
Designate a saved path as a clipping path to make part of an image transparent when exporting
the image to a page-layout or vector-editing application.

Drawing modes

When you work with the shape or pen tools, you can draw in three different modes. You choose

a mode by selecting an icon in the options bar when you have a shape or pen tool selected.

Shape Layers

Creates a shape on a separate layer. You can use either the shape tools or the pen tools to create

shape layers. Because they are easily moved, resized, aligned, and distributed, shape layers are

ideal for making graphics for web pages. You can choose to draw multiple shapes on a layer. A

shape layer consists of a fill layer that defines the shape color and a linked vector mask that

defines the shape outline. The outline of a shape is a path, which appears in the Paths panel.

Paths

Draws a work path on the current layer that you can then use to make a selection, create a vector

mask, or fill and stroke with color to create raster graphics (much as you would using a painting

tool). A work path is temporary unless you save it. Paths appear in the Paths panel.

Fill Pixels

Paints directly on a layer—much as a painting tool does. When you work in this mode, you’re

creating raster images—not vector graphics. You work with the shapes you paint just as you do
with any raster image. Only

’13 the shape tools work in this
Uvens | CHANNELs | patws | Mmode.
Normal ?lODacu'y: 1¢§
Lock: [] /T{oTﬂﬁJ Fill: 1c§
® "':’ Raster -—C
-9 '@m Vector ﬁ
[ 3
..... [ s [ S

Drawing options
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A. Shape Layers B. Paths C. Fill Pixels
Drawing and Type Tools

1. Pen Tool (P)

Pen Tool (P)

Freeform Pen Tool (P)
Anchor Point Tool (P)
Delete Anchor Point Tool (P)
Convert Point Tool (P)

2. Horizontal Type Tool (T)

Horizontal Type Tool (T)
Vertical Type Tool(T)
Horizontal Type Mask Tool (T)
Vertical Type Mask Tool (T)

3. Path selection Tool (A)

o Path selection Tool (A)
o Direct Selection Tool (A)

4. Rectangle Tool (U)

Rectangle Tool (U)
rounded Rectangle Tool (U)
Ellipse Tool (U)

Polygon Tool (V)

Line Tool (U)

Custom Shape Tool (U)

Pen Tool (P)

I mentioned this tool above for creating paths, in this we use the Path Selection Tool to select the
path and we can use Paths in a few ways, mostly to create clipping paths or to create selections.
We use the tool by clicking to add a point. If we will click and drag, it will change the shape of
your path, allowing bend and shape the path for accurate selections and such.
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Freeform Pen Tool (P)

We can easily draw vector shapes and paths by using a Freeform pen tool since it automatically
adds anchor points. The Freeform Pen Tool creates matrix shapes as well as paths (shape
outlines) in just the same manner as if we are making a sketch with the pencil upon paper. The
tool automatically adds anchor points while drawing.

Anchor Point Tool (P)

The Add Anchor Tool adds a point in the path. You can simply click anywhere along the path to
attach a new point.
Delete Anchor Point Tool (P)

You can use the Delete Anchor Point Tool to delete anchors and it can also be used to reshape
the existing vector shapes / paths (shape outlines).

Convert Point Tool (P)

Convert Point tool is a part of the Pen Tool. The Convert Tool allows us to see the jumble of
lines and points of the path that we have created by the other pen tools, and we can adjust a point
of the path also.

Horizontal Type Tool (T)

Through this tool we can write text in Photoshop when you click a single point, itis putin a
separate layer and a bounding box. You can drag the bounding box to increase the text size and
click on the move tool to move the text around.
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Vertical Type Tool (T) @
This tool is denoted by this type "IT " 0>

e Inthe Toolbox, select the Vertical Type !T Tool. @;
. . . ?‘\! "'

e On the Options bar, set the font size font family and color.

« Click on your image and type. Bk

e Your typing style will be vertical. =,

Horizontal Type Mask Tool (T)

The Horizontal Type Mask Tool creates type-shaped selections.

Select the Horizontal Type Mask Tool which is denoted by this type
On the Options bar, set the font size font family and color

Click on your image and type.

Your typing style will be horizontal with shape

Select any other tool to return to standard editing mode.

Vertical Type Mask Tool (T)

This tool is denoted by this type: !

Select the Vertical Type Mask i that is under the pen tool.
On the Options bar, set the font size font family and color.
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e Click on your image and type.
e Your typing style will be vertical with shape.

Path Selection Tool (A)

The path selection tools make shape or segment selections showing anchor points, direction
lines, and direction points.

Direct Selection Tool (A)

Select the Direct Selection tool and click on the Fill of the object to select the entire object., press
the "v" key on your keyboard to switch to the Selection tool and click to select the entire object.

Rectangle Tool (U)

When you click the Rectangle Tool and drag in a new document then by default a new layer is
created and the color is whatever foreground color you have selected.

Custom Shape (U)

First, select the Custom Shape tool, then select the shape in the Option Bar. Many types of shape
icons are available in shape. Select the Shape Icon and drag in the new document, you can write
text according to the shape icon. When you click a shape, a new layer is automatically created
and the text also can be removed/adjusted in your new document.

- SE[ONEECON - o @S St
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Painting tools

1. Brush Tool (B)

Brush Tool (B)

Pencil Tool (B)

Color Replacement Tool (B)
Mixer Brush Tool (B)

2. History Brush Tool (Y)

e History Brush (Y)
e Art History Brush (YY)

3. Gradient Tool (G)

e Gradient Tool (G)
o Paint Bucket Tool (G)

Brush Tool (B)

This tool is used to paint any image, first of all a selected color and size. There are various
options of the Brush Tools sizes and shapes that can be found in the options bar.

Itis also used on layer masks for showing or hiding parts of the image.
Pencil Tool (B)

The Pencil tool is limited to hard brush tips of any size or shape, and it creates freeform lines
using the current foreground color.

The major difference between the Pencil and Brush Tools is that the Pencil tool can draw only
a hard-edged line. The pencil tool is a part of the Brush Tool.

The Pencil Tool has a unique feature named Auto Erase that can be used to switch between the
Current Foreground and Background colors.

Color Replacement Tool (B)

This tool can be used to change the color, saturation, hue and luminance values. In this tool we
apply changes manually with a brush. This tool can also be used to specify mode, sampling,
limits and tolerance parameters for a tool. It is different from the Brush Tool since it preserves
the original texture when the color is changed.

Mixer Brush Tool (B)

Through the Mixer Brush Tool we can mix colors . You can change the wetness of the brush and
how it mixes the brush color with the color already on the canvas. In Photoshop CS5, brushes
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have more realistic bristles as well, so you can add textures that resemble those in paintings you
might create in the physical world.

While this is a great feature in general, it's particularly useful when you're using the Mixer
Brush. Combining various bristle settings and brush tips with different wetness, paint-load, and
paint-mixing settings gives you opportunities to create exactly the look you want.

History Brush Tool (Y)

This tool works in a similar way as the Brush Tool, except the information that it paints with is
from the original state of your image. If you go to "Window" > "History" then you will see the
History Palette. The History Brush Tool paints with the information from whatever History State
is selected.

Art History Brush (YY)

This tool can be used to apply paint styles to your image using a history state. This tool is
available under the History Brush Tool. There are several options available for this tool that will
affect how the pixels will look, the opacity, paint stroke style, fidelity, area, and tolerance. This
tool will probably not fool anyone into thinking you have created a watercolor in the traditional
way, but it's fun to use and can create nice images.

Gradient Tool (G)

You can use this tool to make gradient colors. It creates a blending of your foreground color and
background color when you click and drag it.
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Paint Bucket Tool (G)

This tool fills the area with the Active Foreground Color and Pattern. You can select two options
in this tool but before that you must click the Fill List Arrow. The two options are as follows:
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« Foreground: It can be used to fill the selected area with the current foreground color.
o Pattern: It can be used to fill the area with a pattern.

The Paint Bucket Tool can fill areas with a selected foreground and pattern. The fill area can be
controlled by the shift in brightness of image pixels.

e Click the Pattern list arrow, and then select a pre-defined fill pattern. This option is
available if you select Pattern as a fill option.

Click the Mode list arrow, and then select a blending mode.

Enter an Opacity percentage value (1 to 100).

Select a Tolerance value (0 to 255). The Tolerance value influences the range of the
Paint Bucket used to fill a given area.

Select the Anti-aliased check box to create a visually smoother line.

Select the Contiguous check box to restrict the fill to the selected area.

Select the All Layers check box to fill all the color range information from the image's
layers.

Click the Paint Bucket Tool on the area to be changed.

] Gradient Tool G
&, Paint Bucket Tool .G

Before After

Retouching Tools In Adobe Photoshop

The retouching tools in Adobe Photoshop are: Clone Stamp, Pattern Stamp, Healing
Brush, Patch and Color Replacement.
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These tools repair damaged images, apply repeated patterns, or replace colors in an image.
The following illustration shows the arrangement of these tools in the toolbar.

If two or more tools occupy £=1
the same cell (the icon for s:j B
the tool last used is always -
shown), in order to choose ® ¥ Healing Brush Tool | B X,
another tool, right-click the ¢ Patch Tool i
mouse on the arrow next to 93/ Color Replacement Tool )| 1‘—%‘——-' ¢2, Clone Stamp Tool
the icon and and choose s | FR Pattern Stamp Tool
another tool from the menu J )
that appears. This menu will Q. %,

also appear if you click on the icon and press it for some time.

The Clone Stamp tool and Healing Brush clone (copy) pixels from one part of an image to
another, to another layer or even to another image. The difference between the Healing
Brush and the Clone Stamp tool is, the Healing Brush in Photoshop takes into account the
texture, illumination and shadows of the processed image. As a result, the fragment processed by
the Healing Brushblends more easily into the rest of the image.

To clone an area with the Clone Stamp or Healing Brush, follow these steps:
e Step 1. Choose the tool from the Toolbar.

e Step 2. Set the parameters for the tool in the Options panel: size, blending mode, the
amount of opacity and others.

o Step 3. Check Use All Layers, if you need to work with several layers at once.

o Step 4. Check Aligned to create one clone selected from the area around a starting point.
The mouse button can be released and new fragments selected. Also, the mode and size
of the tool can be changed. If Align is unchecked, then each application of the tool will
create a clone from the same starting point.

e Step 5. Set a starting point. Do this by holding ALT, and then left-clicking on the point
from which the clone will be taken.

o Step 6. Move the cursor to the location where you want to copy the fragment.

e Step 7. Press the left mouse button and the clone will be applied. If the Healing Brush is
used, then the cloned fragments, texture, luminance, and shadows, will be processed in
relation to the pixels of the background image.

The Patch tool repairs an area with pixels copied from another area or image. Like the Healing
Brush, the Patch takes into account the texture, luminance, and shadows of the background
image.

This tool can be used in one of two ways:
Define the place where the clone will be applied, then drag the tool to the source point.
Follow these steps:

e Step 1. Choose the Patch tool from the Toolbar.
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e Step 2. Choose the shape and size of the tool in the Options panel, and select Source in
Patch's options.

e Step 3. Draw a line with the Patch tool around the part of the image that needs to be
restored.

o Step 4. Drag the selected area to a new spot, from which the clone will be created.
Define the source, then drag the tool to the damaged area.
Follow these steps:

e Step 1. Choose the Patch tool from the Toolbar.

e Step 2. Choose the tool's size and shape in the Options panel, and in Patch's options
select Destination.

o Step 3. Draw a line with the Patch tool around the part of the image that will be cloned.
o Step 4. Drag this area over the part of the image that needs repair.

The Pattern Stamp tool works by drawing with a repeating pattern. This tool can be used to
created a frame or design for wallpaper or for retouching the texture of part of an image. A
pattern is selected from the Pattern Palette in the Options Panel.

To use this tool, follow these steps:
e Step 1. Choose the tool from the Toolbar.
o Step 2. Set a pattern, by choosing it from the Pattern Palette in the Options Panel.

e Step 3. Choose the size and shape, blending mode, amount of pattern opacity and other
parameters for the tool in the Options Panel.

e Step 4. Press the left mouse button and drag the tool into the image.

A repeating pattern can also be used with the Healing Brush and Patch tool. To do this with
the Healing Brush, in the tool's options select Pattern for the Source and choose a pattern from
the Pattern Palette. To do this with the Patch tool - begin by using the tool to draw a line around
an area (or use a previously selected area), then choose a pattern from the Pattern Palette and
press the Use Pattern button.

The Color Replacement tool replaces one color in an image with another. This tool can be used,
for example, to repair the "red eye" effect.

Follow these steps to use the tool:
e Step 1. Choose the tool from the Toolbar.
o Step 2. Set the color which will be used to replace the intended color in the image.

o Step 3. Set the parameters for the tool in the Options Panel, such as: size and shape of the
brush, the color's blend mode, color choice mode, opacity, etc.

o Step 4. Click on the color in the image to be replaced.
Text Tool
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The Type tool allows you to add text to your file. You can use text on a variety of projects, such
as adding it to your images to create a poster, holiday card, or invitation. You'll also be able
to customize the text to suit your needs.

To use the Type tool:
1. Locate and select the Type tool in the Tools panel. You can also press the Tkey
on your keyboard to access the Type tool at any time.

2. In the Control panel near the top of the screen, choose the desired fontand text

size.
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3. Click the Text Color picker, then choose the desired color from the dialog box.
Adobe Photoshop CC 2014
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4. Click and drag anywhere in the document window to create a text box.
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5. A new text layer will be added to your document. You can start typing to add text
to the layer.
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If you want to add a lot of text to
your document, you may find it
easier to work with multiple text
layers. This will give you more
control over the apperance of your
text. In the example below, we've
added a second text layer for the
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Type tool tips
o If you want to edit a text layer, you'll need to double-click the layer icon in
the Layers panel. You can then change the text, resize the text box, or use the
options in the Control panel to choose a different font or modify text size and
color.
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o Foreven more text formatting options, go to Window, then select Character to
view the Character panel.
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o If you want to move the text, you'll need to select the Move tool and click and
drag it to the desired location in the document window.
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Rasterizing text

If you try to use certain tools with a text layer, such as Filters, you'll receive a warning message

asking if you want

Adobe Photoshop to rasterize the text.

Rasterizing means the text will
be converted into pixels,

This type layer must be rasterized before
proceeding. Its text will no longer be

editable. Rasterize the type? allowing you to make image
—_— adjustments that normally don't

S work with text. The downside is
Cancel [ik_J that you'll no longer be able to
edit the text, change the

formatting, or convert it back to a text layer. Therefore, you should only rasterize your text if you
absolutely need to. If you don't want to rasterize it, simply click Cancel to keep the text layer in its
current format.

BASIC SHAPE TOOLS IN PHOTOSHOP

Photoshop offers basic shape tools for working with your images and artwork. Rectangles,
rectangles with rounded corners (rounded rectangles), circles and ovals, multisided polygons,
straight lines and arrows, and a whole boatload of special custom shapes are all at your command
with a simple click-drag.
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Select the appropriate tool in the Toolbox, select the desired options in the Options bar, and
click-drag to create your object. (The various shape tools are nested in the Toolbox, as shown in
this figure.) Sounds simple, right? It is — no tricks. Here are some additional features to make

things even easier for you:

— Create Rectangle . .
\ (. 2 Use the Shift key. Pressing the Shift key (both
& (@ Rounded Rectangle Tool Width: 1100 px Height: | 100 px

e(llvn Tool u

@ Poveon Too QN (I Fron Cemer Mac and Windows) while you drag constrains

/ Line Tool u

Cancel OK

S Custom Shape Tool U

proportions (Maintains the width-to-height
ratio). With the Shift key, the Rectangle tool
creates squares; the Ellipse tool creates circles; the Polygon tool creates proportional polygons;
the Line tool creates horizontal or vertical lines (or diagonal lines).
When using custom shapes, pressing the Shift key ensures that the shape retains the
width-to-height ratio with which it was originally defined.

o Use the Option (Mac) or Alt (Windows) key. The Option/Alt key creates the object
centered on the point at which you click. Without the Option/Alt key, the object is
created in whichever direction you drag.

o Use the Shift and Option/Alt key. Pressing Shift and Option/Alt together helps you
create a proportionally constrained object, centered on the point at which you click.

e Click the shape tool. If you click rather than drag, you’ll open a small dialog box that
allows you to enter precise dimensions for your new shape. Click the OK button and the
shape is created to the lower right of (or centered on) the point where you clicked. The
dialog box is visible in the figure.

o Use the spacebar. While you’re dragging a shape, keep the mouse button down and
press the spacebar. You can then drag to reposition the object while you create it. Still
keeping the mouse button down, release the spacebar and finish dragging the object.

e Check the Options bar. When you switch from shape tool to shape tool, the Options bar
changes to fit your needs. For example, with the Rounded Rectangle tool active, you

choose the radius of the rounded corners.
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The Polygon tool offers a simple field in which you choose the number of sides for the
shape. When you’re using the Line tool, choose the thickness (weight) of the line in the
Options bar. Click the button to the left of the Weight field in the Options bar to add
arrowheads to the lines.

o Change the layer content. With a shape layer selected in the Layers panel, select any
shape tool and change the shape’s attributes in the Options bar. You can easily change (or
remove) both the fill and the stroke.

o Edit the vector path. You can use the Direct Selection tool to change the course of the
path, customizing the appearance of the shape.

e Create work paths or pixel-filled shapes. Using the three options in the menu to the left
on the Options bar, you can elect to create shapes, work paths (temporary paths used to
make selections or masks), or add pixels in the selected shape to your currently active
layer.

You can easily spot a shape layer in the Layers panel — especially when the default layer name
starts with the word Shape. (You can, of course, change the layer name by double-clicking it in
the Layers panel.)

You can see in the Layers panel shown in this figure that the shape layer thumbnail includes the
shape badge in the lower-right corner. When a shape layer is selected in the Layers panel, that

shape’s path is visible in the Paths panel.

3. Describe the use of colour correction

50



Color Adjustment

Basic Color Theory
RGB (short for Red, Green, Blue) An RGB color space

YELLOW is any additive color model. The main purpose of the
RGB color model is for the sensing, representation, and
display of images in electronic systems, such as
televisions and computers.

CMYK (short for cyan, magenta, yellow, and key
(black), and often referred to as process color or four
color) is a subtractive color model, primarily used in
color printing.

The major difference is that in a RGB color space, all the colors information are resulted from
the mixing of red, green, and blue; but in a CMYK color space, all the colors are results of the
mixing from cyan, magenta, yellow, and black. RGB color space is also more accurate to human
color sensory than CMYK.

When the same amount of contrast colors such as yellow/blue, red/cyan, and green/magenta
mixing together, it will produce a neutral gray tone. In color adjustment, to reduce the intensity

of one particular color is to add in the contrast color.

Levels

In this and the next chapter, we are going to use week2_ColorAdjustment.psd

To access the levels dialogue box, you simply go to Image>Adjustments> Levels. After you
select Levels, it will bring up the dialogue box with a histogram on it. In photography, a
histogram is basically a bar chart that shows all the tonal levels from the darkest point to the
lightest point that the image is made up of. The chart also shows amount of different tones are
presented in the image. For example, if it is a tall bar, that means there are a lot of that particular

tones are in the image.
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With Levels, we can correct the color, contrast, and brightness of parts and the entire image.

Here we want to adjust the white balance and exposure of this street scene photo.

Correcting Underexposure

Move the midtones slider to the left to bright up the dark tones;
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Correcting White Balance
To neutralize the redness, select the red channel from the Channel dropdown menu; then move it

to the right to reduce the intensity of redness in the image.
lovels

Gannet[Red ] o]
Input Levels: Gacal I
... | |t
swve.. | P
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o .59 1\\3 255 Options... |
Output Levels: / , /

IO 255

You can go to different channel to micro-adjust all the color value until you get the result you

want.

Curve

Curve is another powerful tool for adjusting color and contrast. You can use it to create different
color shifts and special effects such as solarization and color reversal. The main advantage of
using curve is that it allows to re-map colors and tones in several different levels. So you can
make precise changes.

Close and re-open week2_ColorAdjustment.psd. Next, go to Image>Adjustments> Curve to
bring up the curve dialogue box,

A. Adjust curve by adding points

B. Draw a curve with the pencil.
C. Brightest tones/Highlights
D. Midtones

Options... E. Darkest tones/Shadows

[V Preview

© F. Black and white point sliders
G. Curve display options
H. Set black point by sampling a point

Output:

which representing the darkest tone in

5

-
Input:

2 # # [ showCpping the image

¥, Curve Display Options

0 000 ©




I. Set gray point by sampling a point which representing the midtone in the image

J. Set white point by sampling a point which representing the brightest tone in the image

K. Show clipping while some tonal information are edited out through adjustment

Let's try to adjust the same photo with curve and experience the difference between levels and

curve

Brighten Up The Photo
First, click on the top-right curve segment (which representing the bright tones) to setup several
anchor points which will fixate the bright tones. Next, click on the lower-left curve segment and

move the anchor point a bit up to increase the brightness of the dark tones.

x|

[4v>_- A 7S shonOooryp

¥ Gorve Dsolry Ootons

Correcting White Balance
Similar to what we did in the levels dialogue box; select the red channel first; then drag the red

curve lower to decrease the red value
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Also, you can hit Auto to let Photoshop do the adjustment for you but it could be inaccurate.
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Hue, Saturation and Lightness (HLS)

Hue, saturation and lightness are commonly referred as the three main attributes of perceptual
color. Hue is that aspect of a color identified with names such as "red", "yellow" and etc.
Saturation is related to the intensity and colorfulness of one specific color. Lightness is a
property of a color which is defined in a way to reflect the subjective brightness perception of a

color for humans.

Change The Overall Color Scheme Of A Photo
Select Image>Adjustments>Hue/Saturation, it brings up the Hue/Saturation dialogue box.

You can move the three sliders around to try

EdR: I Master 'l

to get different looks of the photo.
'

= [ox 1]
Hue: 61 Cancel I
8
Saturation: |.55 LI
el
Ughtness: [B_
O
™ Colorze
r 2 P preview

Change One Specific Color In A Photo

In this exercise, we want to shift color of the beak to red only without affecting rest of the color.
1. Since the crane's beak is reddish yellow, let us try to select the red channel. Then move the
hue slider to the right end; now you can see part of the bird's peak changed to blue while rest of

image remains the same color.
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 Edit: | Reds

Hue:

Saturation:

Lightness:
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2. Part of the peak is still yellow; using Add to Sample (Shift + Click) on the yellow part to add

that part into your selection. Once you have done that you will find the background was affected

as well which is not the result you want to have.

3. To restore the background color, we can

accurately adjust the color range with the silder in the bottom of the dialogue box.

315°/345° 44\78° 2|2 2 & preview

e

A. Hue slider values
B. Adjusts fall-off without affecting range

C. Adjusts range of color and fall-off
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4. Move both sliders B and C to micro-adjust the color till the background looks normal, then

move the hue slider to the left till the beak appears in vibrant scarlet.

Edit: I Reds EI E
S Cancel
= Load... |
Saturation: |0
R Save...
e
Lightness: |0
A
~ I™ Colorize

330°/ 345° 46°\59° #| # 2 & preview
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Non-Destructive Editing: Adjustment Layer

The main advantage of using adjustment layer is it allows you to adjust the content with altering
the original pixels so you can delete them or disable them anytime you want. You can treat an
adjustment layer the same as a regular pixel layer; you can adjust the opacity and blending mode
of an adjustment layer. As well, you can save your adjustment layer in your PSD file; you can
always revisit any particular filter or effect you applied before and reset the attribute at anytime.
Whereas, the changes you made from the Image>Adjustment menu will permanently alter the
pixel information, and if you ever want to redo one of the many steps you have done so far, you

have to restart again. So it is highly recommended to use the adjustment layer all the time.

Hue/Saturation Alteration With Adjustment Layer
1. Open week2_ColorAdjustment.psd.
Click on the black-white circle icon( as the screenshot showed) at the bottom of the layer penal

to add an adjustment layer to the image and select Hue/Saturation
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2. After you add the Hue/Saturation as an
adjustment layer you can double click on the little
chart icon (on the adjustment layer) to bring up the
Hue/Saturation dialogue box; rest of steps are the

same with what you have done before.

Non-Destructive Editing: Layer Mask

The advantage of using layer mask for
erasing is similar to adjustment layer. You
can simply eraser tool to paint away the pixel
in a photo and make them invisible; however,
this is a permanently pixel alteration, you will

not be able to get it back unless you re-open

the file without saving it. With layer mask, you can still do the same thing but leaving the

original pixels unharmed and you can easily painted it back

Erasing With Layer Mask
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1. Select the layer mask icon at the bottom of layers panel

| Layers x | Channels | Paths |
INormal v l Opacity:
Lock: [ #+ @ Fill: [100% [ * ]

¥

v

H

= & M ® 2 & 3

2. Pick the brush tool with color set to black and start to erase the pixel around the crane.

| Layers x | Channels | Paths |
[l ] Ovect: [0 ]
Lock: D #+ @ Fil: [100% [ * |

59



3. Alt + Click on the layer mask to view merely the layer mask.

%)

4. Anytime and anywhere you want to paint back the original pixels, you can brush the black

| Layers x | Channels | Paths |

Layer mask thumt

= fx O ® 40 a1 3

color out with a white color in the layer mask, and the erased content will showed up again.
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"~ HOW TO USE COLOR BALANCE
- CONTROLS IN PHOTOSHOP

—_ & \Vith an understanding of Photoshop and color

theory, you can probably use the Color Balance

= @ e o @ s controls to make some simple changes to the
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color in your image. The difficult part is recognizing exactly which color you need to add or
subtract from your image in the first place.

Colors are subtler than you might think. For example, a slight colorcast toward cyan can look a
lot like a slightly green or blue colorcast. Is your image too red, or does it have too much
magenta?

To use the Color Balance controls, follow these steps:
1. Choose Image — Adjustments — Color Balance or press Ctrl+B (Command+B on the
Mac) to access the Color Balance dialog box.
2. Choose the Shadows, Midtones, or Highlights option to select the tones of an image you
want to work on.
Usually, Midtones is the best choice, unless your image has a colorcast in the shadows or
highlights that doesn’t affect the overall image. That can sometimes happen when a subject is
close to a colored wall or other object that reflects light onto, say, the shadowed side of a subject.
3. Select the Preserve Luminosity option.
When this option is selected, Photoshop modifies the colors of the image, but the brightness and
contrast of the tones stay the same. If you’re not happy with the results, deselect the option.
4. Move the Cyan/Red, Magenta/Green, or Yellow/Blue slider to add or subtract color,
watching the effects of your adjustments on the original image.
The Color Levels boxes show the amount of each color that Photoshop adds and subtracts while
you move the sliders. Here’s an example of subtracting yellow and green to improve the color in
an image.
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The colors are arranged by their opposites on the color wheel. Dragging the slider toward Cyan
adds cyan to the image and subtracts its complement, red. Dragging toward Green adds green to
the image and subtracts magenta.

CORRECT IMAGES WITH COLOR VARIATIONS IN PHOTOSHOP

The Color Variations command is a digital color-correction feature that’s been around for years
and is largely unchanged. That’s probably because it’s one of those great features that’s easy to
use and easy to understand, and it works.

The command enables you to make corrections by visually comparing thumbnails of color
variations of your image. You may use this command when you’re not quite sure what’s wrong
with the color or what kind of colorcast your image has.

Here’s how to use the Color Variations command:
1. In Full Photo Edit or Quick Photo Edit mode, choose Enhance — Adjust Color — Color
Variations.
The Color Variations dialog box appears, displaying a preview of your original image (before)
and the corrected image (after).
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Color Variations

o )
Cancel )
( Help )
Before
Tip (" Undo )

Select the brightness values you want to adjust (middle tones, dark areas, or
light areas). Drag the Amount slider to set the intensity of the change. Click a

thumbnail preview to make your image match it. ( Reset Image \

1. Select area of image to 3. Use buttons below to adjust your image.
adjust.
() Shadows
() Highlights Increase Red Increase Green Increase Blue Lighten
() Saturation
A
2. Adjust Color Intensity. - ,‘:

Amount. =f

Decrease Red Decrease Creen Decrease Blue Darken

2. Select a tonal range or color richness (if you’re unsure which range to select, start with
the Midtones):
o Shadows, Midtones, Highlights. These adjust the dark, middle, or light areas in the image,
respectively.
o Saturation. This adjusts the color intensity or richness, making colors more
intense (saturated) or less intense (desaturated). If your image is faded from time, be sure
to increase the saturation after you correct any colorcast issues.
Usually, just correcting the midtones is enough to get your image’s color in order, but if it’s not,
you can always adjust the shadows and highlights, as well.
3. Specify how much adjustment you want with the Adjust Color Intensity slider.
Drag left to decrease the amount of adjustment and drag right to increase the amount.
4. If you selected Midtones, Shadows, or Highlights in Step 2, adjust the color by clicking
the various Increase or Decrease Color buttons.
Click more than once if your initial application wasn’t sufficient to correct the problem.
Be sure to keep an eye on the After thumbnail, which reflects your corrections while you make
them.
5. Click the Darken or Lighten buttons to make the colors a little darker or lighter,
respectively.
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6. If you selected Saturation in Step 2, click the Less Saturation or More Saturation buttons.

7. 1f you make a mistake — or several mistakes, for that matter — click the Undo button.
The Color Variations dialog box supports multiple levels of undo. If you botch something, you
can always click the Reset Image button to start again. Keep in mind that you can’t undo the
Reset Image command after you click it. Click Cancel to bail entirely.

8. To apply your color adjustments and close the dialog box, click OK.

The Color Variations command is a great tool to correct those old, faded, green- (or some other
unwanted color) tinted circa-yesteryear photos. The Color Variations command allows you to
easily correct the color and saturation of these precious, but damaged, images. Remember to
either decrease the offending color or add the color that’s the opposite of the cast in the image. If

it’s too red, add cyan, and vice versa.

4. Identify the steps for Digital Painting and Matte Painting

Steps of digital painting

Stepl

First, let's take a look at the brushes that we will use. We only use two basic brushes here, brush
1 is used to soften hard edges and make gradient transitions, its advantage is no need to pick
color when paint in grayscale, you can gradually build up a gray scale of any level with a
pressure tablet using pure black and white. Brush 2 is actually a basic hard round brush with
shape dynamics option on. Brush 2 has very vivid edge. We use brush 2 mainly as a texture
brush and sketching pen. You can see the detailed settings in the following images.

BRusH | Beusi 2.
NO NEED To Plek coigR SHARP EDGE
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Step 2:The concept of this painting is a
crystal swan bathing in a glass of water, light
shines directly from top. There are three
materials in the painting: crystal swan, water,
and glass. Before painting, we need a swan

photo for reference.

Step 3We will not just copy the outline of the
swan in the photo. But extract the shape of the
neck and mouth. We will draw a swan out of
the two curves mostly. Wing and tail is minored
to avoid competing with the curves that | chose.
Let the audience focus on the neck and mouth.

This is my initial intention.

BRusH 2
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Step 4:Create a new layer. Press "D" to set foreground/background
color to black/white. Draw a basic shape of swan and glass with brush
2. The line doesn't need to be perfect, just enough to bring your idea
down on paper.

Step 5:Let's do more on the sketch layer. Create a new layer on top of

the sketch layer. Now we add more detail to the glass shape, and add a
water level, also notice the mouth tip in the edge of glass rim, it's the detail
I want exactly in my mind.

Step 6 @ —\

Here is the final version of my sketch, detailed and cleaned for

grayscale tone and coloring. ; *)/

Step 7

Now we will do our sketch in another way, you can see the route of
sketching is really not important, no matter which way you take, the
most important point is where to go, you must have the image in
your head first. Know what you desire most. The decision making
stuff is in the whole process of painting. We will begin with brush 2
but bigger brush size to draw a black curve block like this to indicate

swan shape in pure simple way. Notice the beautiful curve of neck,
mouth, belly, and little wings and tail, which | keep small to avoid
distracting audience's attention.

Step 8
Detailing the shape.
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|Step 9
Pick a lighter value to paint glass shape.

Step 10
Clean the edge.

Step 11
Go to Filter > Stylize > Find Edges.

|Filter | Analysis 3D View Window Help

Gaussian Blur Ctrl+F
Convert for Smart Filters

Filter Gallery...
Liquify... Shift+Ctrl+X
Vanishing Point... Alt+Ctrl+V

Artistic
Blur
Brush Strokes
Distort
Noise
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Render
Sharpen
Sketch
Stylize
Texture
Video
Other
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Step 12Now you have the sketching layer in a different way.

Step 13
Before we block the sketch layer, use the image below to demonstrate the light and value of this
painting. The widest light path shows
the main light stream coming from top, HIGhLZ6HT
traveling through semi-transparent PosITZWY
swan, water and reflected mostly in the
bottom of the glass, then reflected all
the directions out, make a bright light
source in the image. It's the first and
brightest spot in the image. Some light
goes through the bottom to light the

glass holder. The other four light paths
light the head of swan and wings and tail just emerged from the water. Create a beautiful
highlight on them. Keep these light positions in mind, we will use it later in blocking and
coloring.

Step 14

This is another demonstration made only by brush 1. We
can see the tone mainly lies in three levels, 0, 50, 90. It
transfers the idea clearly enough, though lots of brush
strokes makes the image a little dirty.

Step 15

Now we start blocking the image on the sketch layer. Activate sketch
layer, use Magic Wand tool (W) to click on the background, we will
select the background area, then create a new layer on top of the sketch
layer with the selection on.
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Step 16

Choose Gradient Tool (G) to make a line
as indicated below. This fills the g e, .
background with a gradient look.

Step 17

This is more detailed version of the value we used to
fill some of the blocks. But you have no need to copy
it exactly as | do. Just play around the value 1

mentioned in Step 14.
- [ aowusn |

Step 18
Here are the block layers we will make. Note we put them in separate layer for future selection
and coloring.
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Step 19
Now we select the head of swan as in
step15, and use Paint Bucket Tool (G)

to fill the value. These blocks are more P A ) .
flat than the blocks filled with Gradient ’ o e ;
Tool, so Paint Bucket Tool is preferred ’ '-,
and also we can use brush 2 with big o S
brush size.

&
Step 20

Here we have an image showing the exact value we
choose. Again you don't have to copy the numbers
exactly, just pick around the number | demonstrated
step 14.

Step 21

Make all the layers we have so far made visible including the
sketching layer which will be at the bottom of these layers. Image
like this will come out as below. Group all the layers. Name it
whatever you want. Press Command/Ctrl + Shift + Alt + E to
emerge all the layers, yet saving the original layers. It's useful when
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you want to go back to do some correction. This layer group will be used frequently later in
selection for coloring and adjusting.

Step 22

Now we have the basic valued laid on the sketch layer. Every
tool will be taken to make it more realistic and eye-catching.
Look at the image, we will find the circled areas are a little bit
too bright, so darken the areas.

Step 23

We will use a curve adjustment layer to darken the areas we mentioned [ Sebta ote..
above, this is how we do it. Activate the background layer, click the e
adjustment icon on the bottom of layer panel, or go to Layer > New Brightness/Contrast. ..
Adjustment Layer > Curves, it will pop up a window as indicated :::.

below, click the hand icon and move it to the area you want to darken, e

then drag down a little bit. You will see the result come out. Stop at sy
where you think is proper. Press "D, set color to black/white. We Will | shte riteer. .

Charnel Mixer...

use brush 2 painting on the darken areas to mask.

Invert

Posterize...

Threshold...

Gradient Map...

Selective Color... ro—

N €

71



Step 24

Step 25
Go to Filter > Blur > Gaussian Blur, Radius 56.1, you can put in any number you like just make

sure it's big enough to soften the edges. This blur technique will be used frequently afterward in
any situation, which makes hard edges or borders.
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Step 26

Apply the same technique to the other two blocks. And at last we have this image, no big change
but you can see the difference.
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Step 27
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Now look at the belly part of swan in the water.
How dull it is. In real world, distinctly separated
blocks are unusual, let's make these part flow into
the neighborhood a little bit, create some motions
to let it look like more realistic and alive. Look at
the arrows in the image, that's where brush
works.

Step 28

Use brush 1 to lighten or darken the areas BRUSH |
spotted in the image. Press "D" to set color to
black/white. Press "X" to switch between black
and white. Use white to lighten and dark to
darken. That's the advantage of brush 1, no
need to pick color during painting. All you
need to do is press "X" to switch. Use very

little pressure, make small alteration.

Step 29
Result seems not so good, but not bad either, so
we will just keep it.

Step 30
Now we are going to make the sketch line emerge into

the surrounding areas. Activate sketch layer, make
foreground color to pure white by pressing "D", then
press "X" to switch. Then Select > Color Range,
fuzziness 30, click Ok. As the color picker is already
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set to pure white, which is the background color, so Color Range command will select the
background area. Then activate the swan layer we are working on. Press Command/Ctrl + Shift +
I, make reverse select. Now we have the sketch line selected.

Color Range rg}

Select: / Sampled Colors. 7 ,",7

[JLocalzed Color Clusters
Fuzziness: 30 |

5
'7 1

|

222

Cinvert

® selection O Image

Selection Preview: | None v

S
e e e rr s 200
;:.-.-:::4.-". Fe

7

Step 31

Choose brush2, with a brush size just a little bigger than the sketch line width. Press
Command/Ctrl + H to hide the selections. Then pick color from both sides of the line then draw
on the line. This will make the line disappear into surrounding blocks.
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Step 32
Adding highlight. Use brush 2 with pure white. Highlight position is indicated in Step 13.

Step 33
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Next is the detailing stage. In the image below we spot three areas need further improvement.
Water level is flat, no reflection, and the part between wing and body is not filled yet. Light at

the bottom has a very ugly edge. Use brush 1 to improve.

B \ts H [

Step 34

Enlarge the image we will see some
irregular white dots, let's eliminate
these by median filter in a quick easy
way. Go to Filter > Noise > Median,
Radius 1 pixels, this is important;
radius should be 1 pixels exactly.
More will change the shape of swan.
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Step 35
Still some dark dots left. This time we will use brush 2 to cover it. Just pick the colors around the

dark dots by color picker. Then paint on it.

79



Step 36

Now we are going to work on the edges as shown below. Edges are quite important if you want
to paint something realistic. Look at the mountains far away, you will notice that textures, details
are lost first, then color lost in further distance, vivid edges still survive even at the farthest place.
Interestingly, that's just how we paint reversely, edge with basic shape, color, then details. Look
how | work on the edge of glass and its holder. It's a quick tip to make your picture convincing.
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BrUsH |

Step 37

Let's review our original concept, which is a bathing swan in a glass of water. Now the swan is in
good shape and also glass. But water is just flat. It's time to work on "Water". As a swan is
bathing in the water, the wing and tail must be wet. It should have more reflections, which means
more highlights. And the left neck part of swan should receive more light reflections from glass.
And we need more contrast below the wing. Again using brush 1 to improve. Note that all the
changes we have made in every step are all very subtle separately, zoom in and out of the image
frequently will help you to "see™ the difference you made.

BAUSH |

Step 38
In this step we work on three parts. Part one is cleaning some minor strokes in left part of glass,

part two is softening the light bottom more, part three is smoothing the brush stroke part on the
right and drag it along the rim of glass mouth to the left. Use Smudge Tool to work.
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Step 39

Now work on the negative space to make glass step out from background. Use the curve
adjustment technique mentioned in the previous steps to darken the space around the glass. Don't
forget to mask and blur after curve adjustment. It's another way to bring a sharp edge.

Step 40
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Remember the mouth | mentioned in the very first beginning of the tutorial. The mouth tip under
the glass is a very small yet exciting part of this image. So let 's highlight it. And the crack in the
back part of the belly. It seems not bright enough, but we don't want to break the balance we

have already created so far, So let's darken the part around it to make it look more bright.
BrUsH |

Step 41

Now let's take a little break. Try to move our eyes to other part of the image rather than swan.
We will notice the two parts we found do not fit into the image really well. Again, use curve
adjustment technique to darken it.

Step 42
Finally, look at our image, everything seems so perfect, all we need to do is coloring now. But

wait, our initial intention is a realistic swan bathing in a glass of water. Realistic, The swan is
beautiful and do have a shape which is convincing enough to make people believe it is a swan.
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But texture is missing. In a real world there is no perfection. Use brush 1 with brush size 1 pixel
and color pure white to make these white dots over swan. And brush 1 to paint some cracks and
shadows as indicated below.

BrUsH |

Step 43

It really seems perfect now. We've done all we could. Use the technique in the previous steps,
move your eyes from the part you want to perfect. Usually it is not the part you focus on causes
the problem but the part you ignored. So let's try to unfocus the swan, move our attention to the
water and glass. Yes, Water, glass is as transparent material as swan, or even more, yet they have
no little highlight reflection, that's the weird part of this image. So use brush 2 with the same
settings as previous step to add highlight. Note the highlight dots on the glass, the position is
well chosen not randomly picked. It doesn't conflict with the edge of glass, yet implies the curve

of the glass.
BrUsH 2
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Step 44 -
- H i |

Now let's go to the coloring part. When working with
) oP i~ [800k > [ fouek
color, keep color temperature knowledge as indicated

below in mind is important. It means that a color makes }‘ »!
hue shifts as it goes lighter or darker. And middle tones C Cj
are often more saturated than lightest or_darkest part. So HWZ gz NOHUE NG 2
if you pick color from color wheel to paint, let the color
goes in a curve as indicated below, also make sure hue
changes as value and saturation changes. It's the key of
coloring.

Step 45

Pick color and use selection we have already
made separated layers for selections. You can
use Paint Bucket Tool (G) to fill or brush 2 with
proper brush size. The color layer will look like
this finally. Pick color as mentioned

in the previous step, you can see a clear hue
shifts from yellow to red, and saturation goes
higher in the middle tone in the image below. A
tip in realistic coloring is: most colors in real life

are rather dull. Don't make mistake of , Y
over-saturation. Keep it low at first. This is the principle of traditional painting. But in the digital
painting era, it's always easy to go back. And over-saturation can help you identify the part you
dislike quickly. If you don't like it, just de-saturate it. So next, we will go the step of over-
saturation, lower it if we dislike, raise it if it's too desaturated. Until we find balance in color.

Step 46
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Make the color layer on top of the grayscale layer. Change layer mode to
"color".

Group 11 copy

= 0 0 J 3 3

Step 47
Let's over-saturate it by click on the adjustment icon on the bottom of layer panel, choose
Hue/Saturation. See more detailed settings in the image below.

. ADJUSTMENTS
Gradient...

Pattern... Hue/Outrntien [ cetee M)

Brightness/Contrast... 0 master v

Levels... :

Curves... s - [°—J

Exposure... )
Saturation: 1_.53_

Vibrance... 3

Hue/Saturation... Ughtness: E
Color Balance... Y

Black & Vhite...
Photo Filter...
Channel Mixer...

U

Invert 2 ¥ 7 [Ocoore
Posterize...

Threshold... | m—
Gradient Map... e
Selective Color... (@, SR e e 0 3




Step 48
Use the sketch layers to select background, then activate image we m

are working on with selections on. Go to Filter > Blur > Gaussian

Blur. Radius 41.1 or any number it seems proper. Just to make

image seem smooth.

Gaussian Blur

[GEg] analysis 30 view window Help | [ Fv 0%
| Convert for Smart Filters
Filter Gallery...
Liquify... Shift+Ctrl+X
Vanishing Point... Alt4Ctrl+V
Artistic »
Blur ld Average
Brush Strokes > Blur
Distort » Blur Nore
Noise ’
Pixelate ’
Render »
Sharpen »  Motion Blur...
Sketch »  Radial Blur...
Stylaze »  Shape Blur...
Texture »  Smart Blur... e
Video »  Surface Blur... Radius: L | pixels
Other e e
Diginarc ’ —)- - -
Brovse Filters Online...
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Step 49
Now the whole image seems too saturated, we need to lower saturation down except the swan.

Swan is the part we want our audience focus on. Good painting are always coming out from
good contrast. When you find something wrong in your painting, don't blame the wrong part
first, try to work the part around it. That's the negative space painting way. And in the following
color adjustment steps, the exact color code will not be given. Actually, it's the fun part of
painting, you could try for yourself under the tips mentioned in the previous step. Let your eye
be your judge, if you dislike it, then just modify it. Eye tells you everything.

Step 50

Now we will de-saturate the part indicated in the previous step.
Create a new layer, layer mode set to saturation. Pick any color
just on the left of current color of the image that means a de-
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saturated color. With background and glass holder selections on, we paint it by brush2. And blur
it if there are any hard edges. Final results will look like this. Don't worry about the ugly look of
the results, it only affects the saturated part.

| Layer 50

rF 3 !
s & 0 © 2 1 3
Step 51

Merge the layer using Command/Ctrl + Shift + Alt + E, we will have a de-saturated look. The
left part seems not fully de-saturated. Let's do it again, using same technique. Pick a less
saturated color and paint on a new layer with brush 2, layer mode set to saturation, blur it if there
is any hard edges. As we are use hard brush 2, so a Gaussian Blur is always in need.
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Step 52
Now it looks Ok with the whole image. But we

still need some color highlight to make the image
come to life. Select brush1 with brush mode
"Linear Dodge (Add)", pick the color where you
paint as pointed out in the image below. Then
paint with pressure gradually increasing.

90
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Step 53
Press Command/Ctrl + J to duplicate the image.
Layer mode “overlay", down the opacity to 33% to

make more contrast.

Step 54
Go to Hue/Saturation adjustment as in the previous
steps.
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Step 55
Paint some shadows on the glass holder with brush 1 to compensate the volume loss during the
process of color adjustment.

Step 56
Zoom in/Out the image a little bit to observe. Find out the glass part is far saturated than we

want. Ok, | confess | forgot this part in the de-saturation step. Let's do it again as in step 50.
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Final Image

93



Photoshop Matte Painting

Introduction

Ever wonder how those incredible scenes of panoramic vistas, impossible futuristic cities, or
fantastic alien worlds come to life? It's all through the magic of matte painting. If only | had a
dollar (hey, inflation!) for every time someone responded, "Map painting?" But you know what
I'm talking about, right? If you don't, a brief history lesson is in order.

Ages ago, extremely talented artists painted these realistic scenes on large sheets of glass. It
really is a lost art nowadays. The painting included blank areas that would get filled in with live
action. The filmed segments were optically composited with the painting for the final result. A
matte is a solid shape that is used to block out areas of the film frame so that no image gets
exposed there. A simple matte shot would require a shot of the painting with a matte to block out
the live area, the film sequence with a matte to block out everything but the live area, and a final
piece of film for everything to be exposed onto.

The Digital Revolution

With the invention of Adobe Photoshop, things began to change. What used to require laborious
work in a film studio with several lengths of film and expensive, specialized cameras can now be
done on a home computer with easily available software. No matter how you approach it,
Photoshop has become an integral part of the process. The simplest matte paintings are ones in
which the camera is stationary throughout the entire sequence. This is called a locked-off shot.
Creating a matte painting for this kind of shot can be fairly easy. Only one frame, or plate, of the
footage is needed. It can be opened in Photoshop and the new areas painted right on top.

How to do it?

Step 1 — Size
Open the background stock. The size of the stock is width: 2250px and Height: 1500px.

Image Size

Pixel Dmensons: 9,66M
<um- 22500 pxes v ] Cancel
]
Height: 1500 pxes v
Auto...

Document Sae:

Width: 79,38

Heght: 52,92

Step 2 — Smart Object
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Transform the background into a smart object. Pressing right click in the layer thumbnail and
selecting the option Convert to smart object.

v Opaclty: 100% *

Convert to Smart Object a Fill:| 100% | »

Select Semvdar Layers

Step 3 — Smart Object
Press double click in the smart object thumbnail.

®
[Smart Object thumbnail |

Ooddle: X,

Step 4 — Edit
Now a new window will pop up. This allow you to edit the smart object. So press ok.

|

Adobe Photoshop CS5 Extended

/ 4 ) After editing the contents, choose Fie > Save to commit the changes. Those
) changes wil be reflected upon returning to
h Lookout_misty_mountains_by_CAStock.jpg.

The file must be saved to the same location. If the Save As dialog appears, choose
Cancel, and flatten the image before saving.

| Don’t show again

Step S — Duplicate
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Now press Ctrl+J to duplicate the layer in case you need to go back to the original image.In this
layer you will use the patch tool to hide undesired parts of the image.
) R

[(R7=——

1500807 N 20e NNk

Step 6 — Duplicate and Change color
Press Ctrl+] to duplicate the layer and then press Ctrl+U and in the option saturation put -70. The

image will have this color.

Hue/Saturation

Prgset: Custom

Master

Hue:

Step 7 — Save
The the changes you made to the smart object press ctrl + S and close the window.

I8 Layer 03700030 @ 33.3% (Layer 0 copy 2. RGE/8) =] =x=

Step 8 — River
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Now go to folder you have the stocks and grab the image of the river. You will see that the
image is an smart object itself, you can change the size clicking in the corners.

[ ——

Step 9 — Layer Mask
Create a layer mask to erase the undesired parts of the image. Pick a soft round brush to paint
over the parts you want to remove. You will have something like this:

e
@,
s

A

LA

[«
i
7,
.
'Y
'Y
2.
7.
X,

Step 10 — Hue and Saturation

Go to Create a new fill or adjustment layer and click in the option Hue/Saturation.
Vibeance

Hue/Saturation...
Color Balance..
Black & White.
Photo Filter
Channel Moxer

-
Posterce
Threshold
O pdera WA
Selecte LN
ATV
Reduce the Saturation to -60.
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ADJUSTMENTS

Hue/Saturation (. aom -
"{:5 Master v
Hue: 0
S l l- : 7-“5 =
Ughtness: 0
é el

Step 11 — Apply to one object
To Apply the changes only in the layer of the river you have to press right click over the Hue and
Saturation layer and select the option Create Clipping Mask.

e N0
Disable Layer Mask F
|

Create Clipping Mask

Select mdar s o

Step 12 — Duplicate
Now go back to the Background image and duplicate the layer pressing Ctrl+J and then change
the layer mode to soft light.
.- -l F._.I
o ——, ol =
L4

] b _

13.23% - } —
»

=
% LAVIRS
A
b |

:d!'.zﬁ v Opacty 00

ki /40 Al 300%

|® s & 3] masmn.

"lm

.-
- '
* | Layer O copy

’_ Laywe 0
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Step 13 — City
Grab the image of the city, and repeat the process of creating a new layer mask to blend the layer
to the background

B tutoriati.psd @ 50% (Backg _1562_by | _stock, RGB/S) *

Layer mask:
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Step 14 — Blur
Now go to filters — blur — Gaussian blur and add 2 radius pixels to get this result:

Step 15
Now pick a castle and resize it to fit the mountain like this:
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Step 16 — Layer Mask
Create a layer mask and like you did before hide with the brush tool the parts you don’t want to
use of the image.
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Step 17 — Layer mode
Change layer mode to overlay.

Step 18 — Waterfall

Step 19 — Layer mask
Use the layer mask technique once again to blend the waterfall.
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Change layer mode to soft light

Step 20 — More Elements

Now add more elements to the image, can be mountains, castles, ruins, all of this to give to the
image a better look. Use the layer mask technique you learned in the steps before in each of the
elements and remember to change layer mode to soft light or overlay.
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Step 21 — Add a Stone
Pick a stone stock and add to the image, resize it pressing Ctrl+T.

Step 22 — Select the stone
Now with the Polygonal lasso tool select the stone.

“,

PONEBFANACFNNFAS 2R

Step 23 — Layer
Add a layer mask to the image to have the selection.

104



Step 24 — Duplicate
Duplicate the layer pressing Ctrl + J and then change the layer mode to multiply with 60% of
opacity.

Step 25 — Moss
Add a moss layer, create a Iayesk and hide the undesired parts.

Result:
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Step 26 — adjustments
Use the layer mode in soft light and reduce the saturation to -40.

RS AousTMeNTs ARSI

_ Hue/Saturation (. coom

BB Master -

-

Step 27 — Model

To hide the original background of the model, you have to use the polygonal lasso tool and select
only the model.
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Step 28 — Layer Mask
Now add a layer mask to the image, In that way the selection you made is going to be the only
thing you see.

V= [
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Step 29 — Dress
Duplicate the layer and select only the model’s dress using the same technique as before. Using
layer mask and with the brush hide the undesired parts.

- o

Step 30 -
Now go the the layer mask and choose the option add mask to the selection to have an editable
layer of the dress.

N

Disable Layer Mask

Delete Layer Mask

Apply Layer Mask

Add Mask To Selection
Subtract Mask From Selection
Intersect Mask With Selection

Refine Edge...

Mask Options...

Step 31 — Change size and color.
Now press Ctrl +T give a right click and choose the option warp to modify the dress, press enter
when you are done to save the changes.
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Step 32 — Converting
Convert the dress layer into a Smart Object pressing right click in the layer thumbnail and then
selecting the option Convert Smart Object.

S S
Convert to Smart Object

Step 33 — Black dress
To make the model’s dress black you have to reduce the saturation to -100.
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BB AosusTmenTs [

Hue/Saturation ¢ som

Q‘ﬁ Master +

Step 34- make up
Now for the make up I just paint over the model’s face with pink tones in the cheeks and lips and
some brown in the eyebrows. Also add some eye shadows.

Step 35 — Hair
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You can paint the hair with the help of some hair brushes pen tool or tablet.

Step 36 — City lights

Now to make the city lights, create a new layer and with a soft round brush paint to create lights.

You can use the brush in 5 px or less.
3 o g

Step 37 — Blur
Go to filter — blur — Gaussian blur and select 2 px radius to give a softer look. Also you can use
the eraser with 30% of opacity in some parts to blend the lights.
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Gaussian Blur

Preview

Step 38 — Sky
Put a layer of a sky and add a layer mask to it.

Step 39 — Hide
Hide all the blue parts and just leave like this:
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Step 40 — Layer mode
Change layer mode to soft light and re

duce the opacity to 60%

Soft Light ~ Opacty:| 60% |» |

Step 41 — Light
Paint light effects with a soft round brush with 50% of opacity and 50% of flow.

Lé-ﬁjm:m .Ms«.-@m-s«.-l(vf@
[ tutoriatt.psd @ 40% uz RGE/E) v
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Step 42 — Soft Light
Change layer mode to soft light and the opaC|ty t060%.

Step 43 — Shadows
Create a new layer and use it in soft light mode. Paint with a soft round black brush with 50% of

opaC|ty and 50% of flow.
v [ Mo wema  Oman som + | (@) Fom son ] £
Seﬁbght + Opacty:| 100% [ 100% [»] =S

Step 44 — Freeform Pen Tool
Nowpick the freeform pen tool to make details stand out.
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Step 45 — Paths
After you make all of the strokes give a right click and press the option stroke path

Create vector mask

Delete Path

Define Custom Shape...

Make Selection

FarS

Stroke Path...

Free Transform Poth
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Then select brush pressure:

Stroke Path

Tool: | & Brush |

V| Simulate Pressure

The result is this:
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Step 46 — Blur

Pick the blurand also the smudge tool and pass over the stroke you just made to give a softer
look. Also reduce the opacity of the layer to 60%.
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Step 47 — Lights
As you did before pick a soft round brush in a white or yellow tone and paint around the model
to create lights, make sure the brush have 50% of opacity and 50% of flow.
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Step 48 — Layer mode

Change the layer mode to soft light, if you think is necessary you can reduce the opacity. Repeat
the process with warm tones around the image. In this way you will be creating the direction of
the light. Start in the left corner of the image with more intensity and less intensity in the right
area of the image.
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Step 49 — Dark
Now in a new layer in soft light mode paint with a black brush with 50% of opacity and 50% of
flow to get this result:

Final Results
That’s it

5. Use different blending modes

The blending mode specified in the options bar controls how pixels in the image are affected by
a painting or editing tool. Think in terms of the following colors when visualizing a blending
mode’s effect:

e The base color is the original color in the image.

e The blend color is the color being applied with the painting or editing tool.
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e The result color is the color resulting from the blend.
Blending mode descriptions

Choose from the Mode pop-up menu in the options bar.
Note:

e In the Blend Mode pop-up menu, scroll over different options to see how they look on
your image. Photoshop displays a live preview of blend modes on the canvas.

e Only the Normal, Dissolve, Darken, Multiply, Lighten, Linear Dodge (Add), Difference,
Hue, Saturation, Color, Luminosity, Lighter Color, and Darker Color blending modes are
available for 32-bit images.

Normal

Edits or paints each pixel to make it the result color. This is the default mode. (Normal mode is
called Thresholdwhen you’re working with a bitmapped or indexed-color image.)

Dissolve

Edits or paints each pixel to make it the result color. However, the result color is a random
replacement of the pixels with the base color or the blend color, depending on the opacity at any
pixel location.

Behind

Edits or paints only on the transparent part of a layer. This mode works only in layers with Lock
Transparency deselected and is analogous to painting on the back of transparent areas on a sheet
of acetate.

Clear

Edits or paints each pixel and makes it transparent. This mode is available for the Shape tools

(when fill region Y is selected), Paint Bucket tool &, Brush tool ¢, Pencil tool &, Fill
command, and Stroke command. You must be in a layer with Lock Transparency deselected to
use this mode.

Darken

Looks at the color information in each channel and selects the base or blend color—whichever is
darker—as the result color. Pixels lighter than the blend color are replaced, and pixels darker
than the blend color do not change.

Multiply

Looks at the color information in each channel and multiplies the base color by the blend color.
The result color is always a darker color. Multiplying any color with black produces black.
Multiplying any color with white leaves the color unchanged. When you’re painting with a color
other than black or white, successive strokes with a painting tool produce progressively darker
colors. The effect is similar to drawing on the image with multiple marking pens.

Color Burn

Looks at the color information in each channel and darkens the base color to reflect the blend
color by increasing the contrast between the two. Blending with white produces no change.
Linear Burn

Looks at the color information in each channel and darkens the base color to reflect the blend
color by decreasing the brightness. Blending with white produces no change.

Lighten

Looks at the color information in each channel and selects the base or blend color—whichever is
lighter—as the result color. Pixels darker than the blend color are replaced, and pixels lighter
than the blend color do not change.
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Screen

Looks at each channel’s color information and multiplies the inverse of the blend and base
colors. The result color is always a lighter color. Screening with black leaves the color
unchanged. Screening with white produces white. The effect is similar to projecting multiple
photographic slides on top of each other.

Color Dodge

Looks at the color information in each channel and brightens the base color to reflect the blend
color by decreasing contrast between the two. Blending with black produces no change.
Linear Dodge (Add)

Looks at the color information in each channel and brightens the base color to reflect the blend
color by increasing the brightness. Blending with black produces no change.

Overlay

Multiplies or screens the colors, depending on the base color. Patterns or colors overlay the
existing pixels while preserving the highlights and shadows of the base color. The base color is
not replaced, but mixed with the blend color to reflect the lightness or darkness of the original
color.

Soft Light

Darkens or lightens the colors, depending on the blend color. The effect is similar to shining a
diffused spotlight on the image. If the blend color (light source) is lighter than 50% gray, the
image is lightened as if it were dodged. If the blend color is darker than 50% gray, the image is
darkened as if it were burned in. Painting with pure black or white produces a distinctly darker or
lighter area, but does not result in pure black or white.

Hard Light

Multiplies or screens the colors, depending on the blend color. The effect is similar to shining a
harsh spotlight on the image. If the blend color (light source) is lighter than 50% gray, the image
is lightened, as if it were screened. This is useful for adding highlights to an image. If the blend
color is darker than 50% gray, the image is darkened, as if it were multiplied. This is useful for
adding shadows to an image. Painting with pure black or white results in pure black or white.
Vivid Light

Burns or dodges the colors by increasing or decreasing the contrast, depending on the blend
color. If the blend color (light source) is lighter than 50% gray, the image is lightened by
decreasing the contrast. If the blend color is darker than 50% gray, the image is darkened by
increasing the contrast.

Linear Light

Burns or dodges the colors by decreasing or increasing the brightness, depending on the blend
color. If the blend color (light source) is lighter than 50% gray, the image is lightened by
increasing the brightness. If the blend color is darker than 50% gray, the image is darkened by
decreasing the brightness.

Pin Light

Replaces the colors, depending on the blend color. If the blend color (light source) is lighter than
50% gray, pixels darker than the blend color are replaced, and pixels lighter than the blend color
do not change. If the blend color is darker than 50% gray, pixels lighter than the blend color are
replaced, and pixels darker than the blend color do not change. This is useful for adding special
effects to an image.

Hard Mix
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Adds the red, green and blue channel values of the blend color to the RGB values of the base
color. If the resulting sum for a channel is 255 or greater, it receives a value of 255; if less than
255, a value of 0. Therefore, all blended pixels have red, green, and blue channel values of either
0 or 255. This changes all pixels to primary additive colors (red, green, or blue), white, or black.
Note:

For CMYK images, Hard Mix changes all pixels to the primary subtractive colors (cyan, yellow,
or magenta), white, or black. The maximum color value is 100.

Difference

Looks at the color information in each channel and subtracts either the blend color from the base
color or the base color from the blend color, depending on which has the greater brightness
value. Blending with white inverts the base color values; blending with black produces no
change.

Exclusion

Creates an effect similar to but lower in contrast than the Difference mode. Blending with white
inverts the base color values. Blending with black produces no change.

Subtract

Looks at the color information in each channel and subtracts the blend color from the base color.
In 8- and 16-bit images, any resulting negative values are clipped to zero.

Divide

Looks at the color information in each channel and divides the blend color from the base color.
Hue

Creates a result color with the luminance and saturation of the base color and the hue of the
blend color.

Saturation

Creates a result color with the luminance and hue of the base color and the saturation of the
blend color. Painting with this mode in an area with no (0) saturation (gray) causes no change.
Color

Creates a result color with the luminance of the base color and the hue and saturation of the
blend color. This preserves the gray levels in the image and is useful for coloring monochrome
images and for tinting color images.

Luminosity

Creates a result color with the hue and saturation of the base color and the luminance of the
blend color. This mode creates the inverse effect of Color mode.

Lighter Color

Compares the total of all channel values for the blend and base color and displays the higher
value color. Lighter Color does not produce a third color, which can result from the Lighten
blend, because it chooses the highest channel values from both the base and blend color to create
the result color.

Darker Color

Compares the total of all channel values for the blend and base color and displays the lower
value color. Darker Color does not produce a third color, which can result from the Darken
blend, because it chooses the lowest channel values from both the base and the blend color to
create the result color.

Blending Modes or Blend Modes?
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Officially they are known as Blending Modes, but you can use the names interchangeably. |
sometimes refer to them as “Blend Modes,” so no worries as to which name you use. As longs as
you know how they work!

Opacity vs. Fill With Blending Modes

19 out of the 27 Blending Modes behave the same way when Fill is adjusted, compared to when
Opacity is adjusted. However, eight Blending Modes give you a different result when Fill is
changed compared to Opacity.

Itis crucial to understand the difference because this additional method of blending pixels
extends the capabilities of Blending Modes. More importantly, the blend tends to be more
aesthetically pleasing when using Fill rather than Opacity with these eight Blending Modes.

In the example below, you can see how a graphic with different luminance values and a photo of
Venice were blended using the Hard Mix Blending Mode. The image in the center is set at
Opacity at 50%, while the image on the right is set to Fill at 50%.

Hard Mix Hard Mix (Opacity 5Q%; Hard Mix (Fill 50%)-w
3.

The Blending Modes that are part of this group of 8 are Color Burn, Linear Burn, Color Dodge,
Linear Dodge (Add), Vivid Light, Linear Light, Hard Mix, and Difference.

“Transparency Shapes Layer” Check Box

The 8 Blending Modes in this group, also give you an extra level of blending by un-checking the
“Transparency Shapes Layer” checkbox in the Layer Style panel.

Layer Style X

= Blending Options
Sty General Blending OK
Blending Options Blend Mode:  Normal

Cancel
Bevel & Emboss Opacity: & 10 %

Contour Advanced Blending New Style...
Texture Fill Opacity: a 10 % Dren e
Channels: @R @6 B

Stroke Knockout: None

Inner Shadow Blend Interior Effects as Group
2 Blend Clipped Layers as Group
Transparency Shapes Layer
Layer Mask Hides Effects
Vector Mask Hides Effects

Inner Glow
Satin

Color Overlay

Blend If: Gray
Gradient Overlay

This Layer: 0
Pattern Overlay

Oulse Clow Underlying Layer: 0

Drop Shadow

255
]
o
S5
-
o

Drop Shadow
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In the example below, you can see how Linear Light blends differently when “Transparency
Shapes Layer” is unchecked. Notice how the edges of the circles blend differently on the
example on the right.

Normal o

Base + Blend = Result
You should remember these three terms to understand how Blending Modes work.

The “Base” color is the original color in the image.

The “Blend” color is the color applied with the painting or editing tool to the Base layer.

The “Result” color is the color resulting from the blend.

How the Base and the Blend colors mix depends on the algorithm or Blending Mode that you
select.

Result ColorN lBIend Layer

.

—

N
Base Layer
Blend Mode Math

For those of you who are interested in how the math behind Blend Modes work, I’ve created a
simplified explanation.

Photoshop uses “Standardized” values to calculate the blend. The luminance values in Blending
Mode math range from 0 (black) to 1 (white). However, Photoshop uses 0 (black) to 255 (white)
to represent luminance values in RGB. Photoshop has to convert the values, so black is still 0,
but white becomes 1. 50% gray which is 128 becomes 0.5.

Luminace Values

0 128 255

0 05 1
Standardized Values (128+255=0.5)
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To convert an RGB luminance value to a standardized value, dive it by 255. For example, divide
192 (light gray) by 255, and you get 0.75 (192+255=0.75).

Math Sample:

A = Blend Layer Standardized Value

B = Base Layer Standardized Value

Multiply:

AXxB = Result

Color Dodge:

B+(1-A) = Result

Adobe provides descriptions on each Blending Mode, but they do not provide the mathematical
equations behind them. If you would like to find out more about Blending Mode math, check out
the Wikipedia page on Blend Modes.

Each Blend Mode Explained

In the examples below, we will explain each of the 6 Blend Mode categories (Normal, Darken,
Lighten, Contrast, Inversion, and Component) as well as all the Blend Mode in within each
category.

The graphics in each section will show the outcome of each Blend Mode at 100% opacity unless
otherwise noted.

Each example contains two Blend layers, a grayscale luminosity layer, and a color layer. The
photo of Venice, Italy will be the Base layer.

Luminosity Blend Layer Color Blend Layer

Base Layer Base Layer

Normal Blending Modes

The Blending Modes in this category do not have algorithms that blend pixels. Instead, the
Opacity slider controls the blend between layers.

Normal

“Normal” is the default Blending Mode for Photoshop layers. Opaque pixels will cover the
pixels directly below them without applying any math or algorithm applied to them. You can, of
course, reduce the opacity of the layer to reveal the pixels below.
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Normal

Dissolve

The Dissolve Blending Mode also does not blend pixels. Dissolve only reveals the pixels below
when the Opacity of the layer is reduced. The pixels below are revealed through a dither pattern
(noise) whose intensity is based on the Opacity.

Dissolve (50% Opacity)

Darken Blending Modes

As the name implies, the Blending Modes in the Darken category will turn the “Result” colors
darker. Anything that is white in the blend layer will become invisible, and anything that is
darker than white is going to have some darkening effect on the pixels below it.

Darken

The Darken Blending Mode looks at the luminance values in each of the RGB channels and
selects either the base color or blend color depending on which is darker.

Simply put, this Blending Mode does not blend pixels, it only compares the base and blend
colors, and it keeps the darkest of the two. If the blend layer and the base layer color are the
same, then there is no change.

Darken

Multiply
Multiply is one of the most popular Blending Modes in Photoshop. I’m sure that you have used it
many times before.
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This Blending Mode multiplies the luminosity of the base color by the blend color. The resulting
color is always a darker color. White produces no change, while the black pixels remain.
Multiply can produce many different levels of darkening depending on the luminosity values of
the blend layer, which make it a great Blending Mode for darkening images or creating shadows.

Multipl

Color Burn

Color Burn is the first of the eight unique Blending Modes in Photoshop that react differently
when Opacity is adjusted compared to Fill.

The Color Burn Blending Mode gives you a darker result than Multiply by increasing the
contrast between the base and the blend colors resulting in more highly saturated mid-tones and
reduced highlights. The result is very similar to the effect you would get when you use the Burn
Tool to darken an image.

Color Burn

M
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Llnear Burn

Linear Burn decreases the brightness of the base color based on the value of the blend color. The
result is darker than Multiply but less saturated than Color Burn. Linear Burn also produces the
most contrast in darker colors than any of the other Blending Modes in the Darker group.

Linear Burn blends differently when Fill Opacity is adjusted, compared to when Opacity is
adjusted.

Linear Burn

ni any TR0

' /\ (\IL

: -ntroduced in Photoshop 7.
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Darker Color

The Darker Color Blending Mode is very similar to Darken. This Blending Mode does not blend
pixels. It only compares the base and blend colors, and it keeps the darkest of the two.

The difference is that Darker Color looks at the composite of all the RGB channels, whereas
Darken looks at each RGB channel individually to come up with a final blend.

Darker Color

— e s

Lighten Blending Modes
The Blending Modes in this category and re opposites, or complementary colors from the
Darken category.

TheLighten Blending Modes will turn the “Result” colors brighter. Anything that is black in the
blend layer will become invisible, and anything that is brighter than black is going to have some
darkening effect on the pixels below it.

Lighten

The Lighten Blending Mode takes a look at the base color and blend color, and it keeps
whichever one of the two is the lightest. If the blend colors and the base colors are the same, then
no change is applied. As with the Darken Blending Mode, Lighten looks at the three RGB
channels separately when blending the pixels.

Check out my tutorial on creating a Glass Window Reflection Effect in Photoshop to see a great
example of how you can use Lighten Blending Mode.

Screen

Screen is another of Photoshop’s most popular Blending Modes. The resulting color is always a
brighter color. Black produces no change, while the brighter pixels remain.

Screen can produce many different levels of brightening depending on the luminosity values of
the blend layer, making Screen, a great Blending Mode for brightening images or creating
highlights.
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Screen

Color Dodge

Color Dodge is the third of the eight special Blending Modes, which blends differently when Fill
is adjusted, compared to when Opacity is adjusted.

The Color Dodge Blending Mode gives you a brighter effect than Screen by decreasing the
contrast between the base and the blend colors, resulting in saturated mid-tones and blown
highlights.

The effect is very similar to the result you would get when using the Dodge Tool to brighten up
an image.

Color Dodge

Linear Dodge (Add)
Linear Dodge (Add) produces similar but stronger results than Screen or Color Dodge. This
Blending Mode looks at the color information in each channel and brightens the base color to
reflect the blend color by increasing the brightness. Blending with black produces no change.
Linear Dodge (Add) blends differently when Fill Opacity is adjusted, compared to when Opacity
is adjusted.

Linear Dodge (Add;

*Introduced in Phtoshop 7.

Lighter Color
Lighter Color is very similar to Lighten. This Blending Mode does not blend pixels. It only
compares the base and blend colors, and it keeps the brightest of the two. The difference is that
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Lighter Color looks at the composite of all the RGB channels, whereas Lighten looks at each
RGB channel to come up with a final blend.

ighter Color

Contrast Blending Modes

The Blending Modes in this category are a mixture between the Darken and the Lighten
Blending Modes. They create contrast by both lightening and darkening the result colors by
using complementary Blending Modes to create the blend.

Photoshop checks to see if the colors are darker than 50% gray or lighter than 50% gray. If the
colors are darker than 50% gray, a darkening Blending Mode is applied. If the colors are brighter
than 50% gray, a brightening Blending Mode is applied.

Except for Hard Mix, all the Blending Modes in this category turn 50% gray transparent.
Overlay

Overlay is another of Photoshop’s most widely used Blending Modes. It is a combination of
Multiply and Screen with the base layer always shining through. Overlay uses the Screen
Blending Mode at half strength on colors lighter than 50% gray. And the Multiply Blending
Mode at half strength on colors darker than 50% gray. 50% gray itself becomes transparent.
Also, note that “half-strength” does not mean, Opacity at 50%.

Another way of thinking about Overlay is by thinking of shifting mid-tones. Dark blend colors
shift the mid-tones to darker colors, light-tones shift the mid-tones to brighter colors.

One difference between the Overlay Blending Mode and the other Contrast Blending Modes is
that it makes its calculations based on the brightness of the colors in the base layer. All of the
other Contrast Blending Modes make their calculations based on the brightness of the blend
layer.

Overlay, alongside Hard Light, is part of the first set of Commuted Blending Modes in
Photoshop. A set of commuted Blending Modes will give you the same result when you apply
one Blending Mode to the blend layer, as when you apply the corresponded Commuted Blend
Mode to the base layer, and then reversing the order of the layers.

In other words, if you apply the Overlay Blending Mode to the blend layer, you will get the same
result, as when you apply the Hard-Light Blending Mode to the Base layer, then reverse the
order of the layers.
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Soft Light

Soft Light is very much like Overlay. It applies either a darkening or lightening effect depending

on the luminance values, but in a much more subtle way. You can think of Soft Light as a softer

version of Overlay without the harsh contrast.
ht

Soft Lig

|
P -

Hard Ligh

Hard Light combines the Multiply and Screen Blending Modes using the brightness values of the
Blend layer to make its calculations. Overlay uses the base layer.

The results with Hard Light tend to be intense. In many cases, you will have to reduce the
Opacity to get better results.

Hard Light sounds like it would have something in common with Soft Light, but it does not. It is
much more closely related to Overlay, and they are both part of the first set of Commuted
Blending Modes.

Hard Li

Vivid Light

You can think of Vivid Light as an extreme version of Overlay and Soft Light. Anything darker
than 50% gray is darkened, and anything lighter than 50% gray is Lighten.

Vivid Light is one of those Blending Modes where you may want to adjust the opacity since
100% opacity is generally too strong.
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Vivid Light is the fifth Blending Mode of eight that give you different results when you reduce
the fill compared to opacity.

*Introduced in Photoshop 7.
Linear Light
Linear Light uses a combination of the Linear Dodge Blending on lighter pixels and a Linear
Burn on darker pixels.
Typically, the resulting colors are extreme, and you may want to use the Opacity or Fill sliders to
adjust it.
Linear Lights blends differently when Fill Opacity is adjusted, compared to when Opacity is
adjusted.
*Introduced in Photoshop 7.

Linear Light

Pin Light
Pin Light is an extreme Blending Mode that performs a Darken and Lighten Blending Mode
simultaneously. It can result in patches or blotches, and it completely removes all mid-tones.

Pin Light

*Introduced in Photoshop 7.

Hard Mix
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Hard Mix is the seventh Blending Mode in the contrast group and the seventh of the special 8
Blending Modes. It applies the blend by adding the value of each RGB channel into the blend
layer to the corresponding RGB channel in the base layer.

The resulting image loses a lot of detail, and the colors can only be black, white, or any of the six
primary colors. Red, green, blue, cyan, magenta, or yellow.

Vivid Light is an extreme Blending Mode, but you can use Opacity and Fill to reduce the effect.
Fill will probably be your better option for reducing the effect of this Blending Mode since it
generally gives you better results than Opacity.

Hard Mix

*Introduced in Photoshop CS.
Inversion Blending Modes
The Inversion Blending Modes look for variations between the base and blend layers to create
the blend.
Difference
The Difference Blending Modes uses the difference of the base and blend pixels as the resulting
blend.
White inverts the colors of the base layer. It is the same result as inverting the colors of the base
layer by pressing Command I (PC: Ctrl 1).
Black Produces no change, while dark grays apply a slight darkening effect.
This blending mode can be extremely useful for aligning layers with similar content.
Difference is the eighth and final Blending Mode that react differently when Fill is reduced
compared to Opacity.

Difference

Exclusion
Exclusion is very similar to Difference. Blending with white inverts the base color values, while
blending with black produces no change. However, Blending with 50% gray produces 50% gray.
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Exclusion

Subtract
The Subtract Blending Mode subtracts pixel values from the base layer. This Blending Mode
drastically darkens pixels by subtracting brightness.

Black has no effect. Only as the blend values get brighter, does the result get darker.

Notice how the light areas of the gradient are almost pure black, while the dark areas of the
gradient produced a minimal change.

Subtract

*Introduced in Photoshop CS5.
Divide
Divide produces the opposite effect as Subtract.
White has no effect. Only as the blend values get darker, does the result get brighter.
Dark areas of the blend layer produce bright colors, while the light areas of the blend layer
produced a very small change.

Divide
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*Introduced in P
Component Blending Modes
The Component Blending Modes use different combinations of the primary color components
(hue, saturation, and brightness) to create the blend.
Hue
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The Hue Blending Mode preserves the luminosity and saturation of the base pixels while
adopting the hue of the blend pixels.

Hue can be used to change hues in a layer while maintaining the tones and saturation of the
original.

Hue
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Saturation

The Saturation Blending Mode preserves the luminosity and hue of the base layer while adopting
the saturation of the blend layer.

A black-and-white blend layer also turns the image into grayscale because none of the pixels in
the luminosity layer have saturation.

Saturation

Color

The Color Blending Mode preserves the luminosity of the base layer while adopting the hue and
saturation of the blend layer. Color is the ideal Blending Mode for coloring monochromatic
images.

Also, Color, along with the Luminosity Blending Mode, is the second pair of Commuted
Blending Modes.

If you apply the Color Blending Mode to the blend layer, you will get the same result, as when
you apply the Luminosity Blending Mode to the Base layer, then reverse the order of the layers.
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Luminosity
Luminosity preserves the hue and saturation of the base layer while adopting the luminosity of
the blend layer.

Luminosit:

Pass Through Blending Mode

When you select a group, you will notice that the default Blending Mode is not Normal. Instead,
itis “Pass Through.” The Pass Through Blending Mode tells Photoshop to treat all the layers
within a group to behave as if they were just part of a regular layer stack and not part of the
group. The group is only used as an organizational tool and all the layers all blend as you would

expect.

However, if you changed the Pass Through Blending Mode to any other blending mode,
Photoshop will first blend the layers in the group, then it will blend the resulting composite with
the layers below it using the Blending Mode that you selected.

This is the same result as merging all the layers in a group and then applying a Blending Mode.
For this reason, you can use it to create some great effects especially when compositing. You can
seta Group’s Blending Mode to Normal, and all the adjustment layers inside of the group will
only affect the contents of that group.

PC: Alt Shift Mac: Option Shift

N
|

Normal
Dissolve

Darken
Multiply
Color Burn
Linear Burn
Darker Color

> X

Lighten

Screen

Color Dodge
Linear Dodge (Add)
Lighter Color
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Overlay
Soft Light
Hard Light
Vivid Light
Linear Light
Pin Light
Hard Mix

Difference
Exclusion
Subtract
Divide
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<0O-+4C

Blending Modes with 32-Bit Images

Only 15 blending modes are available when you are working with
32-bit images. They are: Normal, Dissolve, Darken, Multiply,
Lighten, Linear Dodge (Add), Difference, Hue, Saturation, Color,
Luminosity, Lighter Color, Darker Color, Divide and Subtract.
Commuted Blending Modes

There are two sets of Commuted Blending Modes, Overlay and
Hard Light, and Color and Luminosity.

A set of Commuted Blending Modes will give you the same
result when you apply one Blending Mode to the blend layer, as
when you apply the corresponded Commuted Blend Mode to the
base layer, and then reversing the order of the layers.

For example, if you apply the Overlay Blend Mode to the blend
layer, you will get the same result, as when you apply the Hard-
Light Blend Mode to the base layer, then reverse the order of the
layers.

Blending Mode Keyboard Shortcuts

You can change the Blending Mode of a layer by clicking on the
drop-down and selecting one from the list. Alternatively, you can
use the Photoshop keyboard shortcuts for Blend Modes.
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Press, Shift + to go down to the next Blending Mode. Or, Shift — to move up the list.

If you have a painting tool active, this shortcut will change the Blending Mode of the tool instead
of the layer. To prevent this from happening, get in the habit of pressing the V key to select the
Move tool, then press Shift + or Shift — to scroll through the Blending Modes.

If the focus, the blue highlight, is around the Blending Mode drop-down menu, these shortcuts
will not work. Simply hit Enter, or Return on the Mac to remove the focus from the drop-down,
then apply any shortcut that you would like.

Except for Subtract and Divide, the two Blending Modes added in Photoshop CS5 in 2010, each
of the Blend Modes has a keyboard shortcut that you can use to apply it to a layer.

However, | don’t recommend learning all of them. Only learn the ones you use most often. Most
of the time 1 only use Screen, Multiply, Overlay, Soft Light, Color, and Luminously. Those are
the only blend mode keyboard shortcuts | have memorized.

To select a Blending mode press Alt Shift on Windows, or Option Shift on the Mac, then
press the corresponding letter to get you the Blending Mode that you would like to use.

6. Describe various colour modes
Different color modes:

1. RGB mode (millions of colors)

2. CMYK mode (four-printed colors)

3. Index mode (256 colors)

4. Grayscale mode (256 grays)

5. Bitmap mode (2 colors)
The color mode or image mode determines how colors combine based on the number of channels
in a color model. Different color modes result in different levels of color detail and file size. For
instance, use CMYK color mode for images in a full-color print brochure, and use RGB color
mode for images in web or e-mail to reduce file size while maintaining color integrity.
RGB Color mode
Photoshop RGB Color mode uses the RGB model, assigning an intensity value to each pixel. In
8-bits-per-channel images, the intensity values range from 0 (black) to 255 (white) for each of
the RGB (red, green, blue) components in a color image. For example, a bright red color has an
R value of 246, a G value of 20, and a B value of 50. When the values of all three components
are equal, the result is a shade of neutral gray. When the values of all components are 255, the
result is pure white; when the values are 0, pure black.
RGB images use three colors, or channels, to reproduce colors on screen. In 8-bits-per-channel
images, the three channels translate to 24 (8 bits x 3 channels) bits of color information per pixel.
With 24-bit images, the three channels can reproduce up to 16.7 million colors per pixel. With
48-bit (16-bits-per-channel) and 96-bit (32-bits-per-channel) images, even more colors can be
reproduced per pixel. In addition to being the default mode for new Photoshop images, the RGB
model is used by computer monitors to display colors. This means that when working in color
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modes other than RGB, such as CMYK, Photoshop converts the CMYK image to RGB for
display on screen.

Although RGB is a standard color model, the exact range of colors represented can vary,
depending on the application or display device. The RGB Color mode in Photoshop varies
according to the working space setting that you specify in the Color Settings dialog box.

CMYK Color mode

In the CMYK mode, each pixel is assigned a percentage value for each of the process inks. The
lightest (highlight) colors are assigned small percentages of process ink colors; the darker
(shadow) colors higher percentages. For example, a bright red might contain 2% cyan, 93%
magenta, 90% yellow, and 0% black. In CMYK images, pure white is generated when all four
components have values of 0%.

Use the CMYK mode when preparing an image to be printed using process colors. Converting an
RGB image into CMYK creates a color separation. If you start with an RGB image, it’s best to
edit first in RGB and then convert to CMYK at the end of your editing process. In RGB mode,
you can use the Proof Setup commands to simulate the effects of a CMYK conversion without
changing the actual image data. You can also use CMYK mode to work directly with CMYK
images scanned or imported from high-end systems.

Although CMYK is a standard color model, the exact range of colors represented can vary,
depending on the press and printing conditions. The CMYK Color mode in Photoshop varies
according to the working space setting that you specify in the Color Settings dialog box.

Lab Color mode

The CIE L*a*b* color model (Lab) is based on the human perception of color. The numeric
values in Lab describe all the colors that a person with normal vision sees. Because Lab
describes how a color looks rather than how much of a particular colorant is needed for a device
(such as a monitor, desktop printer, or digital camera) to produce colors, Lab is considered to be
a device-independent color model. Color management systems use Lab as a color reference to
predictably transform a color from one color space to another color space.

The Lab Color mode has a lightness component (L) that can range from 0 to 100. In the Adobe
Color Picker and Color panel, the a component (green-red axis) and the » component (blue-
yellow axis) can range from +127 to —128.

Lab images can be saved in Photoshop, Photoshop EPS, Large Document Format (PSB),
Photoshop PDF, Photoshop Raw, TIFF, Photoshop DCS 1.0, or Photoshop DCS 2.0 formats.
You can save 48-bit (16-bits-per-channel) Lab images in Photoshop, Large Document Format
(PSB), Photoshop PDF, Photoshop Raw, or TIFF formats.

Note:

The DCS 1.0 and DCS 2.0 formats convert the file to CMYK when opened.

Grayscale mode

Grayscale mode uses different shades of gray in an image. In 8-bit images, there can be up to 256
shades of gray. Every pixel of a grayscale image has a brightness value ranging from 0 (black) to
255 (white). In 16-and 32-bit images, the number of shades in an image is much greater than in
8-bit images.

Grayscale values can also be measured as percentages of black ink coverage (0% is equal to
white, 100% to black).
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Grayscale mode uses the range defined by the working space setting that you specify in
the Color Settings dialog box.

Bitmap mode
Bitmap mode uses one of two color values (black or white) to represent the pixels in an image.
Images in Bitmap mode are called bitmapped 1-bit images because they have a bit depth of 1.

Duotone mode
Duotone mode creates monotone, duotone (two-color), tritone (three-color), and quadtone (four-
color) grayscale images using one to four custom inks.

Indexed Color mode

Indexed Color mode produces 8-bit image files with up to 256 colors. When converting to
indexed color, Photoshop builds a color lookup table (CLUT), which stores and indexes the
colors in the image. If a color in the original image does not appear in the table, the program
chooses the closest one or uses dithering to simulate the color using available colors.

Although its palette of colors is limited, indexed color can reduce file size yet maintain the visual
quality needed for multimedia presentations, web pages, and the like. Limited editing is available
in this mode. For extensive editing, you should convert temporarily to RGB mode. Indexed color
files can be saved in Photoshop, BMP, DICOM (Digital Imaging and Communications in
Medicine), GIF, Photoshop EPS, Large Document Format (PSB), PCX, Photoshop PDF,
Photoshop Raw, Photoshop 2.0, PICT, PNG, Targa®, or TIFF formats.

Multichannel mode
Multichannel mode images contain 256 levels of gray in each channel and are useful for
specialized printing. Multichannel mode images can be saved in Photoshop, Large Document
Format (PSB), Photoshop 2.0, Photoshop Raw, or Photoshop DCS 2.0 formats.
These guidelines apply when converting images to Multichannel mode:
o Layers are unsupported and therefore flattened.
o Color channels in the original image become spot color channels in the converted image.
e Converting a CMYK image to Multichannel mode creates cyan, magenta, yellow, and
black spot channels.
o Converting an RGB image to Multichannel mode creates cyan, magenta, and yellow spot
channels.
o Deleting a channel from an RGB, CMYK, or Lab image automatically converts the
image to Multichannel mode, flattening layers.
o Toexport a multichannel image, save it in Photoshop DCS 2.0 format.
Note:
Indexed Color and 32-bit images cannot be converted to Multichannel mode.
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Unit 3: Composition and Lighting for Photography

3.1. Describe composition-1

Photography is a complicated art form. The elements of exposure, composition, light, subject
matter, moment, and many others all come together to make a single two-dimensional image that
is presented to a viewer. Learning all of this is time-consuming and difficult. Taken step-by-step,
however, each of the elements can be methodically learned and combined to form your own
photographs. Once you know how to operate your camera an extremely powerful tool you can
add to your kit is a starting knowledge of composition.

Composition is the arranging of elements within the frame of a photograph. Despite what many
articles or videos may tell you, it’s less about following rules and more about utilizing a set of
guidelines to find an appropriate way of describing the scene you have in front of you with the
camera in your hand. Every scene is different. Some will be simple, some will be much more
complex. With that being said, here are five elements of composition you can draw on to help
your viewer see what you want them to in your photographs.

Cut out the Unnecessary Elements

This may not classically be included in lists of techniques for composition, this is one of the most
important concepts to grasp when approaching a photograph. Composition in most forms of
photography is the art of exclusion. You have a limited space within the borders of your
photograph which can only contain so much before you dilute your message.

Your goal when composing a photograph should be to point to something. You want your viewer
to look at what you’re trying to show them. One way you can do this by cutting out all the clutter
of the world and just showing them what you want them to see. A few ways you can achieve this
in photography include getting closer to your subject, using a longer focal-length lens for a
narrower field of view, using depth-of-field to isolate your subject from other elements in the
scene, or using shadow to hide things that do not contribute to the message you are trying to
give.

The scene below was extremely cluttered. There were hundreds of people around at this
ceremony. By looking down at a puddle and using only the reflection of the elements , the
photographer wanted to show, he was able to cut out that clutter and point you towards what he
wanted you to see.

141



Leading Lines

When you break the elements of a two-dimensional photograph down, the people, buildings,
trees, lakes, and everything else in your frame simply become lines. Our eyes reconstruct these
lines and equate them to things we know as we view an image. As a photographer, learning how
you can use lines is very powerful.

One simple way to use lines is for their drawing power. Lines that are simply graphic can be
used to lead the viewer around your image. These are called Leading Lines. When you’re
looking at a scene and deciding how to compose it, consider what your subject is first and then
consider what elements in the scene might draw the viewer towards that subject. Can you find a
receding line, like a fence that draws you to the old house on the hill? Maybe there’s a crack in
the concrete leading to a flower growing at the base of a wall. The viewer’s eye will naturally
follow lines so they can be very useful in directing people to what you want them to look at.
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Rule of third and balancing element

One of the most popular ways to compose your photographs is to use the “Rule of Thirds”.
Although this compositional rule is frequently used by photographers, not everyone understands
exactly what it is or when it works. This article introduces the rule of thirds and explains when to
use it for composition (or not). Keep in mind that this rule is a suggestion for beginners and those
who struggle with properly composing their pictures, and it is far from the only way to take good
images.

The Rule of Thirds

The Rule of Thirds is a type of off-center composition where important elements of a photograph
are placed along a 3x3 grid, which equally divides the image into nine parts. For many
photographers, this type of composition is a basic way to give structure to photographs and make
them more appealing. With the rule of thirds, photographers envision four lines across their
photographs, which also create four intersecting points. Take a look at the illustration below:
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The important elements within a frame should be placed at the intersection points of these lines,
as shown in the above diagram. Or, when photographing subjects like a tree or horizon, which
are comprised of straight lines, the rule of thirds suggests placing them along one of the four
lines instead. Take a look at the below photograph:

NIKON D5100 + 18-55mm /3.5-5.6 @ 32mm, ISO 100, 6 seconds, f/22.0

As you can see, both the horizon line and the primary subject are placed along this grid:
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Rule of thirds grid overlaying the previous image

You can apply the rule of thirds to any genre of photography. In the portrait example below, the
subject’s eyes are placed about two thirds up the photograph, and her nose aligns with the rule of
thirds grid as well:
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The bride’s eyes and nose in this image align with the rule of thirds grid.

One of the most popular ways to compose your photographs is to use the “Rule of Thirds”.
Although this compositional rule is frequently used by photographers, not everyone understands
exactly what it is or when it works.
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In this photo, the lizard’s eye aligns exactly with the Rule of Thirds.
NIKON D800E + 105mm /2.8 @ 105mm, ISO 100, 1/640, /3.2

The Rule of Thirds

The Rule of Thirds is a type of off-center composition where important elements of a photograph
are placed along a 3x3 grid, which equally divides the image into nine parts. For many
photographers, this type of composition is a basic way to give structure to photographs and make
them more appealing. With the rule of thirds, photographers envision four lines across their
photographs, which also creates four intersecting points. Take a look at the illustration below:
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The important elements within a frame should be placed at the intersection points of these lines,
as shown in the above diagram. Or, when photographing subjects like a tree or horizon, which
are comprised of straight lines, the rule of thirds suggests placing them along one of the four
lines instead. Take a look at the below photograph:

NIKON D5100 + 18-55mm /3.5-5.6 @ 32mm, ISO 100, 6 seconds, f/22.0

As you can see, both the horizon line and the primary subject are placed along this grid:
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Rule of thirds grid overlaying the previous image

You can apply the rule of thirds to any genre of photography. In the portrait example below, the
subject’s eyes are placed about two thirds up the photograph, and her nose aligns with the rule of
thirds grid as well:

The bride’s eyes and nose in this image align with the rule of thirds grid.

‘When to Use the Rule of Thirds
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So, when should you use the rule of thirds? The basic value of this rule is to remind yourself that
off-center compositions can work well and be successful. Most of the time, beginner
photographers will place their subjects in the dead center by default, forming central
compositions. Although central composition can be a very strong way to compose photographs,
using it for every photo can be boring. If you find that you are doing this, you can add more
interest and variety by using the rule of thirds.

To use the rule of thirds, start by imagining a 3x3 grid (or use one that is built into your camera)
and place your subjects along those lines and intersections points. When you evaluate the result,
you may find that you like it more than with your subject in the center.

So, if you are struggling to compose your images, you might find that the rule of thirds can be a
quick way to make your photos more dynamic.

When Not to Use the Rule of Thirds

The biggest problem with the rule of thirds is that it doesn’t change, even when your subjects do.
It simply does not take into account what you are photographing. For example, in some scenes,
you might be compromising your composition and excluding important elements just to adhere
to the rule of thirds. So, in a way, it is a cookie-cutter composition.

The whole idea of the rule of thirds is that it introduces beginners to off-center composition.
However, it might lead you to think that your subjects always (or often) need to be placed along
the exact lines and intersections of the 3x3 grid in order to capture a successful composition.

In reality, any type of off-central composition — not just the rule of thirds — can work well.
Instead, try framing your subject just slightly off center, or even in the extreme corners.
Sometimes, the scene itself will dictate the type of composition which will work best for your
photograph. In the image below, you can see that the photographer purposefully placed the
subject close to the edge of the frame in order to convey a sense of isolation with a negative
space composition:
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NIKON D7000 + 24mm /1.4 @ 24mm, 1SO 100, 1/640, /4.0

While taking this photo, he wanted it to be somewhat striking and unexpected. If he had framed
it using the rule of thirds, it would not have conveyed that emotional message.

Along with that, do not underestimate central composition. Although it can be boring if you use
it too much, it also can be the most powerful way to compose and frame photographs.
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No rule of thirds, no problem.
NIKON D800E + 70-200mm f/4 @ 200mm, ISO 100, 1/160, /9.0

Repetition and Patterns

The root word of repetition is “repeat”. When you repeat a certain size or shape or color you add
strength to the overall image. Repetition is a basic concept in the world of art. If you want to
make a statement, you repeat certain elements again and again. If you repeat something once or
twice it becomes more interesting. If you repeat something many times it becomes a pattern and
takes on a life of its own.

photo by whologwhy

Patterns give us order in an otherwise chaotic world. There’s something fundamentally pleasing
about seeing order in such a way that we know what to expect. In most cases, repetition is a tool
used to calm the viewer, making them feel comfortable and at peace while enjoying the view.
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A single, simple subject with a plain non-distracting background definitely has its strengths, but
it is NOT the only way to keep a viewer’s attention. Patterns are to photography what rhythm is
to music. Without the limitation of just a single point of interest, repetition helps your eye dance
from point to point with pure delight. You are not asked to make a judgment of the subject,
simply to explore it. Like music, you are not expected to just listen to a single note, but to take in
the high notes, low notes, the movements, and the beat. The goal here is not to just witness a
good photograph but to experience it. Thus, when repetition is used correctly, it can greatly
increase the emotional impact of your images.
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photo by Anssi Koskinen

Patterns and repetition can be found all around us: a row of trees, a field of sunflowers, or a line
of children waiting for a bus. When you get into the world of close-up photography, you will
start to discover a whole new world of patterns. Often things that you perceive as solid or even as
a single texture are made up of much smaller patterns.
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Look at the surface of an orange, for example. Each dimple, each bump, each hill or valley
contributes to what most viewers consider one smooth surface. Of course not all repetition is 100
percent uniform. Think of a choir in concert; every individual may be wearing the same robe, or
suite, or dress to represent their organization, but they are still all individuals.

Like most things on earth, too much of a good thing can become bad (or stale or boring). It’s like
when you first start taking pictures using a star filter. Occasionally, it makes some really cool
effects and you have some unique images. But if you used it ALL the time; what at first seems
unique now becomes common place, or worse yet—out of place.

|| e

photo by Travis Wise

A shot of a race car, doesn’t really need a star shining off his front windshield to be interesting.
A horse leaning down for a cool drink in a stream doesn’t need little stars shining in the water.
There is a time and place for everything, and repetition will not cure all boring shots. In fact, if
you’re not selective about when you use it, it could make things worse.
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photo by antifluor

The most common way to keep repetition from becoming boring is to deliberately break the
pattern. Think of a fruit stand with an entire box of big red juicy apples. Now take one of those
apples out and replace it with an orange. This technique is often referred to as creating a “spot.”
A spot is nothing more than the deliberate use of opposition to force the viewer to look again and
again. It may seem overly simple, but changing a single element in your shot can often make the
difference between boring and fascinating.
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photo by Joe Mazzola

Keep patterns and rhythm in mind when you line up a number of people for a group portrait.
Here you will be dealing with similar shapes. Try to place them in a pleasing pattern. Start with
three people and have them line up so that their heads form a triangle. As you add people form
another triangle. You are adding to the pattern by creating a rhythm of triangles that dance
together. A group of nine people on their own could form an ugly mob or they could form a very
pleasing family portrait if you use the concept of repetition. Remember what we said at the
beginning. Repetition is a tool. What you build with it determines if people consider you a
master photographer or weekend warrior who just takes snapshots.

The Golden Ratio In Photography
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Some argue that the rule of thirds is an oversimplification of a more advanced mathematical
equation known as the golden ratio (also known as the golden mean). The golden ratio is a ratio
which has continued to surprise artists, scientists, musicians and mathematicians for centuries.
The reason being is that the golden ratio seems to pop up everywhere. Not only does the golden
ratio pop up in everywhere, it also seems that the human eye is very attracted to the results of the
ratio.

For example, there are certain measurements on models faces which equal surprisingly close to
the golden ratio. In nature we see the golden ratio in plants and the branching of trees, the spirals
of shells, the curves of waves, in our DNA and the solar system. It has also been used in
architecture, art and music. The golden ratio seems to be everywhere.

It was used in architectural masterpieces such as the Greek Parthenon, the pyramids and later in
such great works of art such as Notre Dame. There is also cause to believe that it was used by the
great artists Michelangelo and Leonardo De Vinci.

It is debated as to whether the Mona Lisa was intentionally created using the proportions of the
golden ratio. See below

A golden rectangle is a rectangle whose side lengths are in the golden ratio.
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Simply put, the golden ratio is a ratio of approximately 1.618 to 1. This proportion creates a
sense of harmony and balance.

Although this ratio has been rediscovered throughout time, one undisputed milestone in its
history was the Fibonacci number series. In the 12th century Fibonacci produced a series of
numbers by adding together pairs of numbers.

0,1,1,2,3,5,8,13, 21, 34, 55, 89, 144,
(0+1=1, 1+1=2, 1+2=3, 2+3=5, 3+5=8)

The ratio between each successive pair gets closer and closer to Phi as you progress through the
series.
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Once you start splitting a golden rectangle by the ratio, you can keep sub-splitting it down
forever. The spiral this produces exactly matches the growth of the Nautilus shell in nature.
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Let's just say it's a mathematical equation of aesthetically pleasing composition.

Below see how Cartier-Bresson used the proportions of the Golden Rectangle to form his
composition.

The Phi Grid

To apply the golden ratio in photography, you can imagine that spiral over the top of your image.
Or you can create a grid from the 1.618:1 ratio. This is the phi grid, which is another way of
considering proportion in photography.
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The golden ratio or phi grid, golden spiral and the Rule of Thirds are all three separate
composition techniques. The ‘right” answer as to which one to use depends on the subject and
the look you are going for.

How To Use The Golden Ratio in Photography

Both the golden spiral and the phi grid can drastically improve composition. But how do you get
from a spiral or grid pattern to a better photograph?
Now that you know what it is, you can learn how to use the golden ratio in photography.

Step 1: Evaluate the scene

Exactly how you use the golden ratio depends on the scene in front of you. Composition
techniques are there to help you think about the scene instead of just pointing and shooting.
Now that you know three different composition techniques, you need to determine which one is
the right fit. To do that, start asking yourself questions about the potential image in front of you:

What is the subject of the photo? That’s where you’ll want to lead the eye.

What other elements can you include in the scene? Look at everything else in the scene and
determine if it distracts from the subject or enhances it.

Are there any leading lines or natural curves in the image? Leading lines work well for the
phi grid, while natural curves are just asking for a golden ratio spiral.

Step 2: Determine whether to use the golden ratio or the golden spiral (or even the Rule of
Thirds)

Next, choose between the golden spiral and the phi grid. You can’t contort a straight object to fit
inside a spiral, so if your scene has great leading lines, try the phi grid.
If your scene has more natural curves from the shape of a tree to the curve of a cheekbone, the
golden spiral IS likely a better fit.
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The golden ratio is considered a more advanced version of the Rule of Thirds, but it’s still okay
to call on the Rule of Thirds again. If the scene works best with that composition technique, use
it!

Step 3: Imagine the overlay and shoot

Imagining a complex spiral aligned over your photo can be tricky at first. If you simplify the
concept, it’s a bit easier to manage.

First, check and see which grid overlays your camera has built-in by viewing the options in
settings. If your camera has a phi grid or spiral option, turn that feature on. Most will have the
Rule of Thirds. Even when that isn’t the composition guide you are using, it’s helpful to enable
that feature.

If you have an optical viewfinder (as opposed to an electronic one), you’ll have to imagine the
grid as you shoot and check with Live View.

Next, choose which corner of the image to use. You’ll want to place the subject on the
intersection of the lines with the phi grid, or in the smallest part of the spiral. Using the Rule of
Thirds grid overlay on your camera, approximate where the subject should be with the golden
ratio technique.

If you opted for the Phi Grid, place the subject closer to the centre of the image compared to that
Rule of Thirds intersection. If you’re working with that golden spiral, place the subject slightly
farther out than that Rule of Thirds intersection.

Unlike the Rule of Thirds, placing the subject at the intersection isn’t the end.

Adjust your composition aligning any leading lines or curves that you identified in the scene on
the remaining grid lines or along the spiral. Remember, composition is more than just cropping
with the viewfinder.

Lines and angles can be exaggerated by adjusting your position. You can cling to a higher
vantage point, kneel or lay down on the ground, move closer, move farther away or move to one
side.

Explore the composition possibilities! Your goal is to place other elements of the scene either on
that spiral out from the subject or on one of the unused lines in the phi grid.

Then, you shoot.

If you’re unsure (and you’re not working with a fast subject) take a few variations with slight
composition adjustments between each one.

Step 4: Edit

Picturing the phi grid or golden ratio spiral as you shoot is one thing, but what if you want that
exact 1.618 magic number? Thankfully Photoshop (and several other photo editors) have tools
for that.

Using the Golden Ratio in photography: example of photo editor context menu showing golden
ratio guide options
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With the image open in Photoshop, select the crop tool and draw a crop box over the image.
Next, click the overlay options and select the composition tool you want: the golden ratio (phi
grid) or the golden spiral (Fibonacci spiral).

Adjust the crop box to fine-tune your composition. If the golden spiral isn’t in the right corner of
the image, you can select the cycle orientation option from the same drop-down menu you
selected the composition tool form, or you can press Shift + O.

Putting Things in the Way

Two-dimensional nature of photographs is important when considering our compositions. One
technique for adding depth to our images is layering things over the top of other things. Simply
put, you can cover part of your frame with something closer to the camera in order to give the
illusion of depth.

You can use the leaves of a tree to frame a couple in the park, empty beer glasses on a bar while
the bartender pours fresh ones in the background, or an audience listening to a speaker on stage
at a corporate event can make a good frame that doesn’t simply show the speaker out of context.
All of these things not only fill your frame with interesting elements, they further the story
you’re trying to tell. In the case of the frame below, photographer don’t want you to simply see
that there is one temple out on this plane, he want you to see that there are others and that it is a
huge expanse. By using a wide-angle lens and including the foreground, he has achieved all three
of those things but is still pointing you to the beautiful structure in the background.
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3.2 Demonstrate composition-2

The Significance of Depth, Background and Color

Photographers often make the final call on deciding the life span of an image according to our
own perception, imagination and expertise. Being able to analyze each shot before it is taken
eventually will become a second nature as you photograph. The below steps will help you get
there a little faster.

Depth

Mastering the depth of the story and being able to translate it into a visual prospect is very
important, so it certainly helps to have a solid understanding of how depth of field can affect
your images and the story you are working on. Whether it is a portrait or a landscape shot, the
right amount of bokeh should be able to transport the viewer into your story. You can choose a
longer lens with a large aperture (small depth of field) to pinpoint one element in an image that
your viewers could concentrate on, or use a small aperture (large depth of field) to portray the
melting pot of action, with many elements to the story.

NIKON D700 + 24-70mm /2.8 @ 27mm, 1SO 1600, 1/100, /4.5

Background

Background of a photograph is a very big information carrier. Choosing an appropriate
background will make your post-processing job a whole lot easier. Who wants to sit and spend
precious hours editing out unnecessary distractions on the background? Instead, look for a
cohesive environment to work with your story. Background can work hand in hand with your
lens aperture to save or ruin your image as an information carrier and storyteller. So, being able
to utilize your depth of field efficiently with the background is an art in itself. Ask these simple
questions: Is the background relevant to the story that | want to portray? Are the any extra
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elements in the background that | want to change or eliminate? Should | recompose my shot so
that nothing looks out of place?

\_Tk ’t‘ - ' “““75 'V'.',‘s‘ Gk
NIKON D700 + 50mm f/1.4 @ 50mm, I1SO 1600, 1/13, f/1.4
Here are some simple things you can do with the background that will immediately help you get
better results when photographing portraits:

Find a different background that is less busy, more or less colorful (see below on color), etc
Learn to crop in camera to avoid irrelevant content. Move yourself or your subject to a slightly
different location or use a different angle.

. To get the best bokeh, make sure to give plenty of space between your subject and the
background. Having a good fast lens like the Nikon 50mm f/1.8G (see our Nikon 50mm /1.8G
Review) or a solid portrait lens like the new Nikon 85mm /1.8G will certainly help with getting
good bokeh.

Don’t be afraid to bring your subject close, but watch out for distortion. Wide-angle and short
focal length lenses are known to greatly distort images. Unless your intent is to make your
subject’s face look out of proportion, use longer lenses for better compression. That’s why
telephoto lenses are ideal for portraiture.

Pay attention to lines and curves in the background that could enhance the composition and
overall feel of the image.

If there are any vertical lines in the background, place your subjects in such a way, that the lines
are not directly behind the head of your subject. A great image could be ruined by things
growing out of a person’s head.

Color

Color and tone are among the main conveyors of mood and character in any photograph — it can
be both distracting and amazing. Although tonality could be more of a post-processing topic,
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color is most definitely not. You should be able to see the color before you take a photograph,
regardless if you wish to alter it later or not. Just like the background, color can make your shot
look cohesive or all over the place. Positioning your subjects against a background with lots of
different blues, reds and greens may not be a good idea. When you want the eyes to rest on one
spot, over your subject, choose a background with a less distracting color palette.

NIKON D3S + 70-200mm /2.8 @ 80mm, 1SO 800, 1/100, /2.8
Then again, there are always exceptions to these guidelines, so do not be afraid to experiment.

Framing and Cropping in photography

How to use framing in photography for pleasing compositions

Framing in photography might not be what you think it is. When you hear the term framing, you
most likely think of the typical wooden frames in which you mount your photos before you hang
them on the wall. In this, framing is not the solid frames but how you can use framing techniques
to compose better photos. It is the framing you do in your viewfinder or LCD screen.
Composition is about creating pleasing photos that draw the viewer's attention into the photos
and further move the viewer's eyes around to the main subject. There are a lot of composition
rules, and most of them come from the great painters back in history. Despite how important it is,
a lot of beginner photographers don’t know or pay composition enough attention when they
photograph.
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Why is composition so important in photography?

Composition techniques work well because our brain of some reason is programmed to react a
certain way to different stimulus. As an example, bright areas or white spots in photos is where
the eyes move to first. If this spot is not the main interest point in your photo it will have a
disturbing effect and distract the viewer.

If you want to attract the viewer's attention, you can either brighten the main subject or darken
the surrounding areas that are not important in the photograph. This is where frames come to

play.

Furthermore, framing in photography composition is important as it creates depth in a photo and
makes it more interesting. Last but not least framing as a composition technique in photography
will help to put the main subject into a context.

Techniques for framing in photography composition

Physical elements

You can use different physical elements as frames. There is always something you can use as a
framing element even if it’s not obvious at first. Being aware of the importance of framing in
photography composition and taking the time to look around you before you push the shutter is
very important. As you practice, you will get better at recognizing suitable frames. Physical
elements as frames can be divided into architectural or natural frames.

Architectural framing elements

Archways

Arches are a great example of how you can use man-made structures as framing in photography.
When you compose your shot, it is important you spend some time to look thoroughly through
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the viewfinder. Because now you have two frames to consider. You want to make sure nothing
disturbing is included in the frame (the arch). And you want to make sure your main subject is
well positioned within the frame (the arch). Moving your camera slightly up/down or left/right
can make a big difference.

Other man-made elements

Other objects you can use for framing are doorways, fences, bridges, windows, mirrors and
more. It is all about being creative and look around you when you’re at a scene. What might not
look as an obvious framing element can be after a closer look. Just give it a try.

Natural framing elements
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Trees and tree branches

In landscape photography, the most obvious and common framing elements are trees and tree
branches. While arches often frame all four sides of the main subject, trees not necessarily need
to frame the subject on all sides. Tree branches can frame only the top of the composition.

If you have a clear blue sky with no clouds or an overcast sky you can use tree branches to cover
some of this boring sky. A bright sky tends to draw the attention in a photograph. In landscape
photography, a too bright sky is a common problem. You can improve the sky when editing your
photos, but why not do it in camera by masking parts of the boring sky away with a “frame.”

-
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Stones and rocks

Stones and rocks are great framing elements in photography. The challenge can often be to sort
out and avoid introducing clutter in your composition. Too many rocks included in the framing,
and you lose the effect.

Water
Small water ponds isolated can act as a frame. The water is bright and draws attention. Placing a
subject within the water can result in a perfect framing effect.
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Other natural elements you can use for framing in photography
Tall grass and flowers can be great elements to use as framing. Because these are smaller, they
work best for framing the foreground and lower parts of the photo.

None physical framing elements

Shadows and light

Using shadows and light as framing in photography composition might not be obvious for
everyone. Our eyes are attracted to the brightest parts in your photo. If you frame and position
your main subjects in the brightest parts, it will draw the viewers eyes there.
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Texture and patterns as framing elements

Textures draw the viewers interest but because of the simple form of textures the eyes tend to
lose interest quickly. You can use this as a framing technique. By surrounding the main subject
with texture, the eyes are automatically drawn to the subject.

Focus and sharpness

The eyes will first recognize objects that appear sharp in a photo before they move to objects that
are not sharp or out of focus. You can create frames by using Depth of Field or simply by
making sure less important parts of a photo are not in perfect focus.

Negative space

Negative space is the areas that surround your subject. Negative space helps your subject to stand
out in the composition. Negative space can be space with basically nothing of interest in it. Even
a white or blank space have visual weight in a photograph and will balance the composition.
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It can seem strange for beginner to leave a lot or empty space in a photo. You have probably
heard the problem with beginners is they are not going close enough to the subject. That’s right,
but as long the elements around the main subject are not disturbing or drawing attention, it can
have a nice overall effect to the composition.

Tight crop

The opposite of using negative space as framing in photography is to use a tight crop. A tight
crop makes it clear what the main subject is. The framing in such a photo is basically the edges
of the frame. The advantage is you remove anything disturbing around your subject.

Such a composition leave the viewer to interpret the whole context of the photo. Using a
telephoto lens is one method to crop tighter and to isolate the main subject.
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Vignettes
Post processing vignette is a common technique to draw the viewers eyes to the main subject in a
photo. By darkening the sides slightly, the eyes are drawn to the brighter parts.

Vignettes are often mistakenly overdone making them a clearly visible dark frame around the
edges of a photo. Vignettes done correctly should have a subtle effect you hardly recognize. Too
strong and the vignette will have an opposite effect - you draw the viewers eyes to the overly
dark edges instead.

Cropping
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It may at first seem simple. You took the shot a little wide, or a sneaky branch that you didn’t
notice found its way into the edge of your photo. In Lightroom (LR) it’s just a quick press of the
R key to activate the crop tool, hold down the shift key to constrain the crop so you don’t get a
weird aspect ratio, and your task is complete.

The crop tool — simple, yet powerful.

On the contrary, cropping is one of the more powerful tools that you have at your disposal to dial
in the composition of your images. Prime lens users will also find that the limited versatility
(compared to zoom lenses) can result in the need for cropping more often.

In many respects cropping echoes the fundamental principles of composition. Luckily, if you
didn’t get what you wanted the first time around, when you took the photo, you get a second
chance, albeit limited, to recompose your images in post-production for maximum impact.

The Basics

The very first thing to look for, and correct, in any photograph that you edit is straight lines.
Horizon lines and any vertical lines that are near the edges of the image, should be straight. That
being said, lines can be crooked, but it better be obvious that was the intent, otherwise it just
looks like careless composition or lazy editing. In the right context a skewed horizon can add
drama, and make an image more dynamic.
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Crooked horizons can make viewers cringe unless the intent is obvious.

With the crop tool activated in LR (keyboard shortcut R) there are a few ways to straighten out
an image:

Drag the Angle slider left or right
Click on the value to the right of the slider and drag left or right (scrubby slider)
Click on the numerical value and enter whatever you want

Hold the CTRL key while dragging along a straight horizontal or vertical line (will correct on
either axis) and LR will fix it automatically

Also new in LR6 (LR CC) is the “Auto” feature for the crop tool. Just click it and see how it
does — then tweak as necessary.

Elimination

Fight the urge to become attached to pixels. Crop out half of the photo if need be. Unimportant
areas of a photo are not precious real estate.
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You can’t always get as close to the action as you would like (or it is safe to do so) and heavy-
handed cropping can make all the difference.

The fact of the matter is that simple is better. We all suffer from attention deficit disorder, and
viewers usually don’t want to spend too much precious time analyzing a photo to get the story.
Consider the allure of silhouette images. When cropping look for simple compositions and try to
distill the scene down to its essence.

Once the image is rotated and you’ve been forced to chop off some of the edges, look for
elements that detract, distract or add little to the image. You may not have a choice but to include
them, but it’s good practice to be cognizant of them and it may help guide the rest of your editing
process or future compositions.
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Cropping in very tight can sometimes create a more powerful image.

Negative space can play an important role, especially if shooting for a publication where they
need space for text. But, the nice thing about having post-processing options is that you can
always revert back to the original. If you compose your images super tight in camera, you can’t
get that negative space back.

Leading Lines

Although thoughtfully composing your shots through the viewfinder is one of the more
rudimentary skills in photography, there are often distractions. You may find surprises when you
pull up the final image on your computer screen.

In photography, as well as painting and other forms of art, you should always be thinking about
the arrangement of elements in the image that are going to draw in the viewer’s eye. A
compelling subject is just that, but it is your job as photographer to strive to portray that subject
in the most powerful, or striking way possible.

It’s easy to overlook compositional elements while shooting moving subjects. Post -processing
cropping reveals additional possibilities for framing your shots like using leading lines to draw in
the viewer’s eye.

When we talk about leading lines it’s not always an obvious straight line. Often it is an invisible
thread that takes the viewers’ gaze hostage and leads it through the scene. Think of a series of
elements that create a pattern.

177



Diagonal lines which stretch towards the subject are a common, and effective, way to create
interest and tension in an image.

Before venturing into the cropping universe, it is good to keep the following points in mind:

Cropping is not permanent and you can always go back to the original frame, as long as you use
a non-destructive editor such as Lightroom. Photoshop Camera RAW also will not alter the
original RAW file, since it behaves just like Lightroom. If you use Photoshop for cropping and
you use non-RAW file formats such as JPEG and TIFF, make sure to preserve the original image
before saving the cropped image.

If your aim is to get these photos printed later on, the proportions or “aspect ratio” of your crop
should be compliant with print sizes. Labs often prefer to work with standard print sizes, which
might make cropping a little restrictive (more on this at the end).

Avoid over-cropping photos to small areas of the image, as it will decrease resolution
significantly. If you crop too much, it will also magnify all problems with the image. For
example, if you had a little bit of blur on your subject, that blur will get magnified more after
cropping is applied. Remember, if the resolution of the image is too low, you will no longer have
the advantage of down-sampling.

If you want to apply cropping aggressively, it is best to start with an image that is sharp at 100%
view. If the image is noise-free and very sharp, you could crop it to pixel level without worrying
about potentially decreasing the quality of the final image.

Use of CRAP Designing Technique for Pattern and Textures

All design starts from four basic principles, abbreviated as CRAP (they come in no particular
order, so the more squeamish can rearrange them to form “CARP”, if you like). These are
Contrast, Repetition, Alignment, and Proximity.

Contrast

Contrast focuses our attention and should be used to highlight the most important points that the
audience should take away. Designers should use colors, bold type, and size to distinguish parts
of text or an image and create contrast. Contrast is used in all aspects of life. For example,
jewelers usually display their diamond pieces on a background of black velvet to let the jewels
stand out. The page you are reading uses headings to create contrast with the text.
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Formatting, including the use of a blue shape, creates contrast, drawing attention to important
data points in the Excel graph.

GENERATING STUDENT INTEREST
IN THE INFORMATION SYSTEMS
MAJOR: A STRATEGIC
FRAMEWORK FOR THE
INTRODUCTORY COURSE

Formatting headings for the title and subtitles creates contrast..

Contrast Through Visual Weight

Another way to create contrast is by using visual weight. You create a focal point and then lead
the reader’s eye around the page. The main focal point is the picture. The next “heaviest” item on
the page is the headline, followed by the date, followed by the logo, followed by the body text.
The reader’s eye is led from one item to the next based on these “weights.” The greatest mistake
that most students make in flyer design is to make all the text the same size as though it needed
to be readable from 20 feet away. As long as the picture and headline capture interest, a reader
will move in closer to read the rest of the flyer. Also, if every item is the same size then nothing
stands out and it looks unprofessional. Variation of font sizes and weights is critical to focus
attention.
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6 p.m.in Copeland 104

Visual weight in action. Note how your eye travels around this flyer in the numbered sequence
depicted.

Contrast with Fonts: Type Design

When working with type, aim for a contrasting layout. Contrasting layouts create visual interest
and energy. For example, when you wear clothes of contrasting colors, such as red on navy blue,
the outfit can be quite eye catching. Our examples will follow the conventions Robin Williams
sets out in her book.Williams’ book, The Non-Designers Design Book discusses design
principles for the novice designer.

The opposite of contrast is affinity. Layouts demonstrating affinity show subtle variations in
color or brightness. The overall effect is pleasing, though not particularly remarkable. For
example, a person wearing a dark suit with a dark tie would be wearing an outfit that shows
affinity.

In type design, a layout showing affinity is best for formal documents, such as wedding and
graduation invitations. For most other documents, use a contrasting style to make your
documents really pop. However, tailor the contrast to suit the audience and the occasion for the
document. For example, a business plan prepared for a bank should have less contrast than the
layout of this text book. When in doubt, be conservative.

The one type of layout that you must avoid is a conflicting layout. In a conflicting layout the type
is very similar but different. For example, never use two different serif fonts on the same page.
Think of wearing an outfit that has two different shades of red that are very similar but different.
The combination looks like a mistake—as though part of the outfit had faded in the wash. In the
same manner two serif fonts side by side will look like a mistake. Fonts should be identical or
very different.
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The text on the next page is taken from The United States Declaration of Independence and
demonstrates some type contrasting techniques. By increasing the font size and changing the text
color, you can highlight certain words or information that you want to stand out. The goal is to
make “Creator” stand out as the most important word in the sentence. You can also boldface to
dramatize the weight of the text or italicize to accent the text. Direction refers to adding space
between letters to make text stand out. Structure, using serif or sans serif fonts, can also
differentiate text and will be discussed in the next section.

Technique Example in Context

Font
serif/sans serif

Creator

Size Creator

Weight Creator
Colo

Form Creator

(italics,

Direction
Contrast with Fonts: Serif/Sans Serif

The two main categories of font are serif and sans serif. Serifs are the ornamental strokes at the
end of the letters, which all serif fonts have. Sans serif means without serifs, therefore sans serif
fonts do not have these decorative additions.

Serif and sans serif fonts can be used together to create contrast within text. Typically sans serif
fonts are used for headings while serif fonts are used for body text.

Note that you should avoid combining two fonts that are from the same category. For example,
two serif fonts that look similar, such as Georgia and Garamond, should not be used together.

Serif fonts are best used in text heavy books because the serifs quickly guide the reader’s eye
from letter to letter. Sans serif fonts are the best choice for online text because serifs can blur in
the pixels on a screen. The resolution of most computer screens is not sufficient to precisely
draw the serifs in a body of text. The result tends to look blurry. Therefore, most websites use a
sans serif font. An exception is sometimes made for the page title, which because of its greater
font size, can show serifs much more clearly. To allow for serifs online, Microsoft developed a
series of ClearType fonts designed to accurately reproduce serifs.

Though font options are limited online, other techniques such as size, weight, color, form, and
direction can be used to create contrast within online material. Color is especially powerful on a
website as most viewers have a color monitor.
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Please see the Appendix for additional font categories. These include slab serif, modern, script,
and decorative.

A serif is a decorative

embelishment on the o
edge of the letters. e r 1
Times New Roman

Baskerville Old Face, Century, Century Schoolbook,
Constantia, Garamond, Georgia, Goudy Old Style, Palatino,
Times New Roman

A minimalist font--there are no serifs. Sans in
French means without.

Sans serif.

A monoweight font--there are no
thick/thin transitions and therefore
no stress direction either.

Arial, Bell Gothic, Calibri, Candara, Century Gothic, Corbel,
Franklin Gothic, Gill Sans, Lucida Sans, Microsoft Sans
Serif, MS Reference Sans Serif, Myria Pro, Tahoma,
Trebuchet MS, Tw Cen MT,

Contrast with Fills and Outlines
A fill is the color, gradient, or pattern the occupies the inside of a drawn object. An outline is the

color, gradient, or pattern that borders the drawn object. PowerPoint has extensive fill and
outline options.

Different fills, same outline
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Same fill, Different outlines

Repetition
Repetition is one of the most basic principles of design. It is used to keep a constant in a piece of
art or poster. It is often used by creating one shape that is repeated in different sizes throughout
the picture.

Repetition is just keeping with a theme, choosing a shape and repeating that shape over and over
throughout your pictures and posters. This is used mainly for the onlooker's eye. It will find a
constant in the picture, and immediately be able to find the subject, which, using contrast, will be
obvious.
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Repetltlon Unlﬁes an Image

Repetition ties objects or images together. For instance, we know which football players are on a
team because of the repetition of their uniforms. This text uses repetition of fonts, styles, and
sizes to unify the design. On the facing page, repetition of graphic elements draws an image
together.
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Measure Persons, age :Male, age 25+ Female, age Z Persons, age . Household
Some High  $20,321.00 $24,192.00  $15,073.00  $25,039.00  $22,718.00
High schoc $26,505.00 $32,085.00 $21,117.00 $31,539.00  $36,835.00

Some coll¢  $31,054.00 $39"Years ofAEducation vsjlncome
Associate  $35,009.00  $42,3us census Bureau 2005

Bachelor's $43,143.00 $52,2 Persons
Male  Female Female oge 25,
Master'sd  $52,390.00  $67,1 . wessure o ey oniie o .
Professior  $82,473.00 $100,0 10 Some High School 520321 s24092  $15073 $9,119 62% $25,039 s2,718
Doctorate 570,853.00 578,3 12 High school graduate 26,505 32,085 21117 10,968 6% 31,539 36,835
13 Some college 31,054 39,150 25,185 13,95 64% 37,135 45,858
14 Associate degree 35,009 42,382 29,510 12872 70% 40,588 51,970
16 Bachelor's degree 43143 52,265 36,532 15,733 0% 50,944 68,728
18 Master's degree 52,39 67,123 45,730 21,393 68% 61273 78541
19 Professional degree 82473 100,000 66,055 33945 66% 100,000 100,000

20 Doctorate degree 70,853 78,324 54,666 23,658 70% 79,401 96,830
Prepared By: Joe Bobcat

The repetition of formatting in the text headings creates a unified professional look.

with
khakis.

Casa
| Yuca
Only ’he Pric)e is|Chea

This ad uses repetition with the colors in the text, arrow, stain, and background to reflect the
colors in the logo and nachos.

Repetition with Color

Adobe has a wonderful free web-based application called Kuler, which helps you choose a color
palette. One of its most spectacular features is the ability to upload an image and have Kuler
automatically generate a color palette from that image. You then use that palette for fonts, fills,
and so forth in your composition, and you are virtually guaranteed that the colors will all work
well together.
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To use the more interesting features of Kuler you must first create an account
at: kuler.adobe.com. Now you can save your color palettes. Once saved, you can reveal the
numerical values that correspond to your color palette. These numeric values may be imported
into PowerPoint (under custom color).

. kuler

Create Select a Rule
From a Color

Base Color

® RGB 51 35 24 . 2 ® RGB (153 49 | 32 ® RGB 148]178) 111

Kuler helps create a color palette. You can create a color palette by uploading a picture. After
saving your palette, Kuler will allow you see the RGB values associated with each color. You
can then type these values into PowerPoint. Adobe product screenshot reprinted with permission
from Adobe Systems Incorporated.

Alignment
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Alignment indicates organization, polish, and strength. Text on a page is easier to read and
understand if it is properly aligned to the margin. Alignment should be applied to every design or

page layout to show order. Alignment on this page is created by left aligning all of the text and
graphics.

Jose_ph Bobcat

Education

Work Experience

als Sept 2005 - Preze

Visio, Biadibourd. Photoshop, Saaglt
Co, HTML SharePeint

Professional Associations

Honors and Awards

Computer Skills

The alignment of text organizes the categories on the resume.

Sustainable Hair Care

[Goking for an eco-Triendly alce
hair

iconscience will love you.

A fonlit
1€ Joe Bobcat” Lhu&a[:lexmﬂd.\nﬁmnm

The alignment of text and images in this ad creates a polished and professional look.

Proximity
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Proximity creates relationships within objects in an image. Placing objects close together shows
their connectedness and focuses the audience’s attention. For example, captions placed near
photos on a page layout show that they describe the photos they are near. The page you are
reading places headings next to the text they introduce to signify their relationship.

Some High
High schoc
Some coll¢
Associate

Bachelor's
Master's d
Professior
Doctorate

$20,321.00
$26,505.00
$31,054.00
$35,009.00
$43,143.00
$52,390.00
$82,473.00
$70,853.00

$24,192.00
$32,085.00
$39,150.00
$42,382.00
$52,265.00
$67,123.00
$100,000.00
$78,324.00

Measure Persons, age :Male, age 25+ Female, age Z Persons, age : Household

$15,073.00  $25,039.00 $22,718.00
$21,117.00  $31,539.00  $36,835.00
$25.185.00 $37.135.00 $45.854.00

Years of Education vs. Income

US Census Bureau 2005

Persons

Male Female Female age 25+,

Persons  oge 250w/ ofe 25+ w/ Male  camingsasaxof  employed full
Years Measure age 25+ w/ eamings eamings eamings Over/(Under) Male carnings ume Household
10 Some high school $20,321 $24,192 $15,073 $9,119 62% $25,039 $22,718
12 High school graduate 26,505 32,085 21,117 10,968 66% 31,539 36,835
13 Some college 31,054 39,150 25,185 13,965 64% 37,135 45,854
14 Associate degree 35,009 42,382 29,510 12,872 70% 40,588 51,970
16 Bachelor's degree 43,143 52,265 36,532 15,733 70% 50,944 68,728
18 Master's degree 52,390 67,123 45,730 21,393 68% 61,273 78,541
19 Professional degree 82,473 100,000 66,055 33,945 66% 100,000 100,000
20 Doctorate degree 70,853 78,324 54,666 23,658 70% 79,401 96,830

©Joe Bobeat

Proximity helps to organize this spreadsheet in Excel. The title and subtitle are separated from
the rest of the spreadsheet.
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CAoonlit S—

Hair care for the Planet Earth Your Account | Shopping Bag €l
About Us Shop Our Most Popular Products
Hair Styling
(/ Contact Us Shop Our Moy Hair care

Most Popular

Shampoo

Conditioner Moonlit Shampoo Moonlit Conditioner Moonlit Hairspray

$8.00

Heat Protection

; $10.00 $10.00
- . Hair Treatments
Hair Cared/[‘ﬁﬁ”/l'[ Hair §
Hair Tips
Most Popular
Shampoo Contact Us
Moonlit PRO Shampoo  Moonlit PRO Conditioner  Moonlit PRO Hairspray
©Joe Bobcat $15.00 $15.00

Conditioner

Heat Protection

Hair TreatmentMoonlit Shampoo Moonlit Conditioner Moonlit Hairspray

Sﬁ $§ $8.00

= Moonlit PRO Shampoo  Moonlit PRO Conditioner  Moonlit PRO Hairspray
Hair Tips $15.00 $15.00

Hair care for the Planet Earth

©loe Bobcat

Proximity is used to group the links on the navigation bar. Similarly the image, title, and price of
each bottle are grouped together.
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3.3. Use effective lighting for photography-1
Significance and importance of lighting in photography

Photography lighting can be the difference between a breathtaking photo and a terrible one. The
science behind photography lightings really what photographers use each time they take a
picture, whether they know it or not. Without good lighting, a photograph can be grainy and
blurred. Professional photographers understand the relationship between their camera settings
and the light that they have available. Different kinds of light can create different effects in a
photograph. If a photographer knows how the light will change the picture, he or she can create
the exact photo that they want.

Sunlight at Different Times of Day

Natural sunlight is one of the best light sources a photographer can use. On a clear day it is bright
and covers everything equally from the same direction. Photos taken during the middle of a
sunny day will have sharp, bright colors and plenty of detail. Sunlight creates a different effect
during the first few hours of the day and the last few hours before it sets. When the sun is low on
the horizon it shines through the atmosphere at a different angle. Photographs taken in early
morning and late afternoon will be permeated with a soft and hazy atmosphere because of the
quality of the sunlight.

Low Light Situations

Taking photographs in low light can be a challenge. If you use a typical flash, the subject of the
photo may be too washed out because of the harsh lighting. Taking a photo without a flash in
low light can give you a grainy image that is blurry and filled with indistinct objects. When you
know you need to take photos in a dimly lit room or at night, you can change the settings on your
camera to compensate for the dim lighting as much as possible. Set the ISO to a higher setting so
that the camera shutter will be able to take advantage of any available light in the room. If
possible, mount your camera on a tripod to avoid any camera movement. Before you take your
pictures, though, you should understand that it is very difficult to get sharp images in dim light.

What Reflected Light Does to a Photograph

Reflected light is a tool that photographers use to avoid glare in photos. When the light shines
directly on someone or something, there is always a chance that there will be a bright "hot spot"
in the picture. Reflected lighting is created by shining the light onto a white wall or board so that
the light bounces toward your subject and covers the subject in an even, diffused lighting. You
can adjust the angle of the light so that it creates the exact look that you want. Moving the light
closer and further away from your subject will change the quality of the shadows and create a
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different atmosphere for your photograph. Many photographers who specialize in taking portraits
prefer the control that they have when they use reflected and diffused lighting instead of sunlight.

In order to get high-quality pictures, you need the right lighting. You don’t just need sufficient
lighting, but you need the right light to help capture the narrative for your image. The
temperature, the intensity, and whether it’s soft or hard light play a crucial role in your
photography.

Let’s look at the four primary aspects to consider when examining your light:
Intensity (intensity usually comes from how strong it is)

Angle (what angle it is coming from)
Hard or Soft (how much difference between bright and shadow)
Warmth or Coolness (colour)

DIGITAL PHOTOGRAPHY LIGHTING TECHNIQUES

Photography is not completely about settings. Photography is not totally about settings. We need
the settings, sure, but the story goes deeper than that. As photographers, we use lighting
to express emotion. If we want a photo to convey a feeling of romance and an engaging mood,
we might use a yellowy-orange light. If we want to convey a problematic, tough, and challenging
story, then we might use hard light with deep shadows. This creates intense contrast. It’s the way
you utilize light that matters.

Photo by Neusa Quaresma; 1SO 50, /3.5, 1/800-second exposure.

Light has an intense impact on how we emotionally understand what’s going on in the photo.
There are certain things you can achieve to enrich your story such as using the flash, not shooting
with the flash, or using window light instead and making use of different temperatures of
daylight.
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Let’s look at what particular types of light tell us.

LOW LIGHT PHOTOGRAPHY WITHOUT FLASH

Many photos that have low light (dim and soft light with no strong shadows) have been used in
stories that represent sadness, bereavement, secrets, or even intimacy. Lighting like this can
reflect introversion of some sort.

Photo by ™ Pacheco

ARTIFICIAL LIGHT PHOTOGRAPHY

Acrtificial light may come in the form of uninterrupted light, like lights in a photography studio.
This light is often used to reproduce daylight conditions. Brilliant, white light can stand for
optimism, pleasure, sociability, and energy. Flash is also artificial light. Depending on how you
utilise this light (i.e. the direction and angle you fire it from) you can recreate these feelings.
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Photo by Baba G

MORNING LIGHT PHOTOGRAPHY

Morning light is generally soft and doesn’t have as much brightness as the light we see at high
noon. It appears warmer in photographs. Keep in mind that the seasons play a crucial function in
the intensity of light as well. On a bright day in the summer season the light is very intense and
very white. This means that there may well be a lot of contrast in your scenes, such as vivid areas
and deep shadows. This might be suitable if you want to include shadowed areas to tell your
story.
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Photo by Sam; ISO 200, /5.6, 1/80-second exposure.

DRAMATIC LIGHTING PHOTOGRAPHY

Dramatic lighting usually relies upon intense light and deep shadow. This is a high contrast
situation where the light creates and impacts the mood. It is also very dependent on the number
of light sources and at what position the light is coming from. If you place one light source next
to a person’s face, you can produce a lot of hard shadows across the face. This will generate a
very different feeling from a softly lit portrait at sunset.
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Photo by casch52; ISO 100, f/10.0, 1/250-second exposure.

HARD LIGHT PHOTOGRAPHY

Using hard light can capture many intense areas and dark shadowed areas that can be employed
to tell us a story, just as dim light can. You can use this kind of light to enhance quietness,
secrets, and desolation. Alternatively, you may want to photograph a black and white portrait
with strong shadowed areas in the background and keep your subject well lit. This style will
mean that that there might be another facet to the subject’s life or situation.
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Photo by Wil C. Fry; ISO 200, /5.6, 1/200-second exposure.

Lighting is not just about better exposure; it’s about mood and feeling. As you understand light
you can then move forward and capture many different types of moods for your shots. When you
take pictures of a similar thing with changed light, that thing takes on an entirely different
emotion. The way you feel about it alters, and that’s the strength of photography.

This is why photography is not just about settings. It’s about creating powerful, emotive pictures.
You use settings like aperture and shutter speed to have power over the light. You control the
light to direct the emotion and story.

Start examining lighting today. Look at the lighting you see right now and ask yourself about its
qualities. Awareness of lighting will change your photography for the better

Main objectives of lighting in photography

Lighting has nearly infinite permutations and variations. There is certainly no one “right” way to
light a scene. As a result, there is no chance that we can just make a simple list of “proper”
lighting techniques. What we can do, however, is try to identify what it is we want lighting to do
for us. What jobs does it perform for us? What do we expect of “good” lighting? Starting this
way, we have a better chance of evaluating when lighting is working or us and when it is falling
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short. Naturally, these are generalizations. There are always exceptions, as there are in all aspects
of filmmaking — staging, use of the lens, exposure, continuity, editorial, and so on.

Many people think all you have to do in a digital 3D scene is put a light here or there, or just turn
on the lights that are in the shot and my work is done. But there is so much more involved.

You have to understand on a deep level how real world light interacts and reacts in different
situations. You have to study the play of light on a surface, how light will interact with different
materials, what qualities the light takes in different situations, how the color of the light affects
the scene, and that’s just scratching the surface of it. Without knowledge of these things, any 3D
work you do would be an unrealistic, jarring scene with bad lighting. It can be very math heavy
the more you get into it.

Why light?
Lighting is used to:

Establish a setting

Enhance or creating the mood of a scene
Direct the eye

Create the illusion of depth

Create the illusion of volume

Reveal the substance and qualities of materials
Maintain continuity

Integrate visual elements

. Setavisual style

10. Create visual interest

© N WD R

What are the Goals of Good Lighting?

So what is it we want lighting to do for us? There are many jobs, and they include creating an
image that has:

* A full range of tones and gradations of tone

* Color control and balance

» Shape and dimension in the individual subjects

» Separation: subjects stand out against the background

* Depth and dimension in the frame

* Texture

» Mood and tone: emotional content

* Exposure
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Key Lights, Fill Lights, Hair Lights and More: Different Lighting Uses For Studio Strobes

Light is a requirement in photography. Heck, without light, you have no photograph. There are
many different ways to light a subject as you shoot in a studio and as you begin to work with
lighting patterns and light setups, you will find that there are many different lighting uses for
strobes in a studio. Let’s jump into some of the main types of uses when shooting any type of
people images in the studio.

KEY OR MAIN LIGHTS

A key light can be better described as your main source of light on a set. It should also be the
light with the highest intensity of all of the lights being used. Your key light will be what shapes
your subject in the image and should fall on your subject’s face no matter the position your
subject is posed. It can be positioned to the side, at an angle above or below or straight on your
subject depending on the desired result you are looking to achieve.
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One of many positions for a key light.

Positioning Your Key Light

You will want your key light to be close to your subject, but just far enough out of the frame of
your image. A good starting point is usually to the right of the camera at a 45-degree angle, but it
really depends on the result you are aiming to achieve. Just remember, the key light should light
your subject’s face, so it may need to be repositioned throughout a shoot depending on a desired
pose.

Harsh
Shadows

Without
a Fill Light

0N ;L’ (8 TR TR 2
Key lights without fill can cause harsh shadows depending on the modifier and positioning used.
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FILL LIGHTS

A fill light is a light source used to fill in shadows caused by other lights (mainly a key light),
but without creating harsh shadows of its own. This is why your fill light should always be
diffused. You have several options for a fill light source depending on your budget, the size of
your space and the key light modifier you are using.

e

Fill light Zeft) and key light (right).

Fill Light Sources

e Reflectors. This type of modifier is an inexpensive and convenient way of creating
another light source. You can use a reflector as an additional light source by bouncing
light from another light onto your subject. One of the perks to using a reflector as your
fill light is that it does not take up the space that a strobe on a lightstand would — precious
space that is needed in a home studio. The downside to using a reflector as a fill light is
that they cannot be used with anything that directs light only onto your subject, such as
grids and honeycombs, as those leave no light spill to hit your reflector.

e Another Strobe. While more expensive and a not-so-portable option, using a strobe for a
fill light does have its benefits. Since it doesn’t require another light hitting it to make it a
light source, a strobe can be placed anywhere on the set when used for fill. The amount of
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light desired for fill can be adjusted and said light can be diffused with a variety of
modifier choices.

Shadows
Less Harsh

Key Light w/
Fill Light

Uik

A fill light helps to fill in harsh shadows without causing shadows of its own.
Walls/Ceilings. Your walls and ceilings can act as a large reflector of light bounced from your
key or other light source onto your subject. Since it’s such a large light source, the light will be
very soft and produce less harsh shadows.

e Your Clothing. If you wear lighter colored clothing, the lighter surface color can also

become reflective, not much, but it can be noticed.

Positioning Your Fill Light
If you choose to use a reflector as your fill light, it must be placed opposite of a light source,
usually the key light. If you choose to use a strobe as a fill light, depending on the modifier
used, you can place it just about anywhere based on preference to fill in unwanted shadows in

your image.

RIM LIGHTS
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A rim light is a light source placed behind your subject to cast light on the back of your subject,
allowing for some spill to leak around parts of their body, creating a “rim” of light or “lighted
outline” around their body. This is typically used to separate a subject from a background of the
similar color to what the subject is wearing, to separate multiple subjects when they are all
wearing similar colors and to give depth to your image.

Positioning Your Rim Light

A rim light should be positioned behind your subject, but can be positioned in a few different
ways partly depending on the length of the subject that you are desiring to include.

Behind and to the Side of Your Subject

If you are shooting anything other than waist up, without having to take out your light stand in
post-production, it’s usually good to position your rim light at a 45 degree angle behind your
subject and raise and tilt it at a height that will cast light where you need the separation, without
the light hitting the front of your subject. This will create a subtle rim around at least the side of
your subject.

/

If not done right, side rim lighting can produce unwanted lens flare or uneven rim lighting.
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Without the Rim Light

With the Rim Light

Rim Light on the Side

The rim light is off to the back-right of the subject.

Directly Behind Your Subject

For waist-up portraits and headshots, where your subject’s body and head can block the strobe,
try placing the light directly behind your subject and you will get an evenly lit outline of light on
both sides of your subject’s hair and body, depending on angle of placement.
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Positioning a rim light directly behind a subject can make for an even rim around your subject.

Below is a nice soft result using a 16” beauty dish with a sock diffuser to cover the light...

Rim light is located behind the subject.
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Rim light can be seen even more pronounced in the picture below where photographer had a red
gel on a set of barndoors placed behind subject’s head.

Blue gel on the background and barndoors with a red gel aimed at the back of head.

Great (and fun!) Modifiers to Use for Rim Lights

You can use several different modifiers for rim lights, depending on where you place them and
how much area you want to cover.

Small Strobe Reflectors. Unlike a portable reflector, these are hard metal reflectors that
actually attach to the strobe, the type you get usually depends on your light make and model. A
good example of these are the Elinchrom Standard Reflector which works with, you guessed it —
Elinchrom strobes.
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Elinchrom Standard Reflector

o Beauty Dish. Beauty dishes come in a few sizes. If you have a smaller beauty dish, like
the one at 16 inches in diameter, it can fit behind the body of a person when positioned
below the neck or it can work well at the side with a grid on it.

Bowens BW-1900 20.5” Beauty Dish for Bowens Lights

e Snoot. A really great tool for rim lights when you only want to put a rim on a particular
area of a person without spill is a snoot. Add a grid to the snoot, which sometimes comes
together in a set with the snoot, for more direction control.
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Flashpoint Snoot Kit for Flashpoint Mount Strobes

o Barndoors. Barndoors are one of the best light shapers, literally! With four flaps that
each individually move 180 degrees from their start position, there are many
combinations of ways to shape the light.

Flashpoint Barndoors Set

e Gels. Some of the modifiers above already come with gels, but if they don’t and you
want to play with gels, or even if they do and you want more color options, you can buy
sheets individually.

Rosco Color Effects Pack
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HAIR LIGHTS

A hair light is also a light used for separation, but one that is positioned to only light the top of a
subject’s head to create depth in an image.

Image by Yann Bizeul
Positioning a Hair Light...

A hair light should be positioned directly above and slightly behind your subject’s head to put a
nice light on the top of the hair. It should not spill onto your subject’s face.

mage by Yann Bizeul
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Recommended Equipment

e Boom Stand. Since a light has to be placed hanging over your subject’s head, this is one
of those times a good sturdy boom stand comes in handy.

SIDE LIGHTS

Side lights add drama to a portrait as the light sweeps across the face, it works like a gradient and
gets darker the further across the face it goes. As it does this, it can reveal every imperfection of
the skin as it goes from light to dark, which is why: unless a woman has porcelain skin (like the
mannequin below), it is not flattering for women when going for a beauty shot. In those cases,
you want as much light as possible. While it can be used for terrific dramatic portraits of any
gender, side lighting (also known as “split lighting”) is especially amazing for shooting male
portraits as it enhances character of the face.

A sock and a beauty dish lessens the harshness of the shadows of this dramatic lighting.
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With the light source right, this creates more shadow as it falls off toward the left.
How to position a side light and what effect does it create?
A side light can be positioned on either side of your subject, but must be lined up with their body

to create the half dark, half light effect. The more you move the light toward in front of your
subject, the less shadow on the opposite side of the face.

\\\\\\\\‘\'a
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Using a grid on a direct side light can make for a much more dramatically lit image.
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Throwing a grid onto a beauty dish, snoot or reflector helps direct the light exactly where you
want it to go with much less spill.

Using a grid on a side light helps direct light in one straight direction creating a more dramatic
image.

BACKGROUND LIGHTS

Background lights illuminate a background and help eliminate unwanted shadow, which is
extremely helpful when you do not have the space to bring your model forward 6-12 feet from
the seamless.
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Without the benefit of a background light when 4 feet from the background.

How Many Lights Do You Need?

For an evenly lit background, you can get away with one light to light a background when
positioning the background light directly behind your subject. The problem with this is that while
your subject can block most of what’s behind him/her, you will have to get rid of your light stand
legs in post or shoot only thigh-up.

211



Background light positioned directly behind the subject.

Positioning Your Background Lights

It can be optimal, if you can spare the extra money, to invest in a second background light if you
want even lighting on your subject while taking a full length shot. | usually place one a little
higher than the other to cover both the lower and upper halves behind my subject, which works
great on white seamless. On colored seamless, it can make for an interesting background design.

One light on each side aimed at the background at different heights.
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Nice even background light.

FLOOR LIGHTS

Floor lights are great to use when you need to illuminate the entire body, including the
feet/shoes. Due to light falloff and your lights usually being positioned waist-level and higher,
the floor can usually go dark by the time the light gets to the ground. This is where 4- and 5-light
setups start to come into play.
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Hlluminates thigh to foot.

Key, Fill and Floor Light without Background Lights

Positioning Your Floor Lights

If you have background lights, you can position your lights anywhere in front of your subject
where they illuminate the area needed to be it. If you are limited on background lights or are not
using any at all, it’s better to place the floor lights head-on with your subject to cast the least
amount of shadow.
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When positioned at the side, illuminates thigh to foot but can throw shadow to the side of
the subject without background lights.

Use effective lighting forphotography-2

Direction

Where is the light coming from—the front, the side, or behind?

The direction of light has a tremendous amount to do with creating a sense of shape and texture
in your images. To be a bit more precise, the direction of light controls the width of the shadows.
And it’s the shadows that create a sense of shape and texture in your photographs.

“If you want to create interesting light, you have to create interesting shadows. So, look at the
light and think about the shadows.”

Why are shadows important? When we look at a scene, we see depth because the separation
between our eyes gives us the ability to see stereoscopically. We see in three dimensions: height,
width, and depth. Yet, when your photograph of that scene appears onscreen or is printed on
paper, the image only has two dimensions: height and width. Since the screen or paper is flat, the
sense of depth in your photographs is created by geometry and shadows. In terms of geometry,
we assume that larger objects are closer and smaller objects are farther away. In terms of
shadow, the shapes of the shadows go a long way to informing the viewer about the shape of the
objects.

The Lighting Compass
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The placement and width of shadows in a photograph is created by the angle between the camera
and the light source. To keep the discussion simple, we’ll only consider what happens as the light
moves in a circle around the subject.

You, the photographer, control how the camera sees the direction of light through the framing of
the shot. If you move your camera in a circle around your subject, you will see that the direction
of the light changes as you move. For now, as shown in Figure 1.1, let’s think of direction as
being one of four possibilities:

e On-Camera or Aligned with the Camera (red): This means that the sun is coming
straight over your shoulders or the flash is parked right on top of your camera. Typically,
you will have flat light that lacks significant shadows. Photos with flat light often fall
short of capturing a scene as you experience it because they lack depth.

o Angled Towards the Subject (green): When the light approaches the subject from either
side of the camera, shadows are created, and shape/texture become more apparent. The
width of the shadows increases as the direction of the light moves from the camera out to
the side. You’ll find that 45° is a great angle for many lighting situations.

e To the Side of the Subject (orange): When the main light comes at the subject directly
from the side, you’ll have very dramatic light—perhaps too dramatic. Unless there is a
fill light or reflector on the other side of the subject, the camera will record the subject as
being lit on one side with a dark shadow on the other side. This can be good if you want
to create a headshot that conveys mystery, but not so good if you want to convey
glamour.

e Behind the Subject (blue): Unless you want to create a silhouette shot, light coming
from behind the subject should be considered a secondary light. Figure 1.1. The lighting
compass is a view seen directly above the subject. It shows the angle between the camera
and the light source. As you move the light from on-camera out to 90°, the shadows
become more pronounced because they become wider. When you move the light behind
the subject, you are creating an edge of light that will separate the subject from the
background.

Filling Shadows

As good as our cameras are, they cannot record the full range of human vision. If the difference
in your scene between the brightest brights and the darkest darks is too much, then some of the
details in either the highlights or the shadows (or both) will be beyond the range of the camera.
To show details in the dark areas, you can bounce light in with a reflector or add a fill light.

Lighting Lingo

Key light: The main light hitting the subject, typically coming from the front, often angled in
from one side.
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Fill light: Light that is added to the shadows, can be created by bouncing light off a reflector or
by adding a secondary light, such as a flash.

Rim or hair light: A light that comes from behind the subject and is seen by the camera as a thin
outline of light along the edge of the subject.

Sometimes you have no control over the location of the light source, such as when shooting
outdoors under the sun. In this instance, try circling around the subject so that the camera sees
the light falling on the subject from a different angle.

Direct, Diffused, and Reflected Light

Direct light flies straight from the light source to the subject (Figure 1.4). Direct light typically
creates shadows with high contrast and hard edges. Sunlight on a clear day is direct light. Light
from an on-camera flash can also be direct light. While direct light has many uses, photographers
often prefer the softer look of diffused and reflected light.

e
L/

Figure 1.4. Light coming directly from a source to the subject will have dark shadows with a
hard, defined edge.

Diffused light passes through a semi-transparent material on the way from the source to the
subject (Figure 1.5). Diffused light creates shadows with lower contrast and softer edges than
direct light. Depending upon the amount of diffusion, it is possible that the shadows will be so
light that you can barely see them. Clouds are a great example of how sunlight can be diffused.
The water vapor causes the light to bounce around and come at the subject from many angles
rather than directly from the sun. A sheer curtain over a window is another example of a light
diffuser.
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@ Diffuser Panel
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Figure 1.5. Light that passes through a semi-transparent material, like a cloud bank or diffuser
panel, will come at the subject from many angles. This light will have soft shadows.

Reflected light bounces off of an opaque surface before it hits the subject (Figure 1.6). Sunlight
bouncing off the concrete wall of a building is reflected light. Sunlight bouncing off of clouds
can create reflected light. Photographers can use white foam core panels or fabric reflectors in a
variety of colors to bounce light. Hotshoe-mounted flashes often have the ability to tilt and pan
so that the flash can be bounced off a nearby wall or ceiling. Like diffused light, reflected light is
softer than direct light.
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Figure 1.6. Light that bounces off a surface, like a white wall or ceiling, will also come at the
subject from many angles and have soft shadows.

The difference between diffused and reflected light comes from the location of the diffuser and
reflector. With diffused light, the diffuser is between the light source and the subject. With
reflected light, the light hits a nearby surface and then bounces onto the subject. This is why
clouds can be both diffusers and reflectors. When the sun’s light goes through the clouds, they
are a diffuser. When the light reflects off of the clouds—such as when the sun is setting low in
the sky—then the clouds serve as reflectors.

Diffused and reflected light is softer because the diffusion or bounce increases the apparent
size Of the light source. You should think about whether the light is direct, diffused, or reflected.
If it is direct, then you may have options to create softer light by using a diffuser or reflector.
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One/Two/Three/Four Point Lighting Techniques
One-Point Lighting

Most of us experience one-point lighting in nature every day. Yes it is sunshine. In many
occasions, a single source of light creates a very natural, sometimes dramatic look that will
draw people’s attention to the single lighted person or surface. And if it’s good enough for
nature, there are times it might be good enough for you. The catch? As anyone can see with a
walk around the park, a single source looks two dimensional or flat, and rarely hits people
straight on, so it creates shadows.

Two-Point Lighting

When you want the subtleness of a single light source but want your people to stand out in
3D, two-point lighting can be a great way to add dimensionality without going overboard on
your lighting. Photographers often use this approach for bands in churches that like a more
aggressive lighting vibe by taking a single light source from straight on in front of the lighting
zone, about 30-40 degrees up. They then add a top light above and slightly behind the zone
(about 60-70 degrees) in order to define the head and shoulders of the people in the zone,
creating a three-dimensional look without using too much light. There is still quite a potential
for shadowing if a person turns their head either direction, but where a little shadowing is
okay, this can be an effective way to bring focus.

Three-Point Lighting

Not everyone is happy with the shadows that two-point lighting can produce, so the logical
solution would be to add two light fixtures from the front, still 30-40 degrees up but having
each fixture hitting your zone from 45 degree angles off center. Add that same top light from
above and slightly behind, and you’ve got three fixtures giving you light on both sides of the
face (regardless of the direction it faces) and a multi-dimensional look. This approach is
commonly used in theater and worship stages where cameras aren’t used, or at least aren’t a
big focus.

Four-Point Lighting

When cameras are being used, especially HD cameras, three-point lighting can actually fall
short of providing even lighting across your lighting zones. Think of a 10-foot wide circle as
your lighting zone. As you move to the right, the right side of your face will become brighter
as you get closer to the right fixture and farther from the left fixture. Turn around and head
back the other way and the opposite happens. Cameras tend to pick up on this more than our
eyes, because our brains compensate where a camera does not. In order to fix this, in places
where cameras play a critical role, artists tend to use four-point lighting. That means a front
light straight-on the lighting zone, providing the primary light, and two fill lights 45-60
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degrees off center to fill in the sides of the face. The straight-on light is my primary source, so
for example you may have that intensity at 80%. If that’s true, your fill lights might be at 60%
and then of course you have your top light providing the dimensionality you want from
behind. All three of the front lights would still shoot at a 30-40 degree angle and your top
light would be above and behind at 60-70 degrees.

Creating Zones

Lighting is most effective when you have good control of what your light is hitting and not
hitting, and the best way to make a plan of attack for your stage is to divide it into zones.
Most lighting pros will divide their stages into zones of 8-12 foot diameter circles with a
slight overlap of zones to make sure there are no holes in the coverage. If your stage is 30 feet
wide and 30 feet deep, you would likely end up with 3 zones across down-stage, 3 zones
across mid-stage, and 3 zones across up-stage. Breaking your stage into these zones not only
helps make lighting them evenly more manageable but also allows for greater control of
special lighting. For example, perhaps you want to draw attention to a speaker down-stage left
for one part of your service and then immediately cut to down-stage right for the next part. By
lighting each zone individually at the right times, you draw everyone’s attention to the right
place at the right time.

Chroma background (Green-Screen) Photography

Green screens or blue screens are used as backdrops in chroma key photography, which is a
process that replaces a solid-colored background from behind the subject of a photo (or video)
with a new background. When you watch the weather forecaster on TV standing in front of a
map, or Spiderman climbing down a building, you, my friend, are seeing chroma key
photography at work!

You may be wondering, “Why use a green screen or a blue screen?” Because separating a
background from a human subject in a photo or video is much easier if the background is made
of a solid color which is not found in human skin tones, like the colors green and blue.

The practice of chroma keying can seem daunting at first, so be sure to read through this guide to
green screens to get started on the right track.

Tools for Getting Started with Green Screens

Can a beginner really do this?

Removing and replacing photo backgrounds does sound complicated, doesn’t it? Not to worry!
With digital photography and software designed specifically for this purpose, you can be
swapping backgrounds with the best of them in no time. Here’s what you’ll need to get started:
1. Digital camera. You’ve got one already, right?

2. A computer. Either a PC or a Mac is fine.
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3. A cable to download images from camera to computer. (Duh.)

4. Chroma key photography software. As with most software, you’ll run into a lot of green
screen programs that are only compatible with PCs. But there are some made for both types of
operating systems. For example, the Green Screen Software by Savage is compatible with both
PCs and Macs.

5. Green screen background. There are many on the market, so before you buy, carefully
consider how you’ll be using yours. For an occasional fun shot, or as a frequently used tool for
your photography business? For studio shots only, or mostly for outdoor sessions? Here are the
differences to consider:
e SIZE: For example, 5’ x 7’ for photographing individuals, or 10’ x 12’ or 10’ x 20’ for
group shots or full-body pictures.
e PORTABLE vs. STATIONARY: a collapsible pop-up screen or a rolled-up backdrop.
e MATERIAL: If you’ve taken a look online at green screen backdrop options, you’ve no
doubt seen them in several types of material.

e paper
o fabric (muslin, polyester)
e vinyl

o foam-backed
e paint (to color a wall in your studio)

Photo by Ryan Walsh, Featuring Tech Green Seamless Paper 53" x 12yd

Whatever you choose, stay away from glossy or shiny materials since one of the issues with
chroma key photography is the bounce-back color from reflective backdrops.

6. Background stands: If you have a studio and have been using other backgrounds, you may
already own a stand to hang backdrop rolls from. But if you don’t have a studio set up, or the
money or space for background stands, look for one of the smaller, collapsible green screens that
comes with hanging hooks or a portable stand.
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7. Studio lighting: Getting the best possible contrast between your background and your model is
key for chroma key work, so you’ll need a well-lit green screen. For outdoor shooting in brightly
lit areas, you’ll probably be fine with natural light. But for indoor shots, you’ll need professional
equipment.

8. Digital backgrounds: Here’s the fun part! Selecting a new photo background for your subject.
Let’s say you want the look of a studio backdrop. You can select digital backgrounds that look
just like muslin. Or if you prefer your subject in a more natural setting, look for digital
backgrounds with trees, mountains, or waterfalls. For fun shots, there are backgrounds of famous
landmarks, or you can put your subjects in a frame with a holiday greeting on it. The available
choices seem to be endless! The Savage Photo Creator Kitcomes with an extensive image
library of 3,500+ digital backgrounds to choose from!

How to Green Screen: Steps for Completing Your First Project
Ready to get started? Here are the steps!

1) Set up your green screen background. If you’re using a portable stand, figure out how to
stabilize it so it doesn’t flap in the breeze or move around as your model moves around.

2) Get the wrinkles out. Foam-backed screens are virtually wrinkle-free, but more costly. If you
have opted for a fabric green screen, you can get rid of wrinkles by spraying it with water or a
handheld steamer. Try to stretch it tight as it dries to reduce the lines that may cause shadows in
your background.

3) Set up your lighting for the green screen. You need to light the screen separately from your
subject, taking care that your lighting is even and doesn’t create shadows or hot spots. Chroma
key software works best when the background has uniform color across its surface.

4) Select your digital background for the shot you are planning.
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5) Set up your lighting for your subject. Study the direction of the light in the digital background
you have selected for your new backdrop. Which way do the shadows fall? Try to mimic this
angle of lighting on your model. Matching the intensity of light will also help make your
composite photograph look much more realistic.

6) Position your subject. Avoid shadows falling on your green screen by putting some distance
between model and screen. Experiment with your own lighting and subject until you don’t see
any dark shadows on the backdrop. More distance from the screen will also cut down on any
reflection you might get if green light bounces off the screen. This can help avoid an unpleasant
other-worldly green glow around your model—unless perhaps you’re going for that look.

7) Keep the model fully in front of the green screen. Any part of the body or costume that
doesn’t have the green screen background will have a different background which the chroma
key software cannot remove. Knocking out that unwanted background on your own can be a
long, frustrating process with your photo editing software. So, keep those arms and legs inside
the screen, kids!

8) Download your image to your computer.

9) Select your photo, then follow the directions on your software.
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When are green backdrops used?

Green backdrops are used in any situation where you are intending on adding a background
(different from the one where you are when you are taking the photos) at a later date.

Green backdrops have been used in the following situations

e Cruise ships

e Weddings

e Portraits

e On location

e When itis raining

e Filmsand TV

e Weather men/ women
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The most quoted use of green backdrops is TV weather forecasters. Despite the leaps in
technology when you watch the weather forecast on the TV the presenter is actually standing in
front of a green screen. The weather maps and all that good stuff is being added by the behind
the scenes production staff.

Using the Camera Raw File Format for your Digital Photos

The RAW file format is digital photography's equivalent of a negative in film photography: it
contains untouched, "raw" pixel information straight from the digital camera's sensor. The RAW
file format has yet to undergo demosaicing, and so it contains just one red, green, or blue value at
each pixel location. Digital cameras normally "develop” this RAW file by converting it into a
full color JPEG or TIFF image file, and then store the converted file in your memory card.
Digital cameras have to make several interpretive decisions when they develop a RAW file, and
so the RAW file format offers you more control over how the final JPEG or TIFF image is
generated. This section aims to illustrate the technical advantages of RAW files, and makes
suggestions about when to use the RAW file format.

Overview

A RAW file is developed into a final JPEG or TIFF image in several steps, each of which may
contain several irreversible image adjustments. One key advantage of RAW is that it allows the
photographer to postpone applying these adjustments — giving more flexibility to the
photographer to later apply these themselves, in a way which best suits each image. The
following diagram illustrates the sequence of adjustments:

RAW: Bayer Image
RAW Image

- RAW: Debayerized image
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Demosaicing
White Balance

- Final Image from RAW

Tone Curves
Contrast

Color Saturation
Sharpening

— Conversion to 8-bit and JPEG Compression

Demosaicing and white balance involve interpreting and converting the bayer array into an
image with all three colors at each pixel, and occur in the same step. The bayer array is what
makes the first image appear more pixelated than the other two, and gives the image a greenish
tint.

Our eyes perceive differences in lightness logarithmically, and so when light intensity
quadruples we only perceive this as roughly a doubling in the amount of light. A digital camera,
on the other hand, records differences in lightness linearly — twice the light intensity produces
twice the response in the camera sensor. This is why the first and second images above look so
much darker than the third. In order for the numbers recorded within a digital camera to be
shown as we perceive them, tone curves need to be applied (see the tutorial on gamma correction
for more on this topic).

Color saturation and contrast may also be adjusted, depending on the setting within your camera.
The image is then sharpened to offset the softening caused by demosaicing, which is visible in
the second image.

The high bit depth RAW image is then converted into 8-bits per channel, and compressed into a
JPEG based on the compression setting within your camera. Up until this step, RAW image
information most likely resided within the digital camera's memory buffer.
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There are several advantages to performing any of the above RAW conversion steps afterwards
on a personal computer, as opposed to within a digital camera. The next sections describe how
using RAW files can enhance these RAW conversion steps.

Demosaicing

Demosaicing is a very processor-intensive step, and so the best demosaicing algorithms require
more processing power than is practical within today's digital cameras. Most digital cameras
therefore take quality-compromising shortcuts to convert a RAW file into a TIFF or JPEG in a
reasonable amount of time. Performing the demosaicing step on a personal computer allows for
the best algorithms since a PC has many times more processing power than a typical digital
camera. Better algorithms can squeeze a little more out of your camera sensor by producing more
resolution, less noise, better small-scale color accuracy and reduced moiré. Note the resolution
advantage shown below:

Wl

Images from actual camera tests with a Canon EOS 20D using an 1SO 12233 resolution test chart.

Differential between RAW and JPEG resolution may vary with camera model and conversion software.

The in-camera JPEG image is not able to resolve lines as closely spaced as those in the RAW
image. Even so, a RAW file cannot achieve the ideal lines shown, because the process of
demosaicing always introduces some softening to the image. Only sensors which capture all
three colors at each pixel location could achieve the ideal image shown at the bottom (such as
Foveon-type sensors).

Flexible White Balance
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White balance is the process of removing unrealistic color casts, so that objects which appear
white in person are rendered white in your photo.Color casts within JPEG images can often be
removed in post-processing, but at the cost of bit depth and color gamut. This is because the
white balance has effectively been set twice: once in RAW conversion and then again in post-
processing. RAW files give you the ability to set the white balance of a photo *after* the picture
has been taken — without unnecessarily destroying bits.

High Bit Depth

Digital cameras actually record each color channel with more precision than the 8-bits (256
levels) per channel used for JPEG images (see "Understanding Bit Depth™). Most current
cameras capture each color with 12-bits of precision (212 = 4096 levels) per color channel,
providing several times more levels than could be achieved by using an in-camera JPEG. Higher
bit depth decreases the susceptibility to posterization, and increases your flexibility when
choosing a color space and in post-processing.

Dynamic Range & Exposure Compensation

The RAW file format usually provides considerably more "dynamic range" than a JPEG file,
depending on how the camera creates its JPEG. Dynamic range refers to the range of light to
dark which can be captured by a camera before becoming completely white or black,
respectively. Since the raw color data has not been converted into logarithmic values using
curves (see overview section above), the exposure of a RAW file can be adjusted slightly —
after the photo has been taken. Exposure compensation can correct for metering errors, or can
help bring out lost shadow or highlight detail. The following example was taken directly into the
setting sun, and shows the same RAW file with -1 stop, O (no change), and +1 stop exposure
compensation. Move your mouse over each to see how exposure compensation affects the image:
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Apply Exposure Compensation:

-1.0 none +1.0

Note: +1 or -1 stop refers to a doubling or halving of the light used for an exposure, respectively.

A stop can also be listed in terms of eV, and so +1 stop is equivalent to +1 eV.

Note the broad range of shadow and highlight detail across the three images. Similar results
could not be achieved by merely brightening or darkening a JPEG file — both in dynamic range
and in the smoothness of tones. A graduated neutral density filter could then be used to better
utilize this broad dynamic range.

Enhanced Sharpening

Since a RAW file is untouched, sharpening has not been applied within the camera. Much like
demosaicing, better sharpening algorithms are often far more processor intensive. Sharpening
performed on a personal computer can thus create fewer halo artifacts for an equivalent amount
of sharpening (see "Sharpening Using an Unsharp Mask™ for examples of sharpening artifacts).
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Since sharpness depends on the intended viewing distance of your image, the RAW file format
also provides more control over what type and how much sharpening is applied (given your
purpose). Sharpening is usually the last post-processing step since it cannot be undone, so having
a pre-sharpened JPEG is not optimal.

Lossless Compression

Compression:
Lossless Lossy

The RAW file format uses a lossless compression, and so it does not suffer from the compression
artifacts visible with "lossy" JPEG compression. RAW files contain more information and
achieve better compression than TIFF, but without the compression artifacts of JPEG.

Note: Kodak and Nikon employ a slightly lossy RAW compression algorithm, although any
artifacts are much lower than would be perceived with a similar JPEG image. The efficiency of
RAW compression also varies with digital camera manufacturer. Right image shown at 200%;
lossy JPEG compression at 60% in Adobe Photoshop "Save for Web" mode.

Disadvantages

RAW files are much larger than similar JPEG files, and so fewer photos can fit within the same
memory card.

RAW files are more time consuming since they may require manually applying each conversion
step.

RAW files often take longer to be written to a memory card since they are larger, therefore most
digital cameras may not achieve the same frame rate as with JPEG.
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RAW files cannot be given to others immediately since they require specific software to load
them, therefore it may be necessary to first convert them into JPEG.

RAW files require a more powerful computer with more temporary memory (RAM).
Other Considerations

One problem with the RAW file format is that it is not very standardized. Each camera has their
own proprietary RAW file format, and so one program may not be able to read all formats.
Fortunately, Adobe has announced a digital negative (DNG) specification which aims to
standardize the RAW file format. In addition, any camera which has the ability to save RAW
files should come with its own software to read them.

Good RAW conversion software can perform batch processes and often automates all conversion
steps except those which you choose to modify. This can mitigate or even eliminate the ease of
use advantage of JPEG files.

Many newer cameras can save both RAW and JPEG images simultaneously. This provides you
with an immediate final image, but retains the RAW "negative" just in case more flexibility is
desired later.
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